Contents

1 Safety

- Electrical Safety ................................................................. 14
- General Guidelines ............................................................. 14
- Power Cord ......................................................................... 15
- Emergency Turn Off .......................................................... 15
- Telephone Line Cord ........................................................ 15
- Laser Safety ......................................................................... 16

2 Operational Safety ................................................................................................. 17
- Operational Guidelines ....................................................... 17
- Ozone Release ...................................................................... 17
- Printer Location .................................................................... 17
- Printer Supplies ..................................................................... 18

3 Maintenance Safety .................................................................................................. 19
- Printer Symbols ..................................................................... 20

4 Environmental, Health, and Safety Contact Information ............................................. 21

5 Parts of the Printer .................................................................................................... 24
- Front View .............................................................................. 24
- Rear View ............................................................................... 25
- Internal Parts ......................................................................... 26
- Control Panel ........................................................................ 26

6 Energy Saver Mode .................................................................................................. 28
- Exiting Energy Saver Mode .................................................... 28

7 Information Pages .................................................................................................... 29
- Configuration Report ............................................................ 29
- Printing a Configuration Report ............................................. 29

8 Administrative Features .......................................................................................... 30
- CentreWare Internet Services ................................................ 30
- Finding the IP Address of the Printer ..................................... 30
- Accessing the Printer ............................................................ 31
- Meter Readings ...................................................................... 32
- Billing and Usage Information ............................................... 32

9 More Information ..................................................................................................... 33

3 Installation and Setup

- Installation and Setup Overview ............................................. 36
- Selecting a Location for the Printer ........................................ 37
- Connecting the Printer ........................................................ 38
- Selecting a Connection Method .............................................. 38
Contents

Connecting to a Computer Using USB .............................................................................................................. 39
Connecting to a Wired Network ........................................................................................................................ 39
Connecting to a Wireless Network .................................................................................................................... 39
Connecting to a Telephone Line ....................................................................................................................... 49
Configuring Network Settings .......................................................................................................................... 50
About TCP/IP and IP Addresses ........................................................................................................................ 50
Assigning the Printer IP Address ....................................................................................................................... 51
Assigning the IP Address Automatically .......................................................................................................... 51
Finding the IP Address of the Printer ............................................................................................................. 52
Changing the IP Address Using CentreWare Internet Services ..................................................................... 52
Assigning the IP Address Manually ................................................................................................................ 53
Setting Up the Network Address Book .......................................................................................................... 55
Configuring General Setup Using CentreWare Internet Services ............................................................... 56
Opening General Setup Settings ..................................................................................................................... 56
Viewing Printer Information ............................................................................................................................. 56
Cloning Printer Settings ................................................................................................................................... 57
Configuring Mail Alerts ................................................................................................................................... 57
Configuring System Settings ............................................................................................................................. 58
Configuring Clock Settings ............................................................................................................................... 58
Configuring Tray Settings .................................................................................................................................. 59
Setting Up a Proxy Server .................................................................................................................................. 59
Resetting Service Defaults .................................................................................................................................... 60
Configuring General Setup Using the Control Panel ....................................................................................... 61
Accessing Information About the Printer Using the Control Panel ............................................................. 61
Using the Power On Wizard ............................................................................................................................. 61
Configuring General Settings .......................................................................................................................... 63
Configuring the Timers ...................................................................................................................................... 66
Configuring Output Settings ............................................................................................................................. 67
Configuring Tray Settings .................................................................................................................................. 68
Configuring AirPrint ......................................................................................................................................... 69
Configuring Fax Defaults and Settings ............................................................................................................ 70
Setting Fax Defaults from CentreWare Internet Services ............................................................................ 70
Configuring Fax Settings from CentreWare Internet Services ................................................................... 71
Setting Fax Defaults from the Control Panel ................................................................................................ 72
Configuring Fax Settings at the Control Panel (Bridgetown) ......................................................................... 72
Setting Up Scanning ......................................................................................................................................... 77
Scanning Setup Overview ................................................................................................................................. 77
Setting Up Scanning to a Shared Folder on Your Computer ....................................................................... 78
Setting Up Scanning to an FTP Server ............................................................................................................ 80
Setting Up Scanning to an Email Address ....................................................................................................... 81
Setting Up Scanning With USB ....................................................................................................................... 82
Configuring Security Settings Using CentreWare Internet Services ............................................................ 83
Opening the Security Menu ............................................................................................................................... 83
Configuring Administrative Security Settings ............................................................................................... 84
Configuring Secure Settings ............................................................................................................................ 84
Network Authentication ....................................................................................................................................... 86
LDAP Server ...................................................................................................................................................... 87
# Contents

## 4 Paper and Media

- Supported Paper ................................................................. 118
- Recommended Media .......................................................... 118
- Ordering Paper ................................................................. 118
- General Paper Loading Guidelines ........................................ 118
- Paper That Can Damage Your Printer ................................... 119
- Paper Storage Guidelines .................................................. 119
- Supported Paper Types and Weights ................................. 120
- Supported Standard Paper Sizes ....................................... 120
- Supported Paper Types and Weights for Automatic 2-Sided Printing ......................................................... 120
- Supported Standard Paper Sizes for Automatic 2-Sided Printing ............................................................. 121
- Supported Custom Paper Sizes ....................................... 121

- Loading Paper ........................................................................ 122
  - Loading Paper in the Bypass Tray .................................... 122
  - Configuring Trays 1 or 2 for the Paper Length ............... 124
  - Loading Paper in Trays 1 and 2 ....................................... 125

- Printing on Special Paper ................................................ 128
  - Envelopes ........................................................................ 128
  - Labels ........................................................................... 132
  - Glossy Cardstock ............................................................ 133

## 5 Printing

- Printing Overview .............................................................. 136
- Selecting Printing Options ................................................ 137
  - Print Driver Help ........................................................... 137
  - Windows Printing Options ............................................. 138
  - Macintosh Printing Options .......................................... 139

- Printing Features .............................................................. 140
  - Printing on Both Sides of the Paper ............................... 140
  - Orientation .................................................................... 142
  - Selecting Paper Options for Printing ........................... 142
  - Printing Multiple Pages to a Single Sheet .................... 142
  - Printing Booklets .......................................................... 143
  - Print Quality .................................................................. 143
  - Image Options ............................................................. 144
  - Printing Watermarks ..................................................... 144
  - Scaling ........................................................................ 145
  - Printing Mirror Images ............................................... 145
  - Selecting Job Completion Notification for Windows ........ 145
  - Printing Special Job Types ............................................. 146
  - Printing from a USB Flash Drive .................................... 147

- Using Custom Paper Sizes ................................................. 148
  - Defining Custom Paper Sizes ....................................... 148
  - Printing on Custom Paper Sizes ................................... 149

## 6 Copying

- Xerox® WorkCentre® 6605 Color Multifunction Printer User Guide
Scanning

7 Scanning

Making Copies.................................................................152
  Changing the Default Copy Settings...........................162
  Changing Output Color..................................................162
  Changing the Paper Tray.................................................162
  Changing Collation.........................................................163
  Changing Reduce/Enlarge.............................................163
  Changing the Original Size..............................................163
  Changing the Original Document Type........................163
  Changing Lighten/Darken...............................................163
  Changing the Default for Sharpness............................163
  Changing the Saturation.................................................164
  Changing Auto Background Suppression.......................164
  Changing Auto Background Suppression Level...............164
  Changing the Default Color Balance............................164
  Changing 2-Sided Copying..........................................164
  Changing Print Multiple Pages per Side.......................165
  Changing Edge Erase.....................................................165

Limiting Access to Copying..............................................166

Changing the Default Copy Settings...........................162
Changing Output Color..................................................162
Changing the Paper Tray.................................................162
Changing Collation.........................................................163
Changing Reduce/Enlarge.............................................163
Changing the Original Size..............................................163
Changing the Original Document Type........................163
Changing Lighten/Darken...............................................163
Changing the Default for Sharpness............................163
Changing the Saturation.................................................164
Changing Auto Background Suppression.......................164
Changing Auto Background Suppression Level...............164
Changing the Default Color Balance............................164
Changing 2-Sided Copying..........................................164
Changing Print Multiple Pages per Side.......................165
Changing Edge Erase.....................................................165

Limiting Access to Copying..............................................166

Adjusting Copying Options..........................................155
Basic Settings..................................................................156
Image-Quality Settings...................................................158
Output Adjustments........................................................159

Changing the Original Size..............................................163
Changing the Original Document Type........................163
Changing Lighten/Darken...............................................163
Changing the Default for Sharpness............................163
Changing the Saturation.................................................164
Changing Auto Background Suppression.......................164
Changing Auto Background Suppression Level...............164
Changing the Default Color Balance............................164
Changing 2-Sided Copying..........................................164
Changing Print Multiple Pages per Side.......................165
Changing Edge Erase.....................................................165

Scanning to a Folder on a USB Connected Computer........170
Scanning to a PC from the Printer.....................................172
Scanning to a User Home Folder.......................................173
Before You Begin..........................................................173
Scanning to a Home Directory..........................................173

Scanning to a Shared Folder on a Network Computer.........174
Sharing a Folder on a Windows Computer.......................174
Sharing a Folder Using Macintosh OS X Version 10.5 and Later174
Adding a Folder as an Address Book Entry Using CentreWare Internet Services.................175
Adding a Folder as an Address Book Entry Using the Address Book Editor.........................176
Scanning to a Folder on a Network Computer...................176

Scanning to an Email Address..........................................177
Scanning to Web Services on Devices.............................178
Scanning Images into an Application on a USB Connected Computer.................................179
Scanning an Image into an Application............................179
Contents

Scanning an Image Using Windows XP ................................................................. 179
Scanning an Image Using Windows Vista or Windows 7 ................................. 180
Adjusting Scanning Settings ........................................................................... 181
  Setting the Output Color ........................................................................... 181
  Setting the Scan Resolution ................................................................. 182
  Selecting 2-Sided Scanning ................................................................. 182
  Setting the File Format ........................................................................ 182
  Making the Image Lighter or Darker .................................................. 182
  Adjusting the Sharpness ...................................................................... 183
  Adjusting the Contrast ........................................................................ 183
  Specifying the Original Size .............................................................. 183
  Erasing Edges ..................................................................................... 183
  Changing the Default Scan Settings .................................................. 184
    Changing the Default for File Format .............................................. 184
    Changing Output Color ................................................................... 184
    Changing the Default Scan Resolution ....................................... 185
    Changing the Original Size ............................................................ 185
    Changing the Default for 2-Sided Scanning .................................. 185
    Changing Lighten/Darken ................................................................ 185
    Changing the Default for Sharpness .............................................. 185
    Changing the Default for Contrast .............................................. 185
    Changing Auto Background Suppression ...................................... 185
    Changing Auto Background Suppression Level ............................... 186
    Changing Edge Erase ...................................................................... 186
    Changing the Default for TIFF File Format .................................. 186
    Changing the Default for Quality/File Size .................................. 186
    Changing the Default for Maximum Email Size ............................ 186
Limiting Access to Scanning ........................................................................ 187

8 Faxing ......................................................................................................... 189

Configuring the Printer for Faxing .............................................................. 190
Loading Documents for Faxing .................................................................... 191
Sending a Fax from the Printer .................................................................... 192
Sending a Delayed Fax ............................................................................... 193
Sending a Cover Page with a Fax .............................................................. 194
Sending a Fax From Your Computer ........................................................... 195
  Sending a Fax Using Windows Applications .................................. 195
  Sending a Fax Using Macintosh Applications .................................. 196
Printing a Secure Fax .................................................................................. 197
Polling a Remote Fax Machine ..................................................................... 198
Manually Sending, Receiving, or Polling Using OnHook ............................. 199
  Manually Sending, Receiving, or Polling Using OnHook ................. 199
Editing the Fax Address Book ..................................................................... 200
  Adding or Editing Contacts in the Fax Address Book in CentreWare Internet Services .... 200
  Adding or Editing Groups in the Fax Address Book in CentreWare Internet Services ..... 200
  Adding or Editing Contacts in the Fax Address Book at the Control Panel .... 201
9 Maintenance

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cleaning the Printer</td>
<td>204</td>
</tr>
<tr>
<td>General Precautions</td>
<td>204</td>
</tr>
<tr>
<td>Cleaning the Exterior</td>
<td>205</td>
</tr>
<tr>
<td>Cleaning the Scanner</td>
<td>205</td>
</tr>
<tr>
<td>Cleaning the Interior</td>
<td>208</td>
</tr>
<tr>
<td>Adjustments and Maintenance Procedures</td>
<td>219</td>
</tr>
<tr>
<td>Color Registration</td>
<td>219</td>
</tr>
<tr>
<td>Adjusting for the Paper Type</td>
<td>222</td>
</tr>
<tr>
<td>Adjusting the Transfer Belt Unit</td>
<td>222</td>
</tr>
<tr>
<td>Adjusting the Fuser</td>
<td>223</td>
</tr>
<tr>
<td>Adjusting the Transfer Roller</td>
<td>223</td>
</tr>
<tr>
<td>Initializing NVM</td>
<td>224</td>
</tr>
<tr>
<td>Initializing the Print Meter</td>
<td>224</td>
</tr>
<tr>
<td>Resetting the Transfer Unit</td>
<td>225</td>
</tr>
<tr>
<td>Clearing Storage</td>
<td>225</td>
</tr>
<tr>
<td>Formatting the Hard Disk Drive</td>
<td>226</td>
</tr>
<tr>
<td>Adjusting the Altitude</td>
<td>226</td>
</tr>
<tr>
<td>Clearing Job History</td>
<td>227</td>
</tr>
<tr>
<td>Adjusting the Touchscreen</td>
<td>227</td>
</tr>
<tr>
<td>Ordering Supplies</td>
<td>228</td>
</tr>
<tr>
<td>Consumables</td>
<td>228</td>
</tr>
<tr>
<td>Routine Maintenance Items</td>
<td>228</td>
</tr>
<tr>
<td>When to Order Supplies</td>
<td>229</td>
</tr>
<tr>
<td>Toner Cartridges</td>
<td>230</td>
</tr>
<tr>
<td>Recycling Supplies</td>
<td>230</td>
</tr>
<tr>
<td>Managing the Printer</td>
<td>231</td>
</tr>
<tr>
<td>Checking Page Counts</td>
<td>231</td>
</tr>
<tr>
<td>Changing the Passcode Using the Control Panel</td>
<td>231</td>
</tr>
<tr>
<td>Moving the Printer</td>
<td>232</td>
</tr>
</tbody>
</table>

10 Troubleshooting

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>General Troubleshooting</td>
<td>236</td>
</tr>
<tr>
<td>Printer Does Not Turn On</td>
<td>236</td>
</tr>
<tr>
<td>Printer Resets or Turns Off Frequently</td>
<td>237</td>
</tr>
<tr>
<td>Printer Does Not Print</td>
<td>237</td>
</tr>
<tr>
<td>Printing Takes Too Long</td>
<td>238</td>
</tr>
<tr>
<td>Document Prints From Wrong Tray</td>
<td>239</td>
</tr>
<tr>
<td>Automatic 2-Sided Printing Problems</td>
<td>239</td>
</tr>
<tr>
<td>Printer is Making Unusual Noises</td>
<td>239</td>
</tr>
<tr>
<td>Paper Tray Will Not Close</td>
<td>239</td>
</tr>
<tr>
<td>Condensation has Formed Inside the Printer</td>
<td>240</td>
</tr>
<tr>
<td>Paper Jams</td>
<td>241</td>
</tr>
</tbody>
</table>
Contents

Germany ..................................................................................................................................................................... 285
Turkey RoHS Regulation ...................................................................................................................................... 285
Regulatory Information for 2.4 GHz Wireless Network Adapter ........................................................ 285
Copy Regulations ............................................................................................................................................................ 286
  United States ............................................................................................................................................................ 286
  Canada ........................................................................................................................................................................ 288
  Other Countries ....................................................................................................................................................... 288
Fax Regulations ............................................................................................................................................................... 289
  United States ............................................................................................................................................................ 289
  Canada ........................................................................................................................................................................ 291
  European Union ...................................................................................................................................................... 291
  South Africa .............................................................................................................................................................. 291
  New Zealand .............................................................................................................................................................. 292
Material Safety Data Sheets ...................................................................................................................................... 293

C Recycling and Disposal ............................................................................................................................................ 295
  All Countries ...................................................................................................................................................................... 296
  North America .................................................................................................................................................................. 297
  European Union ............................................................................................................................................................... 298
    Domestic/Household Environment ................................................................................................................ 298
    Professional/Business Environment ................................................................................................................ 298
    Collection and Disposal of Equipment and Batteries ...................................................................................... 299
    Battery Symbol Note ............................................................................................................................................. 299
    Battery Removal ...................................................................................................................................................... 299
  Other Countries ................................................................................................................................................................ 300
This chapter includes:

- **Electrical Safety** .................................................................................................................................................................... 14
- **Operational Safety** .............................................................................................................................................................. 17
- **Maintenance Safety** ........................................................................................................................................................... 19
- **Printer Symbols** ..................................................................................................................................................................... 20
- **Environmental, Health, and Safety Contact Information** ................................................................................................. 21

Your printer and the recommended supplies have been designed and tested to meet strict safety requirements. Attention to the following information ensures the continued safe operation of your Xerox printer.
Electrical Safety

This section includes:

- General Guidelines .............................................................................................................................................................. 14
- Power Cord .............................................................................................................................................................................. 15
- Emergency Turn Off ............................................................................................................................................................ 15
- Telephone Line Cord ........................................................................................................................................................... 15
- Laser Safety ............................................................................................................................................................................ 16

General Guidelines

**WARNINGS:**

- Do not push objects into slots or openings on the printer. Touching a voltage point or shorting out a part could result in fire or electric shock.
- Do not remove the covers or guards that are fastened with screws unless you are installing optional equipment and are instructed to do so. Turn off the printer when performing these installations. Disconnect the power cord when removing covers and guards for installing optional equipment. Except for user-installable options, there are no parts that you can maintain or service behind these covers.

The following are hazards to your safety:

- The power cord is damaged or frayed.
- Liquid is spilled into the printer.
- The printer is exposed to water.
- The printer emits smoke, or the surface is unusually hot.
- The printer emits unusual noise or odors.
- The printer causes a circuit breaker, fuse, or other safety device to activate.

If any of these conditions occur, do the following:

1. Turn off the printer immediately.
2. Disconnect the power cord from the electrical outlet.
3. Call an authorized service representative.
Safety

Power Cord

- Use the power cord supplied with your printer.
- Plug the power cord directly into a properly grounded electrical outlet. Ensure that each end of the cord is connected securely. If you do not know if an outlet is grounded, ask an electrician to check the outlet.
- Do not use a ground adapter plug to connect the printer to an electrical outlet that does not have a ground connection terminal.

⚠️ **WARNING:** Avoid the potential of electrical shock by ensuring that the printer is grounded properly. Electrical products can be hazardous if misused.

- Only use an extension cord or power strip designed to handle the electrical current capacity of the printer.
- Verify that the printer is plugged into an outlet that is providing the correct voltage and power. Review the electrical specification of the printer with an electrician if necessary.
- Do not place the printer in an area where people can step on the power cord.
- Do not place objects on the power cord.
- Replace the power cord if it becomes frayed or worn.
- Do not unplug or plug the power cord while the printer is turned on.
- To avoid electrical shock and damage to the cord, grasp the plug when unplugging the power cord.
- The electrical outlet must be near the printer and must be easily accessible.

The power cord is attached to the printer as a plug-in device on the back of the printer. If it is necessary to disconnect all electrical power from the printer, disconnect the power cord from the electrical outlet.

Emergency Turn Off

If any of the following conditions occur, turn off the printer immediately and disconnect the power cord from the electrical outlet. Contact an authorized Xerox service representative to correct the problem if:

- The equipment emits unusual odors or makes unusual noises.
- The power cable is damaged or frayed.
- A wall panel circuit breaker, fuse, or other safety device has been tripped.
- Liquid is spilled into the printer.
- The printer is exposed to water.
- Any part of the printer is damaged.

Telephone Line Cord

⚠️ **WARNING:** To reduce the risk of fire, use only No. 26 American Wire Gauge (AWG) or larger telecommunication line cord.
Laser Safety

This printer complies with laser product performance standards set by governmental, national, and international agencies and is certified as a Class 1 Laser Product. The printer does not emit hazardous light because the beam is totally enclosed during all modes of customer operation and maintenance.

⚠️ **WARNING:** Use of controls, adjustments, or performance of procedures other than those specified in this manual can result in hazardous radiation exposure.
Operational Safety

Your printer and supplies were designed and tested to meet strict safety requirements. These include safety agency examination, approval, and compliance with established environmental standards. Your attention to the following safety guidelines helps to ensure the continued, safe operation of your printer.

Operational Guidelines

• Do not remove any paper trays while the printer is printing.
• Do not open the doors when the printer is printing.
• Do not move the printer when it is printing.
• Keep hands, hair, neckties, and so on, away from the exit and feed rollers.
• Covers, which require tools for removal, protect the hazard areas within the printer. Do not remove the protective covers.

Ozone Release

This printer produces ozone during normal operation. The amount of ozone produced is dependent on copy volume. Ozone is heavier than air and is not produced in amounts large enough to harm anyone. Install the printer in a well-ventilated room.

For more information in the United States and Canada, go to www.xerox.com/environment. In other markets, please contact your local Xerox representative or go to www.xerox.com/environment_europe.

Printer Location

• Place the printer on a level, solid, non-vibrating surface with adequate strength to hold its weight. To find the weight for your printer configuration, see Physical Specifications on page 272.
• Do not block or cover the slots or openings on the printer. These openings are provided for ventilation and to prevent overheating of the printer.
• Place the printer in an area where there is adequate space for operation and servicing.
• Place the printer in a dust-free area.
• Do not store or operate the printer in an extremely hot, cold, or humid environment.
• Do not place the printer near a heat source.
• Do not place the printer in direct sunlight to avoid exposure to light-sensitive components.
• Do not place the printer where it is directly exposed to the cold air flow from an air conditioning system.
• Do not place the printer in locations susceptible to vibrations.
• For optimum performance, use the printer at the elevations specified in Elevation on page 276.
Printer Supplies

- Use the supplies designed for your printer. The use of unsuitable materials can cause poor performance and a possible safety hazard.
- Follow all warnings and instructions marked on, or supplied with, the product, options, and supplies.
- Store all consumables in accordance with the instructions given on the package or container.
- Keep all consumables away from the reach of children.
- Never throw toner, print/drum cartridges, or toner containers into an open flame.
- When handling cartridges, for example toner and such, avoid skin or eye contact. Eye contact can cause irritation and inflammation. Do not attempt to disassemble the cartridge, which can increase the risk of skin or eye contact.

⚠️ CAUTION: Use of non-Xerox supplies is not recommended. The Xerox Warranty, Service Agreement, and Total Satisfaction Guarantee do not cover damage, malfunction, or degradation of performance caused by use of non-Xerox supplies, or the use of Xerox supplies not specified for this printer. The Total Satisfaction Guarantee is available in the United States and Canada. Coverage could vary outside these areas. Please contact your Xerox representative for details.
Maintenance Safety

- Do not attempt any maintenance procedure that is not specifically described in the documentation supplied with your printer.
- Do not use aerosol cleaners. Clean with a dry lint-free cloth only.
- Do not burn any consumables or routine maintenance items. For information on Xerox supplies recycling programs, go to www.xerox.com/gwa.
## Printer Symbols

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Warning" /></td>
<td></td>
</tr>
</tbody>
</table>
| **Warning:**  
Indicates a hazard which, if not avoided, could result in death or serious injury. |
| ![Caution](image)  |
| **Caution:**  
Indicates a mandatory action to take in order to avoid damage to the property. |
| ![Hot Surface](image)  |
| Hot surface on or in the printer. Use caution to avoid personal injury. |
| ![No Burn](image)  |
| Do not burn the item. |
| ![No Light](image)  |
| Do not expose the imaging unit to light for more than 10 minutes. |
| ![No Sunlight](image)  |
| Do not expose the imaging unit to direct sunlight. |
| ![No Touch](image)  |
| Do not touch the part or area of the printer. |
| ![Warning](image) ![Hot](image)  |
| **Warning:**  
Wait for the printer to cool for the specified time before touching the fuser. |
| ![Recycle](image)  |
| This item can be recycled. For details, see [Recycling and Disposal](#) on page 295. |
Environmental, Health, and Safety Contact Information

For more information on Environment, Health, and Safety in relation to this Xerox product and supplies, contact the following customer help lines:

United States: 1-800 828-6571
Canada: 1-800 828-6571
Europe: +44 1707 353 434

For product safety information in the United States, go to www.xerox.com/environment.

For product safety information in Europe, go to www.xerox.com/environment_europe.
This chapter includes:

- Parts of the Printer ................................................................. 24
- Energy Saver Mode ............................................................... 28
- Information Pages ............................................................... 29
- Administrative Features ....................................................... 30
- More Information ............................................................... 33
Parts of the Printer

This section includes:

- Front View ................................................................. 24
- Rear View ........................................................................ 25
- Internal Parts .................................................................. 26
- Control Panel .................................................................. 26

Front View

1. Tray 1
2. Bypass Tray
3. Front Door
4. USB Memory Port
5. Control Panel
6. Duplex Automatic Document Feeder
7. Output Tray
8. Right Side Door
9. Power Switch
10. Tray 2, Optional 550-Sheet Feeder
1. Duplex Unit
2. Transfer Roller
3. Fuser
4. Power Connector
5. Rear Door
6. Control Board
7. Left Side Door
8. Ethernet Connection
9. USB Port
10. Wireless Network Adapter Port
11. Phone Connector
12. Fax Line Connector
13. Phone Line Cover
Internal Parts

1. Front Door
2. Toner Cartridges
3. Document Glass
4. Document Cover
5. Duplex Automatic Document Feeder
6. Waste Cartridge Lock
7. Imaging Units
8. Waste Cartridge

Control Panel

The control panel consists of a touch screen and buttons you press to control the functions available on the printer. The control panel:

- Displays the current operating status of the printer.
- Provides access to print features.
- Provides access to reference materials.
- Provides access to Tools and Setup menus.
- Provides access to Troubleshooting menus and videos.
- Prompts you to load paper, replace supplies, and clear jams.
- Displays errors and warnings.
1. **Services Home** button invokes the Services home menu for access to printer features, such as copy, scan, and fax.

2. **Touch Screen** displays information and provides access to printer functions.

3. **Alphanumeric Keypad** enters alphanumeric information.

4. **Clear All** clears previous and changed settings for the current selection.

5. **Power Saver** enters and exits low-power mode.

6. **Stop** cancels the current job.

7. **Start** starts the selected copy, scan, fax, or Print From job, such as Print from USB.

8. **Error Indicator**
   - This light indicates an error condition or warning that requires your attention.
   - This light blinks red when an error occurs that requires technical support.

9. **Ready Indicator**
   - The light appears green when the printer is ready to receive data, and blinks when the printer is busy receiving data.
   - The light blinks green when the printer is busy receiving data.

10. **Clear** clears a number field or clears the last number of a numeric entry.

11. **Redial/Pause** recalls the last fax number used or inserts pauses in fax numbers.

12. **Machine Status** button switches the display to the System menus.

13. **Job Status** displays the active jobs, Secure Print Jobs, and Secure Fax Jobs available in Job Status on the touch screen.
Energy Saver Mode

You can set the time the printer spends idle in ready mode before the printer transitions to a lower power level.

Exiting Energy Saver Mode

The printer automatically cancels Energy Saver mode when it receives data from a connected computer.

To exit Energy Saver mode manually, press the **Power Saver** button on the control panel.
Information Pages

Your printer has a printable set of information pages. These include configuration and font information, demonstration pages, and more.

Configuration Report

The Configuration Report lists printer information such as default settings, installed options, network settings including IP address, and font settings. Use the information on this page to help you configure network settings for your printer, and to view page counts and system settings.

Printing a Configuration Report

1. At the printer control panel, press the Machine Status button.
2. Touch Information Pages.
3. Touch Configuration, then touch Print.
Administrative Features

CentreWare Internet Services

CentreWare Internet Services is the administration and configuration software installed on the embedded Web server in the printer. It allows you to configure and administer the printer from a Web browser.

CentreWare Internet Services requires:
- A TCP/IP connection between the printer and the network in Windows, Macintosh, UNIX, or Linux environments.
- TCP/IP and HTTP enabled in the printer.
- A network-connected computer with a Web browser that supports JavaScript.

Accessing CentreWare Internet Services

At your computer, open a Web browser, in the address field, type the IP address of the printer, then press Enter or Return.

Finding the IP Address of the Printer

You can view the IP address of your printer on the control panel or on the Configuration Report.

Finding the IP Address at the Control Panel

If Display Network Settings is set to Show IPv4 Address, the address appears in the top left corner of the touch screen display. To display the IPv4 Address on the control panel, do one of the following:

To configure Display Network Settings using CentreWare Internet Services:

Click Properties>Security>Secure Settings>Display Network Settings>Show IPv4 Address>Save Changes. For details, see the Help in CentreWare Internet Services.

To configure Display Network Settings at the control panel:
1. At the printer control panel, press the Machine Status button.
2. Touch Tools>Admin Settings.
3. To change the page to 2 of 2, on the right side, touch the Down arrow.
4. Touch Secure Settings. To change the page to 2 of 3, on the right side, touch the Down arrow.
5. Touch Display Network Settings>Show IPv4 Address.
6. To save the setting, touch OK.
To view the IP address on the control panel when Display Network Settings is not enabled:
1. At the printer control panel, press the **Machine Status** button.
2. Touch **Tools**>**Admin Settings**>**Network**>**Ethernet**>**TCP/IP**.
3. Record the IP address from the display.
4. To return to the Services Home menu, press the **Services Home** button.

**Finding the IP Address on the Configuration Report**

1. At the printer control panel, press the **Machine Status** button.
2. Touch **Information Pages**.
3. Touch **Configuration**, then touch **Print**.
   IPv4 and IPv6 address information is located in the Network Setup section of the Configuration Report under TCP/IPv4 and TCP/IPv6.

**Accessing the Printer**

The system administrator can set access rights on the printer to ensure that unauthorized users cannot access the printer. If the system administrator configures authentication and authorization, users require a login and password to access some or all of the features of the printer. The administrator can also configure accounting to require an accounting code to access tracked features.

**Logging In**

Logging in is the process by which you identify yourself to the printer for authentication. If authentication is set, to access printer features, you log in with your user credentials.

**Logging In at the Control Panel**

1. At the printer control panel, press the **Machine Status** button.
2. Touch **Tools**>**Admin Settings**.
3. Type the passcode using the keypad.
4. Touch **OK**.
   *Note:* Repeat steps 3 and 4 of the procedure to access each service that is password protected.
Logging In to CentreWare Internet Services

When Administrator Mode is enabled, the Jobs, Address Book, Properties, and Support tabs are locked until you enter the administrator user name and password.

To log in to CentreWare Internet Services as the administrator:
1. At your computer, open a Web browser, in the address field, type the IP address of the printer, then press Enter or Return.
   
   Note: If you do not know the IP address of your printer, see Finding the IP Address of Your Printer on page 30.

2. Click the Jobs, Address Book, Properties, or Support tab.
3. Type the administrator user name.
4. Type the password, then type the password again to verify.

Meter Readings

The Meter Readings menu shows the number of processed print jobs. The meter is divided according to the color mode. You cannot reset the meter readings; they track the total number of pages printed for the life of the printer.

To view the Billing Meter at the control panel:
1. At the printer control panel, press the Machine Status button.
2. Touch Meter Readings.
3. After viewing the readings, touch X to close the window or press the Services Home button to return to the Services Home menu.

Billing and Usage Information

Billing and printer usage information appears on the Print Volume Report. The impression counts shown are used for billing. The report lists usage information by user names, then divides usage into page size and sheets for each user. Page count is printed on the Configuration Report and appears in the control panel Meter Readings.

Printing the Print Volume Report
1. At the printer control panel, press the Machine Status button.
2. Touch Information Pages.
3. Use the Up or Down arrows to navigate, then touch Print Meter.
4. Touch Print.
# More Information

You can obtain more information about your printer from these sources:

<table>
<thead>
<tr>
<th>Resource</th>
<th>Location</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Installation Guide</strong></td>
<td>Packaged with the printer.</td>
</tr>
<tr>
<td>Other documentation for your printer</td>
<td><a href="http://www.xerox.com/office/WC6605docs">www.xerox.com/office/WC6605docs</a></td>
</tr>
<tr>
<td>Recommended Media List</td>
<td>United States: <a href="http://www.xerox.com/paper">www.xerox.com/paper</a></td>
</tr>
<tr>
<td></td>
<td>European Union: <a href="http://www.xerox.com/europaper">www.xerox.com/europaper</a></td>
</tr>
<tr>
<td>Technical support information for your printer; including online technical support, Online Support Assistant, and driver downloads.</td>
<td><a href="http://www.xerox.com/office/WC6605support">www.xerox.com/office/WC6605support</a></td>
</tr>
<tr>
<td>Information about menus or error messages</td>
<td>Press the control panel Help (?) button.</td>
</tr>
<tr>
<td>Information Pages</td>
<td>Print from the control panel, or from CentreWare Internet Services, click <strong>Status&gt;Information Pages</strong>.</td>
</tr>
<tr>
<td>CentreWare Internet Services documentation</td>
<td>In CentreWare Internet Services, click <strong>Help</strong>.</td>
</tr>
<tr>
<td>Order supplies for your printer</td>
<td><a href="http://www.xerox.com/office/WC6605supplies">www.xerox.com/office/WC6605supplies</a></td>
</tr>
<tr>
<td>A resource for tools and information, including interactive tutorials, printing templates, helpful tips, and customized features to meet your individual needs.</td>
<td><a href="http://www.xerox.com/office/businessresourcecenter">www.xerox.com/office/businessresourcecenter</a></td>
</tr>
<tr>
<td>Local sales and support center</td>
<td><a href="http://www.xerox.com/office/worldcontacts">www.xerox.com/office/worldcontacts</a></td>
</tr>
<tr>
<td>Printer registration</td>
<td><a href="http://www.xerox.com/office/register">www.xerox.com/office/register</a></td>
</tr>
<tr>
<td>Xerox® Direct online store</td>
<td><a href="http://www.direct.xerox.com/">www.direct.xerox.com/</a></td>
</tr>
</tbody>
</table>
This chapter includes:

- Installation and Setup Overview ................................................................................................................................. 36
- Selecting a Location for the Printer ................................................................................................................................. 37
- Connecting the Printer ....................................................................................................................................................... 38
- Configuring Network Settings ........................................................................................................................................ 50
- Assigning the Printer IP Address .................................................................................................................................. 51
- Setting Up the Network Address Book .......................................................................................................................... 55
- Configuring General Setup Using CentreWare Internet Services ........................................................................... 56
- Configuring General Setup Using the Control Panel ............................................................................................... 61
- Configuring AirPrint ............................................................................................................................................................ 69
- Configuring Fax Defaults and Settings .......................................................................................................................... 70
- Setting Up Scanning ........................................................................................................................................................... 77
- Configuring Security Settings Using CentreWare Internet Services ...................................................................... 83
- Configuring Secure Settings Using the Control Panel ............................................................................................... 94
- Managing Certificates ....................................................................................................................................................... 98
- Configuring Smart eSolutions ........................................................................................................................................ 104
- Enabling the Printer for Scanning ................................................................................................................................. 108
- Installing the Software .................................................................................................................................................... 109
- Installing the Printer as a Web Service on Devices ...................................................................................................... 115

See also:

Installation Guide packaged with your printer.

Online Support Assistant at www.xerox.com/office/WC6605support
Installation and Setup Overview

Before printing, your computer and the printer must be plugged in, turned on, and connected. Configure the initial settings of the printer, then install the driver software and utilities on your computer.

You can connect to your printer directly from your computer using USB, or connect over a network using an Ethernet cable or wireless connection. Hardware and cabling requirements vary for the different connection methods. Routers, network hubs, network switches, modems, Ethernet cables, and USB cables are not included with your printer and must be purchased separately. Xerox recommends an Ethernet connection because it is typically faster than a USB connection, and it provides access to CentreWare Internet Services.

Note: If the Software and Documentation disc is not available, you can download the latest drivers from www.xerox.com/office/WC6605drivers.

See also:
Selecting a Location for the Printer on page 37
Choosing a Connection Method on page 38
Connecting the Printer on page 38
Configuring Network Settings on page 50
Installing the Software on page 109
Selecting a Location for the Printer

1. Select a dust-free area with temperatures from 10–32°C (50–90°F), and relative humidity 15–85%.

   Note: Sudden temperature fluctuations can affect print quality. Rapid heating of a cold room can cause condensation inside the printer, directly interfering with image transfer.

2. Place the printer on a level, solid, non-vibrating surface with adequate strength for the weight of the printer. The printer must be horizontal with all four feet in solid contact with the surface. To find the weight for your printer configuration, see Physical Specifications on page 272.

After positioning the printer, you are ready to connect it to the power source and computer or network.

See also:
Total Space Requirements on page 273
Clearance Requirements on page 274
Connecting the Printer

This section includes:

- Selecting a Connection Method .................................................................................................................................... 38
- Connecting to a Computer Using USB ....................................................................................................................... 39
- Connecting to a Wired Network .................................................................................................................................... 39
- Connecting to a Wireless Network................................................................................................................................ 39
- Connecting to a Telephone Line................................................................................................................................... 49

Selecting a Connection Method

The printer can be connected to your computer using a USB cable or an Ethernet cable. The method you select depends on how your computer is connected to the network. A USB connection is a direct connection and is the easiest to set up. An Ethernet connection is used for networking. If you are using a network connection, it is important to understand how your computer is connected to the network. For details, see About TCP/IP and IP Addresses on page 50.

Note: Hardware and cabling requirements vary for the different connection methods. Routers, network hubs, network switches, modems, Ethernet cables, and USB cables are not included with your printer and must be purchased separately.

- **Network**: If your computer is connected to an office network or home network, use an Ethernet cable to connect the printer to the network. You cannot connect the printer directly to the computer. It must be connected through a router or hub. An Ethernet network can be used for one or more computers and supports many printers and systems simultaneously. Ethernet connection is typically faster than USB and allows you direct access to the settings of the printer using CentreWare Internet Services.

- **Wireless Network**: If your computer includes a wireless router or wireless access point, you can connect the printer to the network with a wireless connection. A wireless network connection provides the same access and services as a wired connection provides. A wireless network connection is typically faster than USB and allows direct access to the setting of the printer using CentreWare Internet Services.

- **USB**: If you connect the printer to one computer and do not have a network, use a USB connection. A USB connection offers fast data speeds, but typically not as fast as an Ethernet connection. In addition, a USB connection does not provide access to CentreWare Internet Services.

- **Telephone**: To send and receive faxes, the multifunction printer must be connected to a dedicated telephone line.
Connecting to a Computer Using USB

To use USB, you must have Windows XP SP1 and later, Windows Server 2003 and later, or Macintosh OS X version 10.5 and later.

To connect the printer to the computer using a USB cable:
1. Ensure that the printer is turned off.
2. Connect the B end of a standard A/B USB 2.0 cable to the USB Port on the back of the printer.
3. Attach the power cord and then plug in the printer and turn it on.
4. Connect the A end of the USB cable to the USB Port on the computer.
5. When the Windows Found New Hardware Wizard appears, cancel it.
6. You are ready to install the print drivers. For details, see Installing the Software on page 109.

Connecting to a Wired Network

1. Ensure that the printer is turned off.
2. Attach a Category 5 or better Ethernet cable from the printer to the network or router socket. Use an Ethernet hub or router, and two or more Ethernet cables. Connect the computer to the hub or router with one cable, then connect the printer to the hub or router with the second cable. Connect to any port on the hub or router except the uplink port.
3. Attach the power cord, then plug in the printer and turn it on.
4. Set or automatically discover the network IP address of the printer.

For details, see Assigning the IP address of the printer on page 51.

Connecting to a Wireless Network

A wireless local area network (WLAN) provides the means to connect two or more devices in a LAN without a physical connection. The printer can connect to a wireless LAN that includes a wireless router or wireless access point. Before connecting the printer to a wireless network, the wireless router must be configured with a service set identifier (SSID), a passphrase, and security protocols.

Note: Wireless networking is available only on printers with the optional Wireless Network Adapter installed.
Installing the Wireless Network Adapter

The optional wireless network adapter plugs in to the back of the control board. After the adapter is installed, and wireless networking is enabled and configured, the adapter is able to connect to a wireless network.

To install the Wireless Network Adapter:
1. Turn off the printer.

2. Remove the packaging from the Wireless Network Adapter.
3. Follow the installation sheet and install the Wireless Network Adapter on the printer.

Note: When the Wireless Network Adapter is installed, remove it only as needed and after reading the instructions for removing the Wireless Network Adapter.

4. To enable the Wireless Network Adapter, disconnect the Ethernet cable from the printer.
5. Turn on the printer.

6. In the Admin Menu, configure the Wi-Fi Settings.

See also:
- Connecting to a network with a Wi-Fi protected setup on page 43
- Connecting to a wireless network using the control panel on page 45
- Connecting to a wireless network manually on page 45
- Connecting to a wireless network using CentreWare Internet Services on page 46

**Removing the Wireless Network Adapter**

1. Turn off the printer.
2. Unscrew the thumbscrew on the back of the left door, then open the left door.

3. Locate the plastic latch release on the Wireless Network Adapter protruding through the back of the chassis.

4. Reach into the chassis and push inward, then back on the latch release to remove the Wireless Network Adapter.

![Image](image_url)

⚠️ **CAUTION:** Do not use force to pull on the Wireless Network Adapter. If the latch is released properly, the adapter pulls out easily. Pulling on the adapter can damage it.

5. Close the left door, then screw in the thumbscrew on the back of the door.

6. Using an Ethernet cable, connect the printer to your computer with a USB cable or through the network.

7. Turn on the printer.

![Image](image_url)
Resetting Wireless Settings

If the printer was previously installed in a wireless network environment, it could retain setup and configuration information.

To prevent the printer from trying to connect to the previous network, perform the following steps:
1. At the printer control panel, press the Machine Status button.
2. Touch the Tools tab.
3. Touch Admin Setting>Network>Wi-Fi.
4. Touch the Down arrow to navigate to the next screen.
5. Touch Reset Wi-Fi>Reset>Yes, Reset.

Connecting to a Network with a Wi-Fi Protected Setup

Wi-Fi Protected Setup (WPS) is a network standard for setting up a wireless network. The WPS protocols allow you with no wireless network experience to set up devices in a secure wireless network. With a WPS-certified router, you can use tools in the router and the printer to connect the printer to the network. In order to use the tools, the wireless router must be configured properly and must be compliant with the WPS.

- Push Button Connection (PBC) is the easiest way to connect the printer to a wireless network. It automatically connects when you push a button on the router and on the printer. After the router and printer exchange information, the printer accepts the security and configuration information from the router and connects to the network. The PBC is a moderately secure way to connect the printer to the network. You do not need to enter any information to make the network connection.
- PIN (Personal Identification Number) automatically connects the printer to wireless router by using a common PIN. The printer generates and prints a PIN for use in the setup process. When you enter the PIN into the router, the router broadcasts network information using the PIN. When both devices recognize the PIN, the router provides the security and configuration information to the printer, which uses it to connect to the network.

To connect to a WPS wireless network using the PBC method:

Note: The wireless router must be connected and properly configured for the network before you install the printer.
1. On the wireless router, push the PBC button.
   The router broadcasts setup information for 120 seconds.
   
   Note: If the wireless router does not have a physical PBC button, use your computer to select the virtual button in the router control panel. For details, see your router documentation.
2. At the printer control panel, press the Machine Status button.
3. Touch the Tools tab.
4. Touch Admin Setting>Network>Wi-Fi.
5. Touch WPS Setup>Push Button Control>Start Configuration.
6. After the printer restarts, wait 20 seconds, then print a Configuration Report to get network information including the IP address.

To connect to a WPS wireless network using the PIN method:
Note: Connect and configure the wireless router for the network before you install the printer.

1. At your computer, open the router control panel, then select Add WPS Client.
   
   Note: For details, see your router documentation.

2. Select PIN Method. The router control panel opens to a dialog box ready for the PIN number.
   
   Note: The following steps can vary with different router manufacturers.

3. At the printer control panel, press the Machine Status button.

4. Touch the Tools tab.

5. Touch Admin Setting > Network > Wi-Fi.

6. Touch PIN Code, then touch Print PIN Code or record the PIN from the screen.

7. Touch Start Configuration.
   
   The printer starts advertising using the PIN Code that it printed on the sheet.
   
   Note: The printer continues to advertise for 120 seconds. If it does not find the wireless router within 120 seconds, the connection attempt is aborted and the printer generates a new PIN.

8. At your computer, enter the PIN Code in the Client PIN Code field of the router control panel, then click Next.
   
   The printer communicates with the router to resolve setup and configuration information. When the printer has the correct information, it connects to the router and restarts with the proper setup and configuration information. If it does not connect with the printer within 120 seconds, the connection stops.

9. After the printer restarts, wait 20 seconds, then print a Configuration Report to get network information including the IP address.
   
   Note: If the printer does not connect to the wireless router, it generates a new PIN Code for the next attempt. Do not try to use the old PIN Code for another attempt.

Collecting Wireless Network Information for Connecting to a Wireless Network Manually

When connecting to a wireless network that does not include a WPS-compliant router, set up and configure the printer manually. Before starting, you must get the setup and configuration information, such as name and passphrase, from the router. After you collect the network information, you can set up the printer from the control panel or from CentreWare Internet Services. For the easiest manual connection, use CentreWare Internet Services.

To record the network information from the wireless router or access point:

1. On your computer, use your Web browser to open the control panel for the wireless router.

2. Click Wireless Settings.

3. Record the following information. The network name and passphrase are case sensitive. Ensure that you record them exactly as they appear in the wireless router control panel.
   
   – Name (SSID)
   – Security Options (Encryption Type)
   – Passphrase
Note: The wireless router must be connected and properly configured for the network before you install the printer. For details, see your router documentation.

Connecting to a Wireless Network Using the Control Panel Wi-Fi Setup Wizard

Before you begin, ensure that you have the wireless network Service Set Identifier (SSID), encryption type, and passphrase. For details, see Collecting Wireless Network Information for Connecting to a Wireless Network Manually on page 44.

To connect to a wireless network using the Wi-Fi Setup Wizard:
1. At the printer control panel, press the Machine Status button.
2. Touch the Tools tab.
3. Touch Admin Setting>Network>Wi-Fi.
4. Touch Wi-Fi Setup Wizard.
5. Select the desired network.
   Note: If the wireless network does not appear in the list, see Connecting to a Wireless Network Manually on page 45.
6. Touch Next.
7. Enter the passcode for the selected network, then touch OK.
8. To view the new IP address and ensure that the connection is successful, print a Configuration Report.

Connecting to a Wireless Network Manually

Before you begin, ensure that you have the wireless network Service Set Identifier (SSID), encryption type, and passphrase. For details, see Collecting Wireless Network Information for Connecting to a Wireless Network Manually on page 44.

To connect to a wireless network manually:
1. At the printer control panel, press the Machine Status button.
2. Touch the Tools tab.
3. Touch Admin Setting>Network>Wi-Fi.
4. Touch Wi-Fi Setup Wizard.
5. Select Manual SSID Setup, then touch Next.
6. Enter the network SSID, then touch Next.
7. Select the Infrastructure type, then touch Next.
8. Enter the passcode for the selected network, then touch OK.
9. To exit the menu, touch OK.
10. Restart the printer, then wait two minutes for the printer to connect.
11. To view the new IP address and ensure that the connection is successful, print a Configuration Report.
Connecting to a Wireless Network Using CentreWare Internet Services

Before you begin, ensure that you have the wireless network Service Set Identifier (SSID), encryption type, and passphrase. For details, see Collecting Wireless Network Information for Connecting to a Wireless Network Manually on page 44.

Note: To use CentreWare Internet Services to set up the printer on a wireless network, connect the printer to your computer through an Ethernet wired network.

To connect to a wireless network manually using the CentreWare Internet Services:

1. At your computer, open a Web browser, in the address field, type the IP address of the printer, then press Enter or Return.
   
   Note: If you do not know the IP address of your printer, see Finding the IP Address of Your Printer on page 30.

2. Click Properties.

3. In the Properties pane at the left of the window, under Physical Connection, click Wi-Fi.

4. In the SSID field, enter the SSID.

5. To select the Network Type, from the drop-down menu, select Infrastructure or AdHoc.
   
   Note: Infrastructure provides the greatest selection of security options. AdHoc provides only WEP encryption in most networks.

6. To select Encryption, under Security Settings, select the appropriate security option for your router.

7. To remove the dots in the Passphrase field, select them, then press Backspace.

8. In the Passphrase field, enter the network passphrase. To remove the dots in the Re-enter Passphrase field, select them, then press Backspace.

9. In the Re-enter Passphrase field, re-enter the network passphrase.

10. Click Save Changes.

11. Disconnect the Ethernet cable from the printer.

12. Turn off the printer, then turn it on again.

   When the printer restarts, it uses the information from CentreWare Internet Services to connect with the wireless router.

Wait about two minutes, then print a Configuration Report to check the connection. If the printer does not successfully connect with the wireless network, check your network information and try again.
Connecting to a Wireless Network Using the Printer Setup Utility

Before you begin, ensure that you have the wireless network Service Set Identifier (SSID), encryption type, and passphrase. For details, see Collecting Wireless Network Information for Connecting to a Wireless Network Manually on page 44.

Note: To use the Printer Setup Utility for setting up on a wireless network, connect your printer to your computer through the Ethernet wired network. You can also use the Printer Setup Utility to set up the printer connected with a USB cable.

1. Open the Printer Setup Utility.
2. At the Select Configuration screen, select Wi-Fi Configuration, then click Next.
3. At Select the current connection to printer screen, select the connection type the printer is currently using.
4. Click Next.
5. From the Access Point list, select the SSID for the network to which you wish to connect.
6. If the desired network does not appear in the list, select Input the SSID directly, then enter the network name in the SSID field.
7. Click Next.
8. In the Password field, enter the password for the selected network.
9. Click Next.
10. On the IP Address Settings screen, select the IP Mode to use for the connection:
   - Dual Stack: Allows the router to assign IPv4 and IPv6 IP addresses, as needed.
   - IPv4: Directs the router to assign an appropriate IPv4 address only.
   - IPv6: Directs the router to assign an appropriate IPv6 address only.
11. Select the type of method of assigning the IP address:
   - DHCP allows your DHCP server to assign an IP address to the printer. This option enables Dynamic DNS Registration.
   - Auto IP allows the printer to assign an IP address to itself, in the absence of a DHCP-capable router or access point.
   - Static IP enables the system administrator to assign an IP address to the printer.
12. If you selected Static IP, do the following:
   a. Enter an IP address that is in the range of the IP address of the access point or router.
   b. Enter the Network Mask, and Gateway Address.
   c. If you need a specific IPv6 address, under IPv6 Settings, select Use Manual Address, then enter the IP Address and Gateway Address.

Note: If the network and wireless router are IPv6 compatible, the router assigns an IPv6 address as appropriate. Do not use Manual Address unless you are experienced assigning and using IPv6 addresses.

13. Click Next.
14. At Confirm the Settings, select your Panel Language, then click Apply.
15. If any of the settings are incorrect, click the Back button to return to the previous screen.
16. To print a record of the IP settings, click Print Printer Settings.
17. Click Finish.
   When the printer restarts, it uses the information from Printer Setup Utility to connect with the wireless router.
18. If the Ethernet cable is connected to the printer, disconnect it.
19. Wait approximately two minutes, then print a Configuration Report to check the connection.
20. If the printer does not successfully connect with the wireless network, check your network information and try again.

Setting Up the Printer for Wireless LAN WPA-Enterprise

WPA-Enterprise Encryption is supported only when Infrastructure is selected as the Network Type in the Wi-Fi settings section.

Note: To manage digital certificates, enable the HDD Data Encryption and HTTPS communication.

1. Import the certificate to use with the wireless LAN. For details, see Importing a Digital Certificate on page 101.
   Note: Use Internet Explorer to import the certificate from Windows. Use Safari to import certificates from Macintosh.
4. Configure WPA-Enterprise for PEAPVO-MS-CHAPV2, EAP-TLS, EAP-TTLS PAP, or EAP-TTLS CHAP.
   a. At your computer, open a Web browser, in the address field, type the IP address of the printer, then press Enter or Return.
   b. Click Properties.
   c. In the left navigation panel, scroll down to Physical Connection, then select Wi-Fi.
   d. Configure the SSID.
   e. At Network Type, select Infrastructure.
   f. In the Security Settings section, select one of the following:
      • WPA-Enterprise-AES/WPA2-Enterprise-AES
      • WPA-Enterprise-TKIP
   g. In the WPA-Enterprise section, configure the EAP Identity, Login Name, and Password.
   h. From the Authentication Method list, select one of the following:
      • PEAPVO-MS-CHAPV2
      • EAP-TLS
      • EAP-TTLS PAP
      • EAP-TTLS CHAP
   i. Click Save Changes.
Connecting to a Telephone Line

1. Ensure that the printer is turned off.
2. Connect a standard RJ11 cable, No. 26 American Wire Gauge (AWG) or larger, to the Line port on the back of the printer.
3. Connect the other end of the RJ11 cable to an operating telephone line.
4. Enable and configure the Fax functions.

For details, see Configuring Fax Settings from the Control Panel on page 72.
Configuring Network Settings

This section includes:

- About TCP/IP and IP Addresses

About TCP/IP and IP Addresses

Computers and printers primarily use TCP/IP protocols to communicate over an Ethernet network. Generally, Macintosh computers use either TCP/IP or the Bonjour protocol to communicate with a network printer. For Macintosh OS X systems, TCP/IP is preferred. Unlike TCP/IP, however, Bonjour does not require printers or computers to have IP addresses.

With TCP/IP protocols, each printer and computer must have a unique IP address. Many networks and cable and DSL routers have a Dynamic Host Configuration Protocol (DHCP) server. A DHCP server automatically assigns an IP address to every computer and printer on the network that is configured to use DHCP.

If you use a Cable or DSL router, see the documentation for your router for information on IP addressing.
Assigning the Printer IP Address

This section includes:

- Assigning the IP Address Automatically ................................................................. 51
- Finding the IP Address of the Printer ................................................................. 52
- Changing the IP Address Using CentreWare Internet Services .................. 52
- Assigning the IP Address Manually ..................................................................... 53

By default, the printer is set to acquire an IP address from the network server using DHCP. Network addresses assigned by DHCP are temporary, however. After a specified time, the network could assign a new IP address to the printer. If the print driver is set to an IP address that changes periodically, you can experience connectivity issues. To avoid problems, or if your network administrator requires a static IP address for the printer, you can assign the IP address to the printer.

Note: You can view the IP address of your printer on the control panel or on the Configuration Report. For details, see Printing the Configuration Report on page 29.

See also:
Assigning the IP Address Manually on page 51
Finding the IP Address of Your Printer on page 30

Assigning the IP Address Automatically

1. At the printer control panel, press the Machine Status button.
2. Touch the Tools tab.
3. Touch Admin Setting > Network.
5. To configure the printer to get an IP address from the server automatically or set its own IP address, select an option:
   - DHCP allows your DHCP server to assign an IP address to the printer. This option enables Dynamic DNS Registration.
   - Auto IP allows the printer to assign an IP address to itself, in the absence of a DHCP-capable router or access point.
   - BOOTP allows the printer to obtain an IP address from a BOOTP server that does not respond to DHCP requests.
   - RARP allows the printer to obtain an IPv4 address from an administrative host server.

   Note: For best results in most networks, select DHCP/AutoIP.
6. Touch OK.
7. At the Restart System prompt, touch Close.
Finding the IP Address of the Printer

To install the print drivers for a network-connected printer, you need the IP address of your printer. You also need the IP address to access the settings of your printer through CentreWare Internet Services. You can view the IP address of your printer from the Configuration Report or on the printer control panel.

Note: After the printer has been on for two minutes, print the Configuration Report. The TCP/IP address appears in the Network section of the page. If the IP address listed on the page is 0.0.0.0, the printer needs more time to acquire an IP address from the DHCP server. Wait two minutes, then print the Configuration Report again.

To print the Configuration Report:
1. At the printer control panel, press the Machine Status button.
2. Touch Information Pages.
3. Touch Configuration, then touch Print.

To view the IP address of the printer on the control panel:
1. At the printer control panel, press the Machine Status button.
2. Touch Tools>Admin Settings>Network> Ethernet> TCP/IP.
3. Record the IP address from the display.
4. To return to the Services Home menu, press the Services Home button.

Changing the IP Address Using CentreWare Internet Services

To change the IP address of the printer using CentreWare Internet Services:
1. At your computer, open a Web browser, in the address field, type the IP address of the printer, then press Enter or Return.
   Note: If you do not know the IP address of your printer, see Finding the IP Address of Your Printer on page 30.
2. Click the Properties link.
   If the Protocols link is not expanded under Properties, scroll to the Protocols link and expand it.
3. Click TCP/IP.
4. In the IPv4 section of the page, make the desired changes. For example, to change the way the printer acquires the IP address, in the Get IP Address field, select a method from the drop-down list.
5. After changing the address information, scroll to the bottom of the page and click Save Changes.
Assigning the IP Address Manually

You can assign a static IP address to your printer from the printer control panel. Once an IP address is assigned, you can change it using CentreWare Internet Services.

To assign a static IP address to the printer, you need the following information:

- An IP address properly configured for your network
- The Network Mask address
- The default Router/Gateway address

If you are on a network managed by a network administrator, contact your network administrator to obtain the network information.

For a home network using routers or other devices to connect the printer to the network, refer to the device instructions on assigning network addresses. The router or device documentation can give you a range of acceptable address numbers you can use. It is important that the addresses be similar to the IP addresses used by other printers and computers on the network, but not the same. Only the last digit must be different. For example, your printer can have the IPv4 address 192.168.1.2 while your computer has the IP address 192.168.1.3. Another device can have the IP address 192.168.1.4.

The router could assign the static IP address of the printer to another computer that obtains its IP address dynamically. To avoid having the IP address reassigned, give the printer an address at the higher end of the range allowed by the router or device. For example, if your computer has IP address 192.168.1.2, and your device allows IP addresses to 192.168.1.25, select an address between 192.168.1.20 and 192.168.1.25.

In IPv6 network configurations, the IPv6 address is assigned automatically.

To assign a static IP address to the printer:

1. At the printer control panel, press the **Machine Status** button.
2. Touch the **Tools** tab.
3. Touch **Admin Setting > Network**.
4. Touch **Ethernet > TCP/IP > Get IP Address**.
5. Touch **Panel > OK**.
6. At the Restart System prompt, touch **Close**.
7. Touch **IP Address**.
8. Using the keypad, enter the address as X.X.X.X, where X is a number from 0–255:
   - To clear an existing number from a cell, press **Clear**.
   - To enter a one or two-digit number, touch the **Right** arrow.
     - When you enter the third digit of a three-digit number, the cursor automatically advances to the next cell.
   - After entering the number in the last cell, touch **OK**.
9. At the Restart System prompt, touch **Close**.
10. Touch **Subnet Mask**.
11. Using the keypad, enter the address as X.X.X.X, where X is a number from 0–255:
   − To clear an existing number from a cell, press **Clear**.
   − To enter a one or two-digit number, to advance to the next cell, touch the **Right** arrow.
     When you enter the third digit of a three-digit number, the cursor automatically advances to
     the next cell.
   − After entering the number in the last cell, touch **OK**.

12. At the Restart System prompt, touch **Close**.

13. Touch **Gateway Address**.

14. Using the keypad, enter the address as X.X.X.X, where X is a number from 0–255:
   − To clear an existing number from a cell, press **Clear**.
   − To enter a one or two-digit number, to advance to the next cell, touch the **Right** arrow.
     When you enter the third digit of a three-digit number, the cursor automatically advances to
     the next cell.
   − After entering the number in the last cell, touch **OK**.

15. At the Restart System prompt, touch **Close**.

16. Turn off the printer, then turn it on again.

See also:

Online Support Assistant at: [www.xerox.com/office/WC6605support](http://www.xerox.com/office/WC6605support)
Setting Up the Network Address Book

Before you can use the Network Address Book, configure the printer to communicate with the LDAP server.

To set up the Network Address Book:
1. At your computer, open a Web browser, in the address field, type the IP address of the printer, then press Enter or Return.
2. Click Properties.
3. In the left navigation panel, scroll to Protocols, then select LDAP Server.
4. Next to IP Address/Host Name & Port, enter the IP address or DNS name for the LDAP server, then enter the port number for LDAP.
   Note: If the optional hard drive is installed and the HDD Data Encryption is enabled, the settings for the LDAP-SSL/TLS appear. Ensure that you save all changes on the LDAP Server page before clicking the SSL link to enable LDAP-SSL/TLS.
5. Enter the Search Directory Root.
6. Enter a valid login name and password.
7. Select one or more of the following:
   – To enable the Network Address Book for the Scan to Email service, select Server Email Address Book.
   – To enable the Network Address Book for the fax service, select Server Fax Address Book.
8. Click Save Changes.
9. At the prompt to restart the system, click Restart.
Configuring General Setup Using CentreWare Internet Services

This section includes:

• Opening General Setup Settings ................................................................. 56
• Viewing Printer Information ........................................................................ 56
• Cloning Printer Settings ................................................................. 57
• Configuring Mail Alerts ....................................................................... 57
• Configuring System Settings ......................................................... 58
• Configuring Clock Settings .................................................................... 58
• Configuring Tray Settings .................................................................... 59
• Setting Up a Proxy Server ...................................................................... 59
• Resetting Service Defaults .................................................................... 60

General Setup in CentreWare Internet Services allows you to configure printer settings onscreen using your Web browser.

Opening General Setup Settings

1. At your computer, open a Web browser, in the address field, type the IP address of the printer, then press Enter or Return.
2. In CentreWare Internet Services, click Properties.
3. To expand the menu, in the Properties pane, next to the General Setup folder, click the plus symbol (+).

Viewing Printer Information

1. At your computer, open a Web browser, in the address field, type the IP address of the printer, then press Enter or Return.
2. In CentreWare Internet Services, click Properties.
3. To expand the menu, in the Properties pane, next to the General Setup folder, click the plus symbol (+).
4. Under Version Information, find the printer model number, serial number, and the firmware version number for the operating systems.
5. Under Page Description Language, find the version numbers of each of the page description languages installed in the printer.
6. In the Memory section, find the amount of RAM and size of the hard drive.
Cloning Printer Settings

You can use cloning to copy configuration settings from one printer to another printer on the same network. To use the clone feature, both the source printer and the destination printer must be the same model and have the same version of firmware.

Note: Before you copy the address book, verify that the address book of the target printer is empty.

To clone the printer settings:
1. From the General Setup menu, click Cloning.
2. Select the parameters to clone from this printer:
   a. To clone the settings from this printer, select Printer Settings.
   b. To clone the contact information from the address book, select Address Book.
3. To use the password for the destination printer, under Enter IP Address of Destination Printer, select Use the printer’s password.
4. In the IP Address field, enter the IP address of the destination printer.
5. If you selected Use the printer’s password, in the Password field, enter the password for the destination printer.
6. Click Clone Selected Settings.

Configuring Mail Alerts

You can define groups to receive email notifications when selected status alerts occur on the printer.

To configure mail alerts:
1. From the General Setup menu, click Mail Alerts.
2. To have the printer send email alerts, select Enable Mail Alerts.
3. To send email alerts to the printer system administrator, next to SysAdmin Mail Address, enter a valid address for the system administrator.
4. To send email alerts to a service representative, next to Service Mail Address, enter a valid address for the service representative.
5. Under Notification Items, select each of the items to generate an email notification for the system administrator or service representative.
6. Click **Save Changes**.

7. Next to Connection Setup, click **Email Settings**.
   a. Enter the From: Email Address for the printer.
   b. Next to SMTP Server, enter the IP Address or DNS Name of the SMTP server to which the printer is connected.
      If you do not know the IP Address or DNS Name of the SMTP server, click **Auto Detect SMTP Server**.
      
      **Note:** Before clicking Auto Detect SMTP Server, to save any entries that you have made, click **Save Changes**.
   c. Next to SMTP Port, enter the port number for the SMTP server.
   d. If the SMTP server requires authentication, select the Authentication Type, then enter the SMTP Login Name and SMTP Password in the appropriate fields.
   e. Click **Save Changes**.

### Configuring System Settings

Use this menu to configure general settings of the printer. For example, time to Energy Saver mode, alarm settings, and so on.

To configure the system settings:
1. From the General Setup menu, click **System Settings**.
2. Under General, enter values for the Energy Saver modes and Display Brightness, then select values for the other selections from each list.
3. Under Timers, select the timeout for the Control Panel from the list, then enter the time in seconds for the Fault Timeout and Job Timeout.
4. Under Output Settings, select a value from the list of each of the items.
5. Click **Save Changes**.

### Configuring Clock Settings

Use this menu to set the date and clock settings of the printer.

To configure the clock settings:
1. From the General Setup menu, click **Clock Settings**.
2. Next to Date Format, Time Format, and Time Zone, select the setting for each from the corresponding list.
3. Using the selected format, next to Set Date, enter the date.
4. Using the selected format, next to Set Time, enter the time.
5. Click **Save Changes**.
Configuring Tray Settings

Use this menu to configure the paper trays for the paper size and type, set custom sizes, and turn the display prompts on and off.

To configure the tray settings:
1. From the General Setup menu, click **Tray Settings**.
2. To use the panel or print driver settings to select the Bypass Tray mode, under Tray Settings select **Bypass Tray Mode**.
3. Under Tray Settings, next to each tray selection, select the paper size and paper type from the lists.
4. Under Tray Settings, enter the custom paper sizes for the paper width (X) and the paper length (Y).
5. To have the display prompt you for the paper settings each time the paper tray is loaded, next to the corresponding tray, select **On**.
6. Under Tray Priority, select the tray priority for paper usage.
7. Click **Save Changes**.

Setting Up a Proxy Server

This feature allows you to set up and enable proxy services on the printer. You can enter your authentication login at the printer control panel, and access a set of features and options designed specifically for your business needs. You can scan and capture paper documents, preview thumbnails, and add them to frequently used document storage locations.

To set up a proxy server:
1. From the Protocols menu, click **Proxy Server**.
2. To enable a proxy server, next to Use Proxy Server, select **Enabled**.
3. Next to Server Name, enter the name for the proxy server.
4. Next to Port Number, enter the port number of the proxy server.
5. If the proxy server requires login for authentication, next to Authentication, select **Enabled**.
6. If you enabled authentication, enter the login name and password for the server.
7. Click **Save Changes**.
Resetting Service Defaults

Use this menu to restart the printer or to reset the default settings for faxing, scanning, printer, and network settings using CentreWare Internet Services.

To reset the printer or to reset system or service defaults:
1. From the General Setup menu, click **Resets**.
2. To reset a service default, next to Reset Fax Defaults or Reset Scan Defaults, click **Power Off/On Printer**.
3. To reset a system default, next to Reset System Defaults or Reset Network Defaults, click **Power Off/On Printer**.
4. To restart the printer without resetting any of the default settings, next to Power Off/On the Printer, click **Power Off/On Printer**.
5. Click **Save Changes**.
Configuring General Setup Using the Control Panel

This section includes:

- Accessing Information About the Printer Using the Control Panel ........................................................................... 61
- Using the Power On Wizard ............................................................................................................................................. 61
- Configuring General Settings .......................................................................................................................................... 63
- Configuring the Timers ...................................................................................................................................................... 66
- Configuring Output Settings ........................................................................................................................................... 67
- Configuring Tray Settings ................................................................................................................................................ 68

Accessing Information About the Printer Using the Control Panel

1. At the printer control panel, press the **Machine Status** button.
2. Touch **Information Pages**.
3. To scroll through the lists of information pages, use the **Up** or **Down** arrows on the touch screen.
4. To print a specific information page, touch the page, then touch **Print**.

Using the Power On Wizard

The Power On Wizard helps to configure several preliminary settings for the printer, including the country, date, time, and time zone.

To use the Power On Wizard to set up the printer:

1. At the printer control panel, press the **Machine Status** button.
2. Touch **Tools > Admin Settings**.
3. Touch **System Settings**, then touch **General**.
4. To navigate to the Power On Wizard, use the **Up** or **Down** arrows, then select **Power On Wizard**.
5. At the prompt, touch **Start**.
6. At the message for Restart is Required, touch **Yes, Restart**.
7. To select your language, use the **Up** or **Down** arrows to navigate, touch your language, then touch **Next**.
8. To select your time zone:
   a. Touch **Time Zone**.
   b. Use the **Up** or **Down** arrows to navigate, select your geographic region and your time zone, then touch **OK**.
9. To set the date:
   a. Touch Date.
   b. Touch Format touch the date format that you want to use, then touch X.
   c. Touch Month, then use the keypad to enter the month.
   d. Touch Day, then use the keypad to enter the date.
   e. Touch Year, then use the keypad to enter the year.
   f. Touch OK.
10. To set the time:
    a. Touch Time.
    b. To select the format, touch 12 Hour or 24 Hour.
    c. Touch Hour, then use the keypad to enter the hour.
    d. Touch Minute, then use the keypad to enter the minutes.
    e. Touch OK.
11. Touch Next.
12. At Do you want to set up Fax now?, select an option.
13. To set up the fax:
   a. Use the keypad to enter the fax number.
   b. Touch Country.
   c. Use the Up or Down arrows to navigate, then touch the name of your country.
   d. Touch Next.
14. At Do you want to set up Email now?, select an option.
15. To select how you would like to find an outgoing mail server, select Find It For Me or I Know My SMTP.
16. If you selected Find It For Me:
   a. Touch Next.
   b. Select a server from the list.
   c. Touch Next.
      The printer runs a test on the SMTP mail server.
17. If you selected I Know My SMTP:
   a. Touch Next.
   b. Use the keypad to enter the SMTP server name.
   c. Touch Next.
   d. Enter the port number for the SMTP server.
   e. Touch Next.
      The printer runs a test on the SMTP mail server.
18. Touch Done.
Configuring General Settings

This section includes:

- Accessing the General Settings Menu......................................................................................................................... 63
- Configuring the Energy Saver Timers.......................................................................................................................... 63
- Setting the Date and Time .............................................................................................................................................. 64
- Setting the Measurement Units .................................................................................................................................... 64
- Setting the Display Brightness ....................................................................................................................................... 64
- Configuring Audio Tones.................................................................................................................................................. 65
- Setting the Startup Page .................................................................................................................................................. 65
- Configuring the Low Toner Alert Message ................................................................................................................ 65
- Setting the OffHook Wake Up........................................................................................................................................ 65
- Setting the Auto Log Print................................................................................................................................................ 66

Use this menu to configure general settings of the printer. For example, time to Energy Saver mode, alarm settings, and so on.

Accessing the General Settings Menu

1. At the printer control panel, press the Machine Status button.
2. Touch Tools>Admin Settings.
3. Touch System Settings, then touch General.

Configuring the Energy Saver Timers

1. At the printer control panel, press the Machine Status button.
2. Touch Tools>Admin Settings.
3. Touch System Settings, then touch General.
5. To set the delay before the printer enters Low Power mode, use the keypad to enter the time, then touch OK. The range is 1–60 minutes.
6. To return to the General menu, touch the Back arrow.
**Setting the Date and Time**

1. Use this menu to configure general settings of the printer. For example, time to Energy Saver mode, alarm settings, and so on.
2. Touch **Date and Time**.
3. To select your time zone:
   a. Touch **Time Zone**.
   b. Use the Up or Down arrows to navigate, select your geographic region and time zone, then touch **OK**.
4. To set the date:
   a. Touch **Date**.
   b. Touch **Format**, touch the date format that you wish to use, then touch X to close the list.
   c. Touch **Month**, then use the keyboard to enter the month.
   d. Touch **Day**, then use the keyboard to enter the date.
   e. Touch **Year**, then use the keyboard to enter the year.
   f. Touch **OK**.
5. To set the time:
   a. Touch **Time**.
   b. To select the format, touch **12 Hour** or **24 Hour**.
   c. Touch **Hour**, then use the keypad to enter the hour.
   d. Touch **Minute**, then use the keypad to enter the minutes.
6. Touch **OK**.
7. To return to the General menu, touch the **Back** arrow.

**Setting the Measurement Units**

1. At the printer control panel, press the **Machine Status** button.
2. Touch **Tools>Admin Settings**.
3. Touch **System Settings**, then touch **General**.
4. Touch **Measurement**.
5. To select an option for units, touch **millimeter (mm)** or **inches (”)**.
6. Touch **OK**.

**Setting the Display Brightness**

1. At the printer control panel, press the **Machine Status** button.
2. Touch **Tools>Admin Settings**.
3. Touch **System Settings**, then touch **General**.
4. Touch **Display Brightness**.
5. Touch - or + on the display or use the keypad to enter a number from 1 through 10.
6. Touch **OK**.
Configuring Audio Tones
1. At the printer control panel, press the **Machine Status** button.
2. Touch **Tools** > **Admin Settings**.
3. Touch **System Settings**, then touch **General**.
4. Touch **Audio**.
5. Select the tone you want to change, then select an option.
6. Repeat step 2 for each tone you want to set.
7. To return to the General menu, touch the **Back** arrow.

Setting the Startup Page
1. At the printer control panel, press the **Machine Status** button.
2. Touch **Tools** > **Admin Settings**.
3. Touch **System Settings**, then touch **General**.
4. Touch **Startup Page**.
5. To print a Startup Page when the printer is turned on, touch **On**.
6. Touch **OK**.

Configuring the Low Toner Alert Message
1. At the printer control panel, press the **Machine Status** button.
2. Touch **Tools** > **Admin Settings**.
3. Touch **System Settings**, then touch **General**.
4. Touch **Low Toner Alert Message**.
5. To display an alert message when the toner is low, touch **On**.
6. Touch **OK**.

Setting the OffHook Wake Up
1. At the printer control panel, press the **Machine Status** button.
2. Touch **Tools** > **Admin Settings**.
3. Touch **System Settings**, then touch **General**.
4. Touch **OffHook Wake Up**.
5. To have the printer leave Energy Saver mode when you pick up the handset of the external telephone, touch **On**.
6. Touch **OK**.
Setting the Auto Log Print

1. At the printer control panel, press the **Machine Status** button.
2. Touch **Tools** > **Admin Settings**.
3. Touch **System Settings**, then touch **General**.
4. Touch **Auto Log Print**.
5. To print a job history log after every 20 print jobs automatically, touch **Auto Log Print**.
6. Touch **OK**.
7. At the Restart System prompt, touch **Close**.

Configuring the Timers

Use the Timers menu to set the timeouts for the control panel touch screen, for faults, and for jobs being sent to the printer.

To configure the timers:

1. At the printer control panel, press the **Machine Status** button.
2. Touch **Tools** > **Admin Settings**.
3. Touch **System Settings** > **Timers**.
4. To set the delay before the control panel times out, touch **Control Panel**, touch the delay you want, then touch **OK**.
5. To set how long the printer waits before canceling a print job that stops abnormally:
   a. Touch **Fault Timeout** > **On**.
   b. Use the keypad minutes to enter a delay time. The range is 3–300 seconds.
   c. Touch **OK**.
6. To set how long the printer waits for data to arrive from a computer:
   a. Touch **Job Timeout** > **On**.
   b. Use the keypad to enter a delay time. The range is 5–300 seconds.
   c. Touch **OK**.
7. To return to the System Settings, touch the **Back** arrow. To return to the Services Home menu, press the **Services Home** button.
Configuring Output Settings

Use this menu to configure settings concerning the output of the printer.

To configure settings for the printer output:

1. To set the default paper size, touch **Default Paper Size**, touch an option, then touch **OK**.
   
   **Note:** The default for Default Paper Size varies depending on the country-specific factory default.

2. To print the user ID on the output page, touch **Print ID**, touch a position where the ID is printed, then touch **OK**.

3. To have the printer output PDL data as text, touch **Print Text**: On**>**OK. The printer does not support printing in PDL.

4. To specify if a banner page is printed:
   a. Touch **Banner Page**.
   b. Touch an option:
      - **Off**: Directs the printer not to print a banner page.
      - **Front**: Directs the printer to insert a banner page before the first page of each copy.
      - **Back**: Directs the printer to insert a banner page after the last page of every copy.
      - **Front and Back**: Directs the printer to insert a banner page before the first page and after the last page of every copy.
   c. Touch **OK**.
   d. To select the tray from which the banner page is printed, touch **Specify Tray**, then touch an option.
   e. Touch **OK**.
   f. To return to the Output Settings menu, touch the **Back** arrow.

5. To select what action the printer takes when a paper size mismatch occurs:
   a. Touch **Size Mismatch**, then select an option:
      - **Off** directs the printer to print with no further action.
      - **Crop to Size** directs the printer to trim the print to fit the printable area of the page.
      - **Scale to Size** directs the printer to reduce or enlarge the print image to fit the printable area of the page.
      - **Use Size in Bypass Tray** directs the printer to use the paper size in the Bypass Tray.
   b. Touch **OK**.

6. To have letterhead print on both sides of the page, touch **Letterhead 2-Sided**: Enable**>**OK.

7. To have information pages print on both sides of the page, touch **Report 2-Sided Print**: 2-Sided**>**OK.

8. Touch the **Back** arrow to return to the previous menu, or press the **Services Home** button to return to Service Home.
Configuring Tray Settings

Use this menu to configure the paper trays for the paper size and type, set custom sizes, and turn the display prompts on and off.

To configure the tray settings:
1. At the printer control panel, press the **Machine Status** button.
2. Touch the **Tools** > **Tray Management** > **Tray Settings**.
3. To configure the Bypass Tray settings:
   a. Touch **Bypass**.
   b. To have the printer prompt you to set the paper type and size when paper is loaded, select **Display Tray Prompt**.
   c. To use the paper size and type from the print driver, select **Use Driver Settings for Print Job**.
   d. To dedicate the Bypass Tray for a paper size and type, clear **Display Tray Prompt** and **User Driver Settings for Print Job**.
      - To select a paper or envelope size, touch **Size**, touch the **Up** or **Down** arrows to navigate, touch a size, then touch **Size** again.
      - To select a paper type, touch **Type**, touch the **Up** or **Down** arrows to navigate, touch a paper type, then touch **Type** again.
   e. Touch **OK**.
4. To configure a paper tray:
   a. Touch **Tray 1** or **Tray 2**.
   b. To have the printer prompt you to set the paper type and size when paper is loaded, select **Display Tray Prompt**.
      - To select a paper or envelope size, touch **Size**, touch the **Up** or **Down** arrows to navigate, touch a size, then touch **Size** again.
      - To select a paper type from the list, touch **Type**, touch the **Up** or **Down** arrows to navigate, touch a type, then touch **Type** again.
   c. Touch **OK**.
5. Touch the **Back** arrow to return to the previous menu, or press the **Services Home** button to return to Service Home.
Configuring AirPrint

Use AirPrint to print directly from a wired or wireless device without using a print driver. AirPrint is a software feature that allows for driverless printing from Apple iOS-based mobile devices and Mac OS-based devices. AirPrint-enabled printers let you print directly from a Mac or from an iPhone, iPad, or iPod touch.

Notes:

- Not all applications support AirPrint.
- Wireless devices must join the same wireless network as the printer.
- For AirPrint to function, both IPP and Bonjour (mDNS) protocols must be enabled.
- The device that submits the AirPrint job must be on the same subnet as the printer. To allow devices to print from different subnets, configure your network to pass multicast DNS traffic across subnets.
- The Mac OS device must be Mac OS 10.7 or later.
- AirPrint-enabled printers work with iPad (all models), iPhone (3GS or later), and iPod touch (3rd generation or later), running the latest version of iOS.

1. At your computer, open a Web browser, in the address field, type the IP address of the printer, then press Enter or Return.
   
   Note: If you do not know the IP address of your printer, see Finding the IP Address of Your Printer on page 30.

2. Click Properties.

3. If the Protocols link is not expanded under Properties, scroll to the Protocols link and expand it.


5. To enable AirPrint, next to Enable AirPrint, click Turn On AirPrint.

   Note: AirPrint is enabled by default when IPP and Bonjour (mDNS) are both enabled. When AirPrint is enabled, Turn On AirPrint is not selectable. To disable AirPrint, disable either IPP or Bonjour (mDNS) protocols.
   - To change the printer name, in the Name field, enter a new name.
   - To enter a location for the printer, in the Location field, enter the location of the printer.
   - To enter a physical location or address for the printer, in the Geo-Location field, enter the geographic latitude and longitude coordinates in decimal form. For example, use coordinates like 45.325026, -122.766831 for a location.

6. Click Save Changes.

7. At the prompt, click Restart, or click Back to cancel.
   
   If you click Restart, the printer takes several minutes to restart and apply the new settings.
Configuring Fax Defaults and Settings

This section includes:
- Setting Fax Defaults from CentreWare Internet Services ................................................................. 70
- Configuring Fax Settings from CentreWare Internet Services ............................................................... 71
- Setting Fax Defaults from the Control Panel .......................................................................................... 72
- Configuring Fax Settings at the Control Panel (Bridgetown) ............................................................... 72

It is unlawful to send a message from a fax machine without the proper Fax Send Header information. The following information must appear on the first transmitted page, or in the top or bottom margin of each transmitted page:
- Identity of the business or individual sending the fax
- Telephone number of the sending machine
- Date and time of the transmission

Proper configuration of the fax requires setting up the Fax Defaults and Configuring the Fax Settings. You can configure the defaults and settings from the printer control panel or from CentreWare Internet Services.

Setting Fax Defaults from CentreWare Internet Services

1. At your computer, open a Web browser, in the address field, type the IP address of the printer, then press Enter or Return.

    Note: If you do not know the IP address of your printer, see Finding the IP Address of Your Printer on page 30.

2. In CentreWare Internet Services, click Properties.
3. In the Properties pane, under Fax, click Fax Defaults.
4. Next to Resolution, select the resolution for the fax transmissions.
5. Next to 2-Sided Scanning, select 1-Sided or 2-Sided.
6. Next to Rotate Side 2, to have side two of the transmitted fax pages rotated to flip on the long edge, select On.
7. Next to Lighten/Darken, to lighten or darken the transmitted copy, select an option.
8. Next to Delayed Send, enter the time at which you want to transmit the faxes.
9. Click Save Changes.
Configuring Fax Settings from CentreWare Internet Services

If your printer is connected to your computer through a wired or wireless network connection, use CentreWare Internet Services to configure the fax settings.

To configure fax settings using CentreWare Internet Services:
1. At your computer, open a Web browser, in the address field, type the IP address of the printer, then press Enter or Return.
   Note: If you do not know the IP address of your printer, see Finding the IP Address of Your Printer on page 30.
2. In CentreWare Internet Services, click Properties > Fax > Fax Settings.
   Note: For details, see the Help in CentreWare Internet Services.
3. In the Fax Line Settings, enter the Fax Number and Company Name, then select the other fax line settings from each of the lists.
4. For Incoming Defaults, configure settings as needed.
5. In the Forward Settings section, for Forward Settings, select an option.
   – To disable fax forwarding, select Off.
   – To direct all incoming faxes to the forwarding number, select Forward.
   – To print incoming faxes and forward them to the forwarding number, select Print and Forward.
   – To forward faxes to an email address, select Forward to Email.
   – To print incoming faxes and forward them to an email address, select Print and Email.
   Note: For the Forward to Email and Print and Email functions to operate, configure the Email Settings with a valid SMTP server.
   – To forward incoming faxes to a server, select Forward to Server.
   – To print incoming faxes and forward them to a server, select Print and Forward to Server.
6. To enter a forwarding fax number, under Forward to Fax, enter a number in the Forwarding number field.
7. To enter server information, for Forward to Server, configure the settings as needed.
8. For Transmission Defaults, select the modes for Prefix Dial and Fax Cover Page, then enter the Prefix Dial Number and redial information.
9. In the Fax Reports section, from each list, select the condition when the printer prints a fax report.
10. Click Save Changes.
Setting Fax Defaults from the Control Panel

Note: If your printer is connected to your computer through a wired or wireless network connection, use CentreWare Internet Services to configure the fax settings.

1. At the printer control panel, press the Machine Status button.
2. Touch Tools, then touch Service Defaults.
3. Touch Fax Defaults.
4. Touch Resolution, select the default resolution for fax transmissions, then touch OK.
5. Touch 2-Sided Scanning, select 1-Sided or 2-Sided, then touch OK.
6. Touch Lighten/Darken, use the scale to make the fax lighter or darker, then touch OK.
7. To select a delayed transmission time, touch Delayed Send.
   a. Touch the hour field, then use the keypad to enter the hour.
   b. Touch the minute field, then use the keypad to enter the minutes.
   c. Touch AM or PM.
   d. To save the setting, touch OK.
8. To return to the Services Home menu, press the Services Home button.

Configuring Fax Settings at the Control Panel (Bridgetown)

Note: If your printer is connected to your computer through a wired or wireless network connection, use CentreWare Internet Services to configure the fax settings.

There are four areas to configure in Fax Settings:
- Fax Line Settings
- Incoming Defaults
- Transmission Defaults
- Fax Reports

For proper fax operation, before you use the fax, configure all of the settings. You can change the settings using the control panel or CentreWare Internet Services.
Configuring Fax Line Settings from the Control Panel

1. At the printer control panel, press the Machine Status button.
2. Touch Tools > Admin Settings.
3. Touch Fax Settings.
4. Touch Fax Line Settings.
5. Touch Fax Number, enter the fax line number, then touch OK.
6. Touch Country, use the arrow keys to scroll through the lists, select your country, then touch OK.
7. At the Restart is Required message, to save the settings and restart the printer, click Yes, Save.
   
   **Note:** If this time is the first for fax setup, restart the printer to have the remaining menu selections appear.

8. At the printer control panel, press the Machine Status button.
10. Touch Company Name, enter the company name on the touch pad, then touch OK.
11. Touch Line Type, select PSTN or PBX, then touch OK. At the Restart System prompt, touch Close.
12. To select the next screen, touch the Up and Down arrows on the display.
13. Touch Line Monitor, touch to select the level, then touch OK. At the Restart System prompt, touch Close.
14. Touch DRPD Patterns, touch to select a pattern, then touch OK. At the Restart System prompt, touch Close.
15. Touch Extel Hook Threshold, touch to select the level, then touch OK. At the Restart System prompt, touch Close.
16. Touch the Back arrow to return to the Fax Settings menu or press the Services Home button to return to Service Home.

Configuring Fax Incoming Defaults from the Control Panel

1. At the printer control panel, press the Machine Status button.
2. Touch Tools > Admin Settings.
3. Touch Fax Settings.
4. Touch Incoming Defaults.
5. Use the Up and Down arrows to navigate between the lists.
6. Touch Receive Mode, touch the mode to select it, then touch OK.
7. Touch Ring Tone Volume, select the volume, then touch OK. At the Restart System prompt, touch Close.
8. Touch Auto Answer Setup.
   a. Select the appropriate setup for your fax set:
      - Auto Answer for a fax line that is hooked up without a telephone or answering machine.
      - Auto Answer TEL/FAX for a fax line that is hooked up with a telephone.
      - Auto Answer ANS/FAX for a fax line that is hooked up with an answering machine.
   b. Next to your selection, use the keypad to enter the delay before the printer answers.
   c. To return to incoming defaults, touch the Back arrow.
9. To reject faxes sent from unwanted sources:
   a. Touch Junk Filter, then touch On or Off.
   b. Touch OK.
   c. At the Restart System prompt, touch Close.
   d. To return to incoming defaults, touch the Back arrow.

10. To configure Secure Receive:
   
   Note: To use Secure Receive, set up Panel Lock first.
   a. Touch Secure Receive.
   b. Touch Secure Receive Set, select Enable, then enter a four-digit PIN.
   c. Touch the Back arrow to return to Incoming Defaults.

11. To configure how faxes are forwarded:
   a. Touch Forward Settings.
   b. To forward the fax without printing, touch Forward, enter the forwarding number, then touch OK.
   c. To print the fax then forward it to another number, touch Print and Forward, enter the forwarding number, then touch OK.
   d. At the Restart System prompt, touch Close.

12. To have faxes printed on both sides of the sheets:
   a. Touch 2-Sided Printing, select On, then touch OK.
   b. At the Restart System prompt, touch Close.

13. To receive a fax while using the external telephone after hearing a fax tone:
   a. Touch Remote Receive, then touch On.
   b. Enter a two-digit tone code, then touch OK.
   c. At the Restart System prompt, touch Close.

14. To instruct the printer what to do when it receives a document longer than the paper loaded in your printer:
   a. Touch Discard Size.
   b. To have the printer print oversized faxes on two sheets of paper, select Off.
   c. To have the printer reduce the size of the incoming fax so that it fits the selected paper, select Auto Reduction.
   d. To have the printer discard the data or image that falls outside the margins of the selected paper, select On.
   e. Touch OK.
   f. At the Restart System prompt, touch Close.
   g. Touch the Back arrow to return to the previous menu, or press the Services Home button to return to Service Home.
Configuring Fax Transmission Defaults from the Control Panel

1. At the printer control panel, press the Machine Status button.
2. Touch Tools>Admin Settings.
3. Touch Fax Settings.
4. Touch Transmission Defaults.
5. To configure the printer to auto redial a busy number or a line that does not answer:
   a. Touch Auto Redial Setup.
   b. To change the number of redial attempts, touch Number of Redial, enter a number from 0–9, then touch OK.
   c. Touch OK.
   d. At the Restart System prompt, touch Close.
6. To change the interval between the redial attempts:
   a. Touch Redial Interval, then enter a number from 1–15 for the delay in minutes.
   b. Touch OK.
   c. At the Restart System prompt, touch Close.
7. To change the interval between resend attempts:
   a. Touch Interval Timer, then enter a number from 3–255 for the delay in seconds.
   b. Touch OK.
   c. At the Restart System prompt, touch Close.
   d. Touch the Back arrow to return to Transmission Defaults.
8. To select the dialing type for your outgoing faxes:
   a. Touch Dial Type.
   b. Select an option:
      • PB uses push-button tone dialing.
      • DP (10 PPS) sets 10 pulse per second dialing pulses as the dial type.
      • DP (20 PPS) sets 20 pulse per second dialing pulses as the dial type.
   c. Touch OK.
   d. At the Restart System prompt, touch Close.
9. To enter a prefix dial number:
   a. Touch Prefix Dial, then select On.
   b. Enter the prefix number, then touch OK.
   c. At the Restart System prompt, touch Close.
10. To have the printer generate a cover page for each fax transmission, touch **Fax Cover Page**, touch **On**, then touch **OK**.
11. To enable or disable the Error Correction Mode:
   a. Touch **ECM**, then touch **On** or **Off**.
   b. Touch **OK**.
   c. At the Restart System prompt, touch **Close**.
12. To select the modem speed, touch **Modem Speed**, select the transmission speed, then touch **OK**.
13. When sending a manual fax, to have the number of the recipient appear on the Sending Fax screen:
   a. Touch **Display Manual Fax Recipients**, then touch **On**.
   b. Touch **OK**.
14. Touch the **Back** arrow to return to the previous menu, or press the **Services Home** button to return to Service Home.

**Configuring Fax Reports from the Control Panel**

1. At the printer control panel, press the **Machine Status** button.
2. Touch **Tools** > **Admin Settings**.
3. Touch **Fax Settings**.
4. Touch **Fax Reports**.
5. To print a fax activity report after every 50 fax communications, touch **Fax Activity**, touch **Auto Print**, then touch **OK**.
6. To print a report of the transmission results after sending a fax, touch **Fax Transmit**, select an option, then touch **OK**.
7. To print a report of the transmission results after sending a fax to multiple destinations, touch **Fax Broadcast**, select an option, then touch **OK**.
8. To print a fax protocol report to help troubleshoot fax problems, touch **Fax Protocol**, select an option, then touch **OK**.
9. Touch the **Back** arrow to return to the previous menu, or press the **Services Home** button to return to Service Home.
Setting Up Scanning

This section includes:

- Scanning Setup Overview ................................................................. 77
- Setting Up Scanning to a Shared Folder on Your Computer .......... 78
- Setting Up Scanning to an FTP Server ............................................ 80
- Setting Up Scanning to an Email Address ...................................... 81
- Setting Up Scanning With USB ....................................................... 82

See also:

Scanning on page 167

Scanning Setup Overview

If the printer is connected to a network, it is enabled for scanning. Before you can scan, you must do the following:

- If you are scanning to a shared folder on your computer, share the folder, set the correct permissions, and add the folder as an Address Book entry in CentreWare Internet Services.
- If you are scanning to an FTP server, add the FTP server and set the correct folder permissions as an Address Book entry in CentreWare Internet Services.
- If you are scanning to an email address, configure the email server in CentreWare Internet Services.

If the printer is connected using a USB cable, you cannot scan to an email address or a network location. You can scan to a folder on your computer, or scan into an application after installing the scan drivers and the Express Scan Manager utility.

For details, see Installing the Software on page 109.
Setting Up Scanning to a Shared Folder on Your Computer

This section includes:

- Sharing a Folder on a Windows Computer ................................................................. 78
- Sharing a Folder Using Macintosh OS X Version 10.5 and Later .................................... 79
- Adding a Folder as an Address Book Entry Using CentreWare Internet Services .................. 79
- Adding a Folder as an Address Book Entry Using the Address Book Editor ......................... 80

Before you can scan to a shared folder, you must share the folder, then add the folder as an Address
Book entry in CentreWare Internet Services.

For details, see CentreWare Internet Services on page 30.

Sharing a Folder on a Windows Computer

1. Open Windows Explorer.
2. Right-click the folder you want to share, then select Properties.
3. Click the Sharing tab, then click Advanced Sharing.
4. Select Share this folder.
5. Click Permissions.
6. Select the Everyone group, and verify that all permissions are enabled.
7. Click OK.

Note: Remember the Share name for later use.

8. Click OK again.
9. Click Close.
Sharing a Folder Using Macintosh OS X Version 10.5 and Later

1. From the Apple menu, select System Preferences.
2. From the View menu, select Sharing.
3. From the Services list, select File Sharing.
4. Click the plus icon (+) below the Shared Folders field. A folder list appears.
5. Select the folder you want to share on the network, then click Add.
6. From the Users list, click Everyone.
7. From the list to the right of the Users window, use the arrow buttons to set user privileges to Read & Write.
8. Click the Options button.
9. To share this folder with Windows computers, select Share files and folders using SMB.
10. Select the On check box to the left of File Sharing in the Service pane.
    The folder and its contents are shared with network users.
11. Close the System Preferences window.
    Note: When you open a shared folder, a Shared Folder banner appears in the Finder for the folder and its subfolders.

Adding a Folder as an Address Book Entry Using CentreWare Internet Services

1. At your computer, open a Web browser, in the address field, type the IP address of the printer, then press Enter or Return.
    Note: If you do not know the IP address of your printer, see Finding the IP Address of Your Printer on page 30.
2. Click Address Book.
3. Under Network Scan (Comp./Serv.), click Computer/Server Address Book.
4. Next to any empty field, click Add, then enter the following information:
   - **Name**: Enter the name that you want to appear in the Address Book.
   - **Server Type**: Select Computer (SMB).
   - **Host Address**: Enter the IP address of your computer.
   - **Port Number**: Enter the default port number for SMB, 139, or select a number from the range provided.
   - **Login Name**: Enter your computer user name.
   - **Login Password**: Enter your computer login password.
   - **Re-enter Password**: Enter your login password again.
   - **Name of Shared Directory**: Enter a name for the directory or folder. For example, if you want the scanned files to go in a folder named scans, type scans.
   - **Subdirectory Path**: Enter the path of the folder on the SMB server. For example, if you want the scanned files to go in a folder named colorscans inside the scans folder, type \colorscans.
5. Click Save Changes.
Adding a Folder as an Address Book Entry Using the Address Book Editor

1. On your computer, select Start > All Programs > Xerox Office Printing > WorkCentre 6605.
2. In the left navigation pane, under Printer Address Book, click Server.
3. For Name, enter the name of the shared file on your computer.
4. For Server Type, select Computer (SMB).
5. Click Computer Settings Wizard, then click Browse.
6. Navigate to a shared folder on your computer.
7. Click OK, then click Next.
8. To give the printer access to the shared folder, enter a login name and password.
9. Click Next, then click Finish.
10. Click OK.
    The new entry appears in the Server pane.
11. Click Save All.

Setting Up Scanning to an FTP Server

Before you set up scanning to an FTP Server, the server must have the proper software installed and be configured with shared folders for each user.

1. At your computer, open a Web browser, in the address field, type the IP address of the printer, then press Enter or Return.
   Note: If you do not know the IP address of your printer, see Finding the IP Address of Your Printer on page 30.
2. In CentreWare Internet Services, click Address Book.
3. Under Network Scan (Comp./Serv.), click Computer/Server Address Book.
4. Click Add next to any blank field, then enter the following information:
   − Name: Enter the name that you want to appear in the Address Book.
   − Network Type: Select Server (FTP).
   − Host Address: Enter the IP address or DNS name of the FTP server.
   − Port Number: Enter the default port number for FTP, 21, or select a number from the range provided.
   − Login Name: Enter a valid login name for your FTP server.
   − Password: Enter a valid password for your FTP server.
   − Re-enter Password: Enter the password again.
   − Name of Shared Directory: Enter a name for the directory or folder. For example, if you want the scanned files to go in a folder named scans, type scans.
   − Subdirectory Path: Enter the path of the folder on the FTP server. For example, if you want the scanned files to go in a folder named colors scans inside the scans folder, type /colors scans.
5. Click Save Changes. A new address book entry is created.

Now you can scan to the FTP server.
Setting Up Scanning to an Email Address

Before you can scan to an email address, you must configure the printer to communicate with your SMTP email server.

To configure the SMTP server settings:

1. At your computer, open a Web browser, in the address field, type the IP address of the printer, then press Enter or Return.
   
   Note: If you do not know the IP address of your printer, see Finding the IP Address of Your Printer on page 30.

2. Click Properties.

3. In the left pane, under Protocols, click Email Settings.

4. Type the following information:
   
   − Next to Enter the “From” Email Address, type an appropriately formatted email address to appear in the From field of emails from the printer.
   
   − For SMTP Server (IP Address or DNS Name), type the IP address or DNS name of the SMTP server.
     
     If you do not know the IP Address or DNS Name of the SMTP server, click Auto Detect SMTP Server.
   
   − For SMTP Port, type the default port number of 25 for SMTP, or select a number from the range provided.

5. Select an Authentication Type.
   
   Note: Ensure that the authentication type is compatible with your SMTP server.

6. If authentication is required, enter a valid SMTP Login Name for the SMTP Server.

7. If authentication is required, enter a valid password for the SMTP server.

8. Re-enter the password.

9. Scroll down, then click Save Changes.
   
   Note: Contact your Internet service provider or system administrator to obtain your SMTP server name or IP address. Some Internet service providers require authentication. Ensure that you confirm the authentication type, login, and password.

Now you can scan to an email address. For details, see Setting Up Scanning to an Email Address on page 81.
Setting Up Scanning With USB

If the printer is connected using a USB cable, you cannot scan to an email address or a network location. You can scan to a folder on your computer, or scan into an application after installing the scan drivers and the Express Scan Manager utility. For details, see Installing the Software on page 109.

Setting Up Scanning to a Folder on Your Computer With USB

1. Start Express Scan Manager:
   - Windows: Click Start>Programs>Xerox. Select your printer from the list. Double-click Express Scan Manager.
   - Macintosh: Navigate to Applications>Xerox. Select your printer from the list. Double-click Express Scan Manager.
2. Click OK to accept the default Destination Path folder, or click Browse to navigate to another folder.
3. Press OK.

Now you can scan to a folder on your computer. For details, see Scanning to a Folder on USB Connected Computer on page 171.
Configuring Security Settings Using CentreWare Internet Services

This section includes:
- Opening the Security Menu ................................................................. 83
- Configuring Administrative Security Settings ...................................... 84
- Configuring Secure Settings .................................................................. 84
- Network Authentication ........................................................................ 86
- LDAP Server ......................................................................................... 87
- Configuring an LDAP Authentication System ...................................... 87
- LDAP User Mapping ............................................................................... 88
- Configuring a Kerberos Authentication System ..................................... 89
- Configuring Xerox Secure Access Settings ......................................... 90
- Configuring LDAP Authentication ....................................................... 90
- Configuring the Host Access List ........................................................... 91
- Configuring IPsec Settings .................................................................... 92
- Configuring 802.1x Settings ................................................................ 93
- Configuring SSL Settings ..................................................................... 93
- Configuring SMTP Domain Filtering .................................................... 93

Use security settings to configure administrative settings, authentication, user access and privileges, and service access.

Note: For details, see the Help in CentreWare Internet Services.

Opening the Security Menu

1. At your computer, open a Web browser, in the address field, type the IP address of the printer, then press Enter or Return.
2. In CentreWare Internet Services, click Properties.
3. In the Properties pane, to expand the menu, click the plus (+) symbol next to the Security folder.
Configuring Administrative Security Settings

1. At your computer, open a Web browser, in the address field, type the IP address of the printer, then press Enter or Return.
2. In CentreWare Internet Services, click Properties.
3. In the Properties pane, to expand the menu, click the plus (+) symbol next to the Security folder.
4. Click Administrator Security Settings.
5. To turn on administrator privileges, select Enable Administrator Mode.
6. Enter the user name and password, then re-enter the password.
7. Next to Access denial by the authentication failure of the Administrator, enter the number of login attempts allowed before locking out the user.
8. Click Save Changes.

Configuring Secure Settings

1. At your computer, open a Web browser, in the address field, type the IP address of the printer, then press Enter or Return.
2. In CentreWare Internet Services, click Properties.
3. In the Properties pane, to expand the menu, click the plus (+) symbol next to the Security folder.
4. Click Secure Settings.
5. Configure security features as needed.

To enable network authentication:
1. For Network Authentication, select On.
2. Click Save Changes.

To limit access to the control panel menus:
1. For Panel Lock Set, select Enable.
2. Type, then retype a passcode.
3. To view service lock setting options, click Save Changes.

To set access rights for non-authorized users:
1. For a service name, from the lists, select an access level.
2. To allow users to make copies, for Copy, select Enabled.
3. To allow users to scan and email documents, for Email, select Enabled.
4. To allow users to fax documents, for Fax, select Enabled.
5. To allow faxes to send from the fax driver, for Send via Fax Driver, select Enable.
6. To allow users to scan documents and send them to a network server, for Scan to Network, select Enabled.
7. To allow users to scan documents and send them to a computer, for Scan to PC, select Enabled.
8. To allow users to scan documents using TWAIN or WIA, for PC Scan, select Enabled.
9. To allow users to scan to a USB drive, for Scan to USB, select Enabled.
10. To allow users to print documents from a USB drive, for Print from USB, select Enabled.
11. To enable the printer to copy ID cards front and back, for ID Card Copy, select **Enable**.
12. To set the USB menu to pop up when a USB Flash drive is inserted, for USB Services - Show USB Pop Up Menu, select **Enable**.
13. To select when the USB Memory appears, for USB Services - Display USB Memory Services, select an option.
14. Type, then retype a passcode.
15. Click **Save Changes**.

To prevent unauthorized users from viewing incoming faxes:
1. For Secure Receive Set, select **Enable**.
2. Type, then retype a passcode.
3. Click **Save Changes**.

To allow users to edit the From field in emails sent from the printer:
1. To allow users to edit the From field in emails sent from the printer, for Edit Email From Field, select **Enable**.
2. Click **Save Changes**.

To limit users to selecting recipients from the phonebook or address book only:
1. To allow users to edit the From field in emails sent from the printer, for Edit Email From Field, select **Enable**.
2. Click **Save Changes**.

To allow download of firmware updates:
1. To allow download of firmware updates, for Software Downloads, select **Enable**.
2. Click **Save Changes**.

To set the IP address or host name to appear on the control panel screen:
1. To set the IP address or host name to appear on the control panel screen, for Display Network Information, select an option.
2. Click **Save Changes**.

To encrypt the data on the hard drive:
1. To set hard drive data encryption, click **HDD Data Encryption**.
2. For Encryption, select **On**.
3. Enter an Encryption Key for the printer, then reenter the key.
   
   **Note:** All stored data is deleted after you change the Data Encryption Settings.

Click **Save Changes**.
1. For Encryption, select **On**.
2. Enter an Encryption Key for the printer, then reenter the key.
   
   **Note:** All stored data is deleted after you change the Data Encryption Settings.
3. Click **Save Changes**.
To erase the hard drive data by overwriting it with random data:
1. For HDD Overwrite, select the number of overwrites that the printer is to perform.
2. Click Save Changes.

To limit the number of attempts allowed when a user logs in as an administrator:
1. To limit the number of attempts allowed when logging in as an administrator, for Login Attempts, select an option.
2. Click Save Changes.

Network Authentication

Network Authentication is a security protocol that requires users to provide their login credentials before they can access the printer. The printer compares the user credentials to the information stored on an authentication server. To prove their identity, users can type their user credentials at the control panel, in CentreWare Internet Services, or they can use a card reader.

To configure access rights using network authentication:
• Provide information about your authentication server and configure authentication server settings.
• Enable Panel Lock. For details, see Managing Panel Lock on page 95.
• Ensure that service locks are set. For details, see Setting Service Locks on page 96.
• Ensure that Network Authentication is enabled. For details, see Configuring Secure Settings.

To access the authentication system:
1. In CentreWare Internet Services, click Properties>Security.
2. Click Authentication System.

See also:
• Configuring a Kerberos Authentication System on page 89
• Configuring Xerox Secure Access Settings on page 90
• Configuring LDAP Authentication on page 90
LDAP Server

Lightweight Directory Access Protocol (LDAP) is a protocol used to process queries and updates to an LDAP information directory, on an external server. LDAP can also be used for network authentication and authorization. LDAP directories are heavily optimized for read performance. Use this page to define how the printer retrieves user information from an LDAP directory.

1. At your computer, open a Web browser, in the address field, type the IP address of the printer, then press Enter or Return.
   
   Note: If you do not know the IP address of your printer, see Finding the IP Address of Your Printer on page 30.

2. Click Properties>Protocols>LDAP Server.

3. Type the LDAP IP address or host name and port number.

   Notes:
   - The settings for the LDAP-SSL/TLS appear only if the optional Device Memory Data is installed and Device Memory Data encryption is enabled under Secure Settings.
   - Before you click the SSL link, save any changes on the LDAP Server page.

4. To enable LDAP-SSL/TLS, click SSL.

5. Configure the optional LDAP server information as needed.
   a. Type the root path of the search directory in the Search Directory Root field using Base DN format. For example, DC=xerox, DC=net.
   b. If you select System, type the Login Name and Password used to access the server. None instructs the printer to access the server without providing credentials.
   c. For Search Timeout, specify the type of timeout to use for the server. You can set the LDAP server to limit the time or you can set the time limit manually in the seconds field.
   d. For Search Name Order, specify the method to search names.
   e. To enable the Network Address Book for the Scan to Email service, for Server Email Address Book, select On.
   f. To enable the Network Address Book for the fax service, for Server Fax Address Book, select On.

6. Click Save Changes.

Configuring an LDAP Authentication System

Before using LDAP servers for authentication, configure the settings in CentreWare Internet Services. To use an LDAP server, see Properties>Protocols in CentreWare Internet Services.

Note: The Authentication System is an extra authentication option that is used only when searching the Network Address Book from the printer control panel. First, the printer authenticates using the Authentication System specified. If successful, the printer proceeds to search the network address book.
Configuring the Authentication System

1. At your computer, open a Web browser, in the address field, type the IP address of the printer, then press Enter or Return.
2. In CentreWare Internet Services, click Properties.
3. In the Properties pane, to expand the menu, click the plus (+) symbol next to the Security folder.
4. Click Authentication System.
5. For Authentication Type (for User Authentication), select an authentication system settings option.
6. To configure the Kerberos Server, click Kerberos Server.
7. To configure the LDAP Directory settings, click LDAP Server.
9. For Authentication Type (for Server Address/Phone Book), select an authentication type option.
10. To configure the Kerberos Server, click Kerberos Server.
11. To configure the LDAP Directory settings, click LDAP Server.
12. Under Option Information, for the Server Response Timeout and Search Timeout, enter the timeout in seconds.
13. Click Save Changes.

LDAP User Mapping

LDAP servers display different results depending on how they implement mappings. Use this page to map LDAP fields to fields on your printer. Editing current map settings allows you to fine-tune server search results.

Before you begin:
- Ensure that you have configured the LDAP server settings. For details, see LDAP on page 87.
- Ensure that you have set LDAP for authentication. For details, see Configuring LDAP Authentication on page 90.
- Ensure that LDAP is enabled. For details, see Network Authentication on page 86.
- Ensure that Network Authentication is enabled. For details, see Configuring Secure Settings.

To define LDAP user mappings:
1. At your computer, open a Web browser, in the address field, type the IP address of the printer, then press Enter or Return.
2. Click Properties>Protocols>LDAP User Mappings.
3. In the User Mapping fields, type the information. For example, the Surname and Given Name fields allow you to search for the last and first name of the user.
4. If Network Authentication is enabled, the Home field appears. The Home field indicates the location the personal directory of the user. The system administrator defines the default for homeDirectory when the user account is created.
5. Click Save Changes.
Configuring a Kerberos Authentication System

Before using Kerberos servers for authentication, configure the settings in CentreWare Internet Services. To use a Kerberos server, see Properties > Security > Kerberos Server.

Note: The Kerberos Server is an extra authentication option that is only used by the Authentication System when searching the Network Address Book from the printer control panel. First, the printer authenticates using the Authentication System specified. If successful, the printer proceeds to search the network address book.

Note: For Kerberos authentication to be successful, configure the printer with the current time and date. See Setting the Date and Time on page 64. To use a Network Time Server, see Properties > Protocols > SNTP in CentreWare Internet Services.

Configuring Kerberos Server Settings

1. At your computer, open a Web browser, in the address field, type the IP address of the printer, then press Enter or Return.
2. In CentreWare Internet Services, click Properties.
3. In the Properties pane, to expand the menu, click the plus (+) symbol next to the Security folder.
4. Click Kerberos Server.
5. Next to IP Address/Host Name and Port, enter the IP address or the network host name for the Kerberos server, then enter the port number.
6. Next to Domain Name, enter the domain name of your authentication server.
7. Next to Login Name, enter the user name for logging in to the server.
8. Next to Password, enter and re-enter the password for the server.
9. Click Save Changes.
Configuring Xerox Secure Access Settings

When Xerox Secure Access is enabled, users swipe a pre-programmed identification card through a proximity card reader at the control panel. To use this method, purchase and install a USB card reader and an authentication server that supports the Convenience Authentication API.

For recommended authentication servers and supported USB card readers, see www.xerox.com/office/WC6605support.

To configure Xerox Secure Access Settings:
1. At your computer, open a Web browser, in the address field, type the IP address of the printer, then press Enter or Return.
2. In CentreWare Internet Services, click Properties>Security.
3. Click Xerox Secure Access Settings.

   Note: When you register the printer, most authentication servers automatically configure the Xerox Secure Access Server setting. If prompted to set these fields manually, you can set the IP Address/Host Name and Path fields as specified in your authentication server documentation.

4. For IP Address/Host Name and Port, type the appropriately formatted address and port number.
5. For Path, type the HTTP path that your authentication server provides.
6. Enter additional information as needed.
   - Connection Time-Out: This option sets the length of time the printer waits for a response from the server before it cancels the operation.
   - Alternate Login: When an authentication server enables the feature, this setting provides an option for the user to enter login credentials using a keyboard.
   - Default Title and Default Prompt: These fields set the instructional text that appears when the user attempts to enter a locked service.
7. For USB Card Reader, choose a detection policy.
8. Click Save Changes.

Configuring LDAP Authentication

1. At your computer, open a Web browser, in the address field, type the IP address of the printer, then press Enter or Return.
2. In CentreWare Internet Services, click Properties.
3. In the Properties pane, to expand the menu, click the plus (+) symbol next to the Security folder.
4. Click LDAP Authentication.
5. To use a text string to add to the user name, next to Use Added Text String, select Enable.
6. Next to Text String Added to User Name, enter the text string to add to the user name for authentication.
7. Click Save Changes.
Configuring the Host Access List

The host access list controls access to the printer over LPR or Port 9100. You can enter up to 20 IPv4 or IPv6 address/mask combinations. You can also select to accept, reject, or turn off the filtering for each IP address. You can enter a specific IP address and address mask, or you can enter a range of IP addresses and address masks. If you leave IP address and Address Mask blank, anyone can access the printer.

You can choose to allow printing from one specific IP address only. The following table shows an example.

<table>
<thead>
<tr>
<th>Access List</th>
<th>IP Address</th>
<th>Address Mask</th>
<th>Operation</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>192.168.200.10</td>
<td>255.255.255.255</td>
<td>Accept</td>
</tr>
</tbody>
</table>

You can reject one specific IP address but allow printing from any other address. The following table shows an example.

<table>
<thead>
<tr>
<th>Access List</th>
<th>IP Address</th>
<th>Address Mask</th>
<th>Operation</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>192.168.200.10</td>
<td>255.255.255.255</td>
<td>Reject</td>
</tr>
<tr>
<td>2</td>
<td>0.0.0.0</td>
<td>0.0.0.0</td>
<td>Accept</td>
</tr>
</tbody>
</table>

The first row of the access list is the highest priority. When configuring a list with multiple rows, enter the smallest range first. Make the first row the most specific and the last row the most general.

For example, you can set up the host access list to do the following:
- Accept printing from a specific network.
- Reject printing from a particular network mask within that network.
- Accept printing from one particular IP address within that network mask.

The following table shows an example.

<table>
<thead>
<tr>
<th>Access List</th>
<th>IP Address</th>
<th>Address Mask</th>
<th>Operation</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>192.168.200.10</td>
<td>255.255.255.255</td>
<td>Accept</td>
</tr>
<tr>
<td>2</td>
<td>192.168.200.0</td>
<td>255.255.255.0</td>
<td>Reject</td>
</tr>
<tr>
<td>3</td>
<td>192.168.0.0</td>
<td>255.255.0.0</td>
<td>Accept</td>
</tr>
</tbody>
</table>

To configure the Host Access List:
1. At your computer, open a Web browser, in the address field, type the IP address of the printer, then press Enter or Return.
2. In CentreWare Internet Services, click Properties.
3. In the Properties pane, to expand the menu, click the plus (+) symbol next to the Security folder.
4. Click Host Access List.
5. In the IP Address field, enter the IP address of the host as X.X. X.X, where X is a number from 0 through 255. For example, 192.168.200.10.
6. In the Address Mask field, enter the network mask for the host as X.X.X.X, where X is a number from 0 through 255. For example, 255.255.255.255.

7. Under Operation, for the action the host takes with the IP address:
   – Off indicates that this row of the access list is inactive. This setting lets you enter a specific IP address or range of addresses before you plan to enforce the Accept or Reject operation.
   – Accept allows the specified IP address or range of addresses access to the printer.
   – Reject denies the specified IP address or range of addresses access to the printer.

8. Click Save Changes.

Configuring IPsec Settings

IPsec is a protocol suite that uses authentication or encryption of each IP packet in a datastream to secure Internet Protocol (IP) communications. IPsec also includes protocols for cryptographic key establishment and can be implemented as part of the overall security policy for your company.

To configure IPsec:
1. At your computer, open a Web browser, in the address field, type the IP address of the printer, then press Enter or Return.
2. In CentreWare Internet Services, click Properties.
3. In the Properties pane, to expand the menu, click the plus (+) symbol next to the Security folder.
4. Click IPsec.
5. To use the IPsec protocol, next to Protocol, select Enabled.
6. Next to Shared Key, enter the shared key value, up to 255 characters long.
7. Next to Verify Shared Key, re-enter the shared key value.
8. To specify the lifetime of the secure association, next to IKE SA Lifetime, enter a number. The range is 5–28800 minutes.
9. To set the maximum time that a secure association is linked without activity, next to IPsec SA Lifetime, enter a number. The range is 5–2880 minutes.
10. To set the level of cryptographic strength, next to DH Group, select G1 for low, and G2 for strong.
11. To turn on Perfect Forward Security, next to PFS, select Enabled.
12. In the Specify Destination IPv4 Address, enter the IP address and port number as X.X.X.X/P. X must be a number from 0 through 255.
13. In the Specify Destination IPv6 Address, enter the IP address and port exactly as it appears for the destination server.
14. To specify how the printer treats data from non-IPsec devices, next to Communicate with Non-IPsec device, select an option:
   – Bypass directs the printer to bypass the IPsec security protocol and use the data.
   – Discard directs the printer to discard the data without using it.
15. Click Save Changes.
Configuring 802.1x Settings
1. At your computer, open a Web browser, in the address field, type the IP address of the printer, then press Enter or Return.
2. In CentreWare Internet Services, click Properties.
3. In the Properties pane, to expand the menu, click the plus (+) symbol next to the Security folder.
4. Click 802.1X.
5. If the printer is connected to a RADIUS server, next to Enable IEEE 802.1X, select Enabled.
6. Next to Authentication Method, select the authentication method.
7. Next to Login Name, enter the login name for the printer.
8. Type a Password for the user, then retype it to verify.
9. To have the printer validate certificates, next to Certificate Validation, select Enabled.
10. Click Save Changes.

Configuring SSL Settings
1. At your computer, open a Web browser, in the address field, type the IP address of the printer, then press Enter or Return.
2. In CentreWare Internet Services, click Properties.
3. In the Properties pane, to expand the menu, click the plus (+) symbol next to the Security folder.
4. Click SSL.
5. For Enable SSL, select the Enable SSL check box.
6. For Encryption Strength, select an option.
7. For Port Number, type a valid port number.
8. For LDAP - SSL/TLS Communication, select Enabled.
9. For SMTP - SSL/TLS Communication, select an option.
11. To view certificate details, click Certificate Management.
12. Click Save Changes.

Configuring SMTP Domain Filtering
1. At your computer, open a Web browser, in the address field, type the IP address of the printer, then press Enter or Return.
2. In CentreWare Internet Services, click Properties.
3. In the Properties pane, to expand the menu, click the plus (+) symbol next to the Security folder.
4. Click SMTP Domain Filtering.
5. To enable domain filtering, next to Domain Filtering, select Allow Domains.
6. In the Allow Domain List area, under Destination Domain, enter the names of the domains to allow.
7. Click Save Changes.
Configuring Secure Settings Using the Control Panel

This section includes:

- Accessing the Secure Settings Menu ................................................................. 94
- Setting Panel Lock .................................................................................................. 94
- Managing Panel Lock ............................................................................................ 95
- Authentication Using a Card Reader System ....................................................... 95
- Setting Service Locks ............................................................................................. 96
- Configuring Secure Settings .................................................................................. 96
- Configuring the Data Encryption Settings ............................................................ 97
- Configuring the USB Setup Menu .......................................................................... 97

Use this menu for controlling access to printer features.

Accessing the Secure Settings Menu

1. At the printer control panel, press the Machine Status button.
2. Touch Tools>Admin Settings.
3. Use the Up or Down arrows to navigate, then touch Secure Settings.

Setting Panel Lock

1. At the Secure Settings screen, touch Panel Lock>Enable>OK.
2. At the prompt, enter a four-digit passcode, then touch OK.
3. At the prompt, re-enter the passcode.
4. Touch the Back arrow to return to the previous menu, or press the Services Home button to return to Service Home.
Managing Panel Lock

The Panel Lock password limits access to the Admin menu.

To set the Panel Lock password:
1. At the printer control panel, press the Machine Status button.
2. Touch Tools>Admin Settings.
3. Touch Secure Settings.
4. At the Secure Settings screen, touch Panel Lock>Enable>OK.
5. At the prompt, enter a four-digit passcode, then touch OK.
6. At the prompt, re-enter the passcode.
7. Touch the Back arrow to return to the previous menu, or press the Services Home button to return to Service Home.

To change the passcode:
1. At the printer control panel, press the Machine Status button.
2. Touch Tools>Admin Settings.
3. At the prompt, enter a four-digit passcode, then touch OK.
4. Use the Up or Down arrows to navigate, then touch Secure Settings.
5. Touch Panel Lock, then touch Change Passcode.
6. At the prompt, enter a four-digit passcode, then touch OK.
7. At the prompt, enter the new passcode, then touch OK.
8. At the prompt, re-enter the passcode, then touch OK.
9. Touch the Back arrow to return to the previous menu, or press the Services Home button to return to Service Home.

Authentication Using a Card Reader System

When Xerox® Secure Access authentication is configured, users swipe a pre-programmed identification card at the control panel. The printer compares the user credentials to the information stored on the Convenience Authentication server.

For details, refer to the documentation provided with your authentication software.
Setting Service Locks

A list of installed services appears in this menu and lets you configure the way they appear on the control panel for non-authorized users. Each service can be set from a selection of access levels.

- **Enabled** allows the non-authorized users access to the service.
- **Passcode Locked** allows authorized users access to the service after entering a passcode.
- **Color Passcode Locked** allows authorized users access to a color service, such as copying, after entering a passcode.
- **Disabled** blocks access to the service for non-authorized users.

*Note:* Panel Lock must be enabled before setting the service locks.

To set the service locks:
1. From the Secure Settings menu, use the **Up** or **Down** arrows to navigate to the menu with their service listed.
2. Touch a service name.
3. Touch an access option, then touch **OK**.

*Note:* After setting a service lock for fax access, at the Restart prompt, touch **Close**.

Configuring Secure Settings

1. To allow users to edit the From Field in emails sent from the printer, touch **Edit Email From Field** > **Enable** > **OK**.
2. To allow users to select recipients only from the phonebook or address book, touch **Confirm Recipients** > **Confirm Recipients** > **OK**.
3. To restrict emails to only selected domains, touch **Domain Filtering** > **Enable** > **OK**.
4. To enable downloading firmware upgrades, touch **Software Download** > **Enable** > **OK**.
5. To have the IP address or host name appear on the control panel screen, touch **Display Network Information**, touch an option, then touch **OK**.
6. To enable data encryption of the hard drive:
   a. Touch **HDD Data Encryption**, then touch **On**.
   b. When prompted, enter a passphrase, then touch **OK**.
   c. To delete stored documents on the drive and restart the printer, at the prompt, touch **Yes, Delete**.
7. To change the encryption key for HDD encryption, touch **Encryption Key**, enter the passphrase, then at the prompt, touch **Yes, Delete**.
8. To erase the hard drive by overwriting it with random data, touch **HDD Overwrite**, then select the number of times to overwrite the data.
9. To limit the number of attempts allowed when logging in as an administrator, touch **Login Attempts**, enter number of times from 1–10, then touch **OK**.
10. Touch the **Back** arrow to return to the previous menu, or press the **Services Home** button to return to Service Home.
Configuring the Data Encryption Settings

1. At the printer control panel, press the Machine Status button.
2. Touch Tools>Admin Settings.
3. Use the Up or Down arrows to navigate, then touch Secure Settings.
4. Touch HDD Data Encryption, then touch On.
5. When prompted, enter a passphrase, then touch OK.
6. To delete stored documents on the drive and restart the printer, at the prompt, touch Yes, Delete.
7. To change the encryption key for HDD encryption, touch Encryption Key, enter the passphrase, then at the prompt, touch Yes, Delete.
8. To erase the hard drive by overwriting it with random data, touch HDD Overwrite, then select the number of times to overwrite the data.
9. Touch the Back arrow to return to the previous menu, or press the Services Home button to return to Service Home.

Configuring the USB Setup Menu

1. At the printer control panel, press the Machine Status button.
2. Touch Tools>Admin Settings.
3. Touch USB Setup.
4. To have the USB port status appear on the display, touch Port Status>Enable>OK.
5. At the Restart System prompt, touch Close.
6. To select the Adobe protocol, touch Adobe Protocol, select an option from the list, then touch OK.
7. At the Restart System prompt, touch Close.
8. To restart the system, turn off the power switch, then turn it on again.
Managing Certificates

This section includes:

- About Security Certificates ................................................................. 98
- Overview of Setting Up Digital Certificates ........................................ 99
- Before You Begin .................................................................................. 99
- Preparing to Manage Certificates ....................................................... 100
- Importing a Digital Certificate ............................................................. 101
- Configuring the Digital Certificate Purpose ............................................. 101
- Verifying the Digital Certificate Purpose ............................................... 102
- Deleting a Digital Certificate ............................................................... 102
- Exporting a Digital Certificate .............................................................. 103

About Security Certificates

A digital certificate is a file that contains data used to verify the identity of the client or server in a network transaction. A certificate also contains a public key used to create and verify digital signatures. One device proves its identity to another by presenting a certificate signed by a trusted third party and a digital signature proving its ownership of the certificate.

A digital certificate includes the following data:

- Information about the owner of the certificate
- The certificate serial number and expiration date
- The name and digital signature of the certificate authority (CA) that issued the certificate
- A public key
- A purpose defining how the certificate and public key can be used

There are three types of certificates:

- **Device Certificate**: A certificate for which the printer has a private key, and the purpose specified in the certificate allows it to be used to prove identity.
- **CA Certificate**: A certificate with authority to sign other certificates.
- **Trusted Certificate**: A self-signed certificate from another device that you want to trust.

To ensure that the printer can communicate with other devices over a secure trusted connection, both devices must have certain certificates installed.
For protocols such as HTTPS, the printer is the server, and must prove its identity to the client Web browser. For protocols such as 802.1X, the printer is the client, and must prove its identity to the authentication server, typically a RADIUS server.

- Install a device certificate on the printer.
  
  **Note:** To enable HTTPS, create a self-signed Certificate from the SSL page in CentreWare Internet Services.

- Install a copy of the CA certificate that was used to sign the device certificate of the printer on the other device.

Protocols such as LDAP and IPsec require both devices to prove their identity to each other.

**Overview of Setting Up Digital Certificates**

This is an overview of the steps to take to set up and use digital certificates:

1. Preparing the printer to manage digital certificates.
   a. Changing the encryption settings of the hard drive.
   b. Enabling HTTPS communications.
2. Importing and setting up digital certificates.
   a. Importing the digital certificates.
   b. Configuring the digital certificate purpose.
   c. Verifying the digital certificate purpose.
3. Configuring desired security features to use the imported digital certificates.

Use the following topics to set up the digital certificates for your printer.

**Before You Begin**

Before you can manage certificates, do the following:

- Install the optional Productivity Kit (HD).
- Enable HDD Encryption. For details, see Configuring the Data Encryption Settings on page 97.
- Configure SSL. For details, see Configuring SSL settings on page 93.
Preparing to Manage Certificates

Some settings are available only when the encryption setting on the optional hard drive is enabled. To use these settings, enable data encryption and set up an encryption key.

*Note:* All stored data is deleted after you change the Data Encryption Settings.

To enable data encryption of the hard drive:
1. At the printer control panel, press the **Machine Status** button.
2. Touch **Tools**, then touch **Admin Settings**.
3. Enter the Panel Lock passcode as needed, then touch **OK**.
4. Use the **Up** or **Down** arrows to navigate, then touch **Secure Settings**.
5. Use the **Up** or **Down** arrows to navigate, then touch **HDD Data Encryption**.
6. Touch **On**, then touch **OK**.
7. Using the keypad, enter an encryption key, then touch **OK**.

*Note:* Use characters for 0 to 9, a to z, A to Z, and null values for the encryption key.

**WARNING:** All stored data is deleted after you change the Data Encryption Settings.

8. At the message, to confirm the setting, touch **Yes, Delete**.
   The printer automatically restarts.

To enable HTTPS communication:
1. At your computer, open a Web browser, in the address field, type the IP address of the printer, then press **Enter** or **Return**.
2. Click **Properties**.
3. In the left navigation panel, scroll to **Security**, then select **SSL**.
4. Click **Create New Certificate**.
5. Under **Public Key Method**, select an option.
6. Under **Public Key Size**, select an option.
7. Confirm the issuer of the SSL self-signed certificate.
8. In **Validity**, specify the validity period of the certificate.
9. Click **Generate Signed Certificate**.
   The printer creates a digital certificate and places it in the certificate list.
10. After the settings are changed, to restart the printer, click **Restart Printer**.
11. Enter the IP address of the printer in the address bar, then press the **Enter** key.
12. To display the SSL page, repeat steps 2, 3, and 4.
13. Ensure that **Enabled SSL** is selected.
Importing a Digital Certificate

Before importing a certificate, back up the certificate file.

Note: Use Internet Explorer to import the certificate from Windows. Use Safari to import certificates from Macintosh.

To import a digital certificate:

1. At your computer, open a Web browser, in the address field, type the IP address of the printer, then press Enter or Return.
2. Click Properties.
3. In the left navigation panel, scroll to Security, then select SSL.
4. Click Upload Signed Certificate.
   Note: Upload Signed Certificate appears only when the optional hard drive is installed and the HDD Data Encryption is enabled.
5. Enter a password corresponding to the certificate file to import.
   Note: A password is only required for PKCS#12 certificates. Leave the password field blank for PKCS#7 and other certificates.
6. To confirm, re-enter the password.
7. Click the Browse button, then browse to the certificate file and select it.
8. To import the file, click Import.

Configuring the Digital Certificate Purpose

1. At your computer, open a Web browser, in the address field, type the IP address of the printer, then press Enter or Return.
2. Click Properties.
3. In the left navigation panel, scroll to Security, then select Certificate Management.
   Note: Certificate Management appears in the Security menu only when the optional hard drive is installed and HDD Data Encryption is enabled.
4. Next to Category, select an option:
   – When setting a certificate for an SSL server, SSL client, IPsec, or Wireless LAN client, select Local Device.
   – When setting a certificate for a Wireless LAN server, select Trusted Certificate Authority.
5. Next to Certificate Purpose, select an option.
6. Next to Certificate Order, select the order in which the certificates appear.
7. To display the Certificate List page, click Display the List.
   Note: If the list includes more than 20 certificates, click Next to display the next page.
8. Select the certificate to associate with the Certificate Purpose you selected in step 5.
9. To display the Certificate Details page, click Certificate Details.
10. After confirming the certificate details, at the top of the details window, click the Use this certificate button.
Verifying the Digital Certificate Purpose

1. At your computer, open a Web browser, in the address field, type the IP address of the printer, then press Enter or Return.
2. Click Properties.
3. In the left navigation panel, scroll to Security, then select Certificate Management.
4. Verify the information selected next to Category, Certificate Purpose, and Certificate Order. If a selection is incorrect, select another option.
5. To display the Certificate List page, click Display the List.
   **Note:** If the list includes more than 20 certificates, click Next to display the next page.
6. Ensure that the certificate that appears with an asterisk is valid and that it is the certificate associated with the Certificate Purpose.

Deleting a Digital Certificate

1. At your computer, open a Web browser, in the address field, type the IP address of the printer, then press Enter or Return.
2. Click Properties.
3. In the left navigation panel, scroll to Security, then select Certificate Management.
4. For the certificate you want to delete, select the Category.
5. For the certificate you want to delete, select the Certificate Purpose.
6. To display the Certificate List page, click Display the List.
   **Note:** If the list includes more than 20 certificates, click Next to display the next page.
7. Select the certificate that you want to delete.
8. Click Certificate Details.
9. To delete the certificate, in the upper right corner, click Delete.
10. Click Delete to confirm.
    **Note:** When you delete a certificate, it disables the feature associated with the deleted feature. To delete a certificate that is in use, disable the feature in advance or switch the association to another certificate.
    - For an SSL server, select another certificate, such as a Local Device.
    - For an SSL Client, disable the LDAP-SSL/TLS and IEEE802.1x features.
    - For IPsec, change the IKE setting to Preshared Key or disable the feature.
    - For Wireless LAN, change the wireless security setting to something other than WPA-Enterprise before deleting the certificate.
Exporting a Digital Certificate

1. At your computer, open a Web browser, in the address field, type the IP address of the printer, then press Enter or Return.
2. Click Properties.
3. In the left navigation panel, scroll to Security, then select Certificate Management.
4. Select the Category of the certificate you want to export.
5. Select the Certificate Purpose of the certificate you want to export.
6. To display the Certificate List page, click Display the List.
   Note: If the list includes more than 20 certificates, to display the next page, click Next.
7. Select the certificate to export.
8. Click Certificate Details.
9. To export the certificate, at the bottom of the details list, click Export this certificate.
   Note: Imported PKCS#12 format certificates can be exported only as a PKCS#7 certificates, because PKCS#12 passwords cannot be exported.
10. In the File Download dialog box, click Save.
11. Select the location to save the file, then click Save.
Configuring Smart eSolutions

This section includes:

- Using Smart eSolutions ................................................................. 104
- Overview for Setting Up Smart eSolutions ......................................................... 104
- Enabling the Proxy Server ........................................................................ 105
- Validate DNS Settings and Enable SSL .................................................. 105
- Registering with the Xerox Communication Server ................................... 106
- Setting Up Email Notifications for Billing Meter Read Alerts .................. 106
- Setting Up Email Notifications for Supplies Data Send Alerts .................. 107

Using Smart eSolutions

Smart eSolutions is a suite of features that simplifies printer ownership and administration. It provides free services to enable administration of metered billing and supplies replenishment plans for printers on a network. For details, see www.xerox.com/smartesolutions.

MeterAssistant automatically counts all metered impressions printed on network printers, then submits them to Xerox. This process eliminates the need to collect and report meter read information manually.

SuppliesAssistant monitors the remaining life of the toner or ink, and other printer consumables. When Smart eSolutions is configured to communicate with Xerox, SuppliesAssistant also monitors the usage of consumables. The data reported to Xerox is used to replenish supplies.

Overview for Setting Up Smart eSolutions

This is an overview of the steps required to set up the Smart eSolutions feature:

1. Enabling the Proxy Server.
2. Validating the DNS settings and enabling SSL.
3. Registering the printer with the Xerox Communication Server.
4. Setting up email notifications for Meter Assistant.
5. Setting up email notifications for Supplies Assistant.

Use the following topics to set up Smart eSolutions.
Enabling the Proxy Server
1. At your computer, open a Web browser, in the address field, type the IP address of the printer, then press Enter or Return.
2. Click Properties.
3. In the left navigation panel, scroll to Smart eSolutions, then select Registration.
4. In the Registration Window, under Setup, click Enable Proxy Server.
5. If your network does not use a proxy server, next to Use Proxy Server, clear the Enabled box, then click Save Changes.

Proceed to Register with Xerox Communication Server.
6. If your network uses a proxy server, next to Use Proxy Server, select Enabled.
7. Next to Server Name, enter the name for the proxy server.
8. Next to Port Number, enter the port number of the proxy server.
9. If your proxy server requires authentication, next to Authentication, select Enabled.
10. If authentication is enabled, next to Login Name, enter the login name for the proxy server.
11. Next to Password, enter the password for the proxy server.
12. Next to Retype Password, re-enter the password.
13. Click Save Changes.

Validate DNS Settings and Enable SSL
1. At your computer, open a Web browser, in the address field, type the IP address of the printer, then press Enter or Return.
2. Click Properties.
3. In the left navigation panel, scroll to TCP/IP.
4. Scroll to DNS and ensure that the Obtain DNS Server Address Automatically button is enabled.
   
   Note: If the printer does not find the DNS server automatically, manually configure the settings for the DNS server.
5. If the field is not enabled, in the DNS Server Address Field, enter the IP address of the DNS.
6. Click Save Changes.
7. In the left navigation panel, scroll to SSL.
8. Next to LDAP-SSL/TLS Communication, select Enabled.
9. Click Save Changes.
10. At the prompt to restart the system, click Restart.
11. After the printer restarts, wait about 20 seconds, then refresh the CentreWare Internet Services page in your browser.
    
   If the configuration was successful, the CentreWare Internet Services URL should start with https.
12. When prompted by the browser, accept the certificate.
Registering with the Xerox Communication Server

1. At your computer, open a Web browser, in the address field, type the IP address of the printer, then press Enter or Return.
2. Click Properties.
3. In the left navigation panel, scroll to Smart eSolutions, then select Registration.
4. In the Registration Window, under Setup, click Register with Xerox Communication Server.
5. In the Xerox Communication Server window, under Communication setup, next to Server Communication, select Enabled.
6. Next to Transmission Time, enter the time for the printer to communicate with the Xerox Communication Server.
   
   Note: Enter the GMT time for the transmission time. Do not use the local time for the transmission.
7. Click Test Communication Now.
8. If the message reads "Download Problem detected during the download process. Please try again", check the settings and retry. If the problem persists, go to www.xerox.com/office/WC6605support for online support information.
9. If the message reads "Communication Successful, Device diagnostic information successfully sent to Xerox," click Back, then click Save Changes.
   Setup is complete. No other action is required.

Setting Up Email Notifications for Billing Meter Read Alerts

Use Billing Meters to view impression count details for the printer, and to print Billing Meter and Supplies Usage reports. The current counts for color, black and white, and combined total impressions appear on the Billing Meters screen. The Billing Meters data can be sent to as many as five email addresses for billing administrators and key operators. Use this page to manage the email addresses and determine when the printer sends email notifications.

   Note: Before using email notifications, configure the SMTP server for mail alerts. See Configuring Mail Alerts on page 57.

To set up email notifications for Billing Meter reads:
1. At your computer, open a Web browser, in the address field, type the IP address of the printer, then press Enter or Return.
   
   Note: If you do not know the IP address of your printer, see Finding the IP Address of Your Printer on page 30.
2. Click Properties.
3. In the left navigation panel, scroll to Smart eSolutions, then select Registration.
4. In the Registration Window, under Setup, click Setup Email Notification (Billing Meter Read Alerts).
5. Under Recipient Group Addresses, for Billing Administrator Email Addresses, type the email address of each administrator to receive email alerts.
6. Next to Send Alert, select when the printer sends email alerts.
7. Click Save Changes.
Setting Up Email Notifications for Supplies Data Send Alerts

SuppliesAssistant monitors the remaining life of the toner or ink, and other printer consumables. When Smart eSolutions is configured to communicate with Xerox, SuppliesAssistant also monitors the usage of consumables. The data reported to Xerox is used to replenish supplies. The printer can also send email alerts up to five email addresses for supplies administrators and key operators. Use this page to manage the email addresses and determine when the printer sends email notifications.

Note: Before using email notifications, configure the SMTP server for mail alerts. See Configuring Mail Alerts on page 57.

To set up email notifications for supplies data:
1. At your computer, open a Web browser, in the address field, type the IP address of the printer, then press Enter or Return.
   
   Note: If you do not know the IP address of your printer, see Finding the IP Address of Your Printer on page 30.
2. Click Properties.
3. In the left navigation panel, scroll to Smart eSolutions, then select Registration.
4. In the Registration Window, under Setup, click Setup Email Notification (Supplies Data Send Alerts).
5. Under Recipient Group Addresses, next to Supplies Administrator Email Addresses, enter the email addresses of the administrators that the printer sends email notifications.
6. To send an email alert if the registration with the Xerox Communication Server is canceled, select Send Alert.
7. Click Save Changes.
Enabling the Printer for Scanning

If the printer is connected to a network, you can scan to an FTP address, an email address, or a shared folder on your computer. First you must set up scanning in CentreWare Internet Services. For details, see CentreWare Internet Services on page 30.

If the printer is connected with a USB cable, you can scan to a folder on your computer, or scan into an application. First you must install the scan drivers and the Express Scan Manager utility.

**Note:** If your printer is connected using the USB cable, you cannot scan to an email address or a network location, such as a shared folder on your computer.

For details, see Scanning Setup Overview on page 77.
Installing the Software

This section includes:

- Operating System Requirements
- Installing the Print Drivers for a Windows Network Printer
- Installing the Print Drivers for a Windows USB Printer
- Installing Print Drivers for Macintosh OS X Version 10.5 and Later
- Installing Scan Drivers for Macintosh
- Installing LAN Fax Drivers for Macintosh
- Adding a LAN Fax Printer for Macintosh

Before installing driver software, verify that the printer is plugged in, turned on, connected correctly, and has a valid IP address. The IP address usually appears in the upper right corner of the control panel. If you cannot find the IP address, see Finding the IP Address of Your Printer on page 30.

If the Software and Documentation disc is not available, download the latest drivers from www.xerox.com/office/WC6605drivers.

Operating System Requirements

- Macintosh OS X version 10.5 and later
- UNIX and Linux: Your printer supports connection to various UNIX platforms through the network interface. For details, see www.xerox.com/office/WC6605drivers.
Installing the Print Drivers for a Windows Network Printer

1. Insert the Software and Documentation disc into the appropriate drive on your computer. If the installer does not start automatically, navigate to the drive, and double-click the Setup.exe installer file.
2. At the bottom of the Driver Installation window, click Language.
3. Select your language, then click OK.
4. Select the printer model, then click Install Print and Scan Drivers.
5. To accept the agreement, click I Agree.
6. In the Discovered Printers list, select your printer, then click Next.
7. If your printer does not appear in the list of discovered printers, to search the wider network, click Extended Search.
8. If your printer still does not appear in the list of discovered printers, and you know the IP address:
   a. Click the Network Printer icon at the top of the window.
   b. Enter the IP address or the DNS name of the printer.
   c. Click Search.
   d. From the list of discovered printers, select your printer, then click Next.
9. If the printer still does not appear in the list of discovered printers, and you do not know the IP address:
   a. Click Advanced Search.
   b. If you know the gateway address and subnet mask, click the top button and enter the addresses into the Gateway and Subnet Mask fields.
   c. If you know the address of another printer on the same subnet, click the middle button and enter the address in the IP Address field.
   d. Click Search.
   e. From the list of discovered printers, select your printer, then click Next.
   Note: If you do not know the IP address of your printer, see Finding the IP Address of Your Printer on page 30.
10. Click Next to start the installation.
11. Under Print Driver Selection, select Postscript (recommended), PCL6, or both.
12. Under Additional Options, to get the latest driver files, select Download Files from the Internet.
13. Click Install.
14. When the installation is complete, at the Installation Complete screen, select the following:
   – Set Printer as Default (optional)
   – Print a Test Page (optional)
   – Share Printer ensures that the scanner works properly with your computer.
15. Click Finish.
16. At the Product Registration screen, select your country from the list, then click Next. Complete the registration form and submit it.
Installing the Print Drivers for a Windows USB Printer

1. Insert the Software and Documentation disc into the appropriate drive on your computer.
   If the installer does not start automatically, navigate to the drive, and double-click the Setup.exe installer file.
2. At the bottom of the Driver Installation window, click Language.
3. Select your language, then click OK.
4. Select the printer model, then click Install Print and Scan Drivers.
5. Click I accept the terms to accept the agreement, then click Next.
6. At the Product Registration screen, select your country from the list, then click Next. Complete the registration form and submit it.

   Notes: The following applications are installed on your computer with the print driver:
   • Express Scan Manager
   • Address Book Editor

See also:
Online Support Assistant at: www.xerox.com/office/WC6605support
Installing Print Drivers for Macintosh OS X Version 10.5 and Later

Install the Xerox print driver to access all features of your printer.

To install the print driver software:
1. Insert the Software and Documentation disc into your computer.
2. Double-click the disc icon on your desktop to see the .dmg file for your printer.
3. Open the .dmg file, and navigate to the appropriate installer file for your operating system.
4. Open the installer file.
5. Click Continue to acknowledge the warning and introductory messages.
6. To accept the license agreement, click Continue, then click Agree.
7. To accept the current installation location, click Install, or select another location for the installation files, then click Install.
8. Enter your password, then click OK.
9. Select your printer in the list of discovered printers, then click Continue.
10. If your printer does not appear in the list of discovered printers:
   a. Click the Network Printer Icon.
   b. Type the IP address of your printer, then click Continue.
   c. Select your printer in the list of discovered printers, then click Continue.
11. To accept the print queue message, click OK.
12. Select or clear the Set Printer as Default and Print a Test Page check boxes.
13. Click Continue, then click Close.

   Note: The printer is automatically added to the printer queue in Macintosh OS X version 10.4 and later.

To verify that the print driver recognizes the installed options:
1. From the Apple menu, click System Preferences>Print.
2. Select the printer in the list, then click Options and Supplies.
3. Click Driver, then confirm that your printer is selected.
4. Confirm that all of the options installed on the printer appear correct.
5. If you change settings, click Apply Changes, close the window, and quit System Preferences.
Installing Scan Drivers for Macintosh

1. Insert the *Software and Documentation disc* into your computer.
2. Double-click the disc icon on your desktop to see the *.dmg* file for your printer.
3. Open the *Scan Installer.dmg* file, then navigate to the appropriate installer file for your operating system.
4. Open the *Scan Installer* package file.
5. Click *Continue* to acknowledge the warning and introductory messages.
6. To accept the license agreement, click *Continue*, then click *Agree*.
7. To accept the current installation location, click *Install*, or select another location for the installation files, then click *Install*.
8. Enter your password, then click *OK*.
9. Select your printer in the list of discovered printers, then click *Continue*.
10. Click *Continue Installation*.
11. To restart, click *Log Out*.

Installing LAN Fax Drivers for Macintosh

1. Insert the *Software and Documentation disc* into your computer.
2. Double-click the disc icon on your desktop to see the *.dmg* file for your printer.
3. Open the *LAN Fax Installer.dmg* file, then navigate to the appropriate installer file for your operating system.
4. Open the *LAN Fax Installer* package file.
5. Click *Continue* to acknowledge the warning and introductory messages.
6. To accept the license agreement, click *Continue*, then click *Agree*.
7. To accept the current installation location, click *Install*, or select another location for the installation files, then click *Install*.
8. Enter your password, then click *OK*.
9. Select your printer in the list of discovered printers, then click *Continue*.
10. Click *Continue Installation*.
11. To finish, click *Close*.
12. To register your printer and software, complete the registration form.
Adding a LAN Fax Printer for Macintosh

After installing the LAN fax driver on a Macintosh computer, use Bonjour to set up your printer. You can also add the printer using the IP Address of the printer for an LDP/LPR connection. For non-network printers, create a desktop USB connection.

To add the printer using Bonjour:
1. From the computer Applications folder or from the dock, open System Preferences.
2. Click Print & Fax.
   The list of printers appears on the left of the window.
3. Click the plus button (+) under the list of printers.
4. Click the Default icon at the top of the window.
5. Select your printer from the list and click Add.
   Note: If the printer is not detected, ensure that the printer is on and that the cable is connected properly.
6. In the Print Using drop down list, choose Select Printer Software.
7. Select the appropriate Xerox® 6605 LAN fax driver model from the list, then click OK.
8. Click Add.

To add the printer by specifying the IP address:
1. From the computer Applications folder or from the dock, open System Preferences.
2. Click Print & Fax.
   The list of printers appears on the left of the window.
3. Click the plus button (+) under the list of printers.
4. Click IP.
5. From the Protocol drop down menu, select the Protocol.
6. In the Address field, enter the IP address of the printer.
7. In the Name field, enter the name of the printer.
8. In the Print Using drop down list, choose Select Printer Software.
9. Select the appropriate Xerox® 6605 LAN fax driver model from the list, then click OK.
10. Click Add.
Installing the Printer as a Web Service on Devices

Web Services on Devices (WSD) allow a client to discover and access a remote device and its associated services across a network. WSD supports device discovery, control, and use.

To install a WSD printer using the Add Device Wizard:
1. At your computer, click Start, then select Devices and Printers.
2. To launch the Add Device Wizard, click Add a Device.
3. In the list of available devices, select the one you want to use, then click Next.
   Note: If the printer you want to use does not appear in the list, click the Cancel button. Add the WSD printer manually using the Add Printer Wizard.
4. Click Close.

To install a WSD printer using the Add Printer Wizard:
1. At your computer, click Start, then select Devices and Printers.
2. To launch the Add Printer Wizard, click Add a Printer.
3. Click Add a network, wireless, or Bluetooth printer.
4. In the list of available devices, select the one you want to use, then click Next.
5. If the printer you want to use does not appear in the list, click The printer that I want is not listed.
6. Select Add a printer using a TCP/IP address or hostname, then click Next.
7. From the Device type field, select Web Services Device.
8. Enter the printer IP address in the Hostname or IP address field, then click Next.
9. Click Close.
Paper and Media

This chapter includes:

- Supported Paper ................................................................. 118
- Loading Paper ........................................................................ 122
- Printing on Special Paper .................................................... 128
Supported Paper

This section includes:

- Recommended Media ................................................................. 118
- Ordering Paper ............................................................................. 118
- General Paper Loading Guidelines ............................................. 118
- Paper That Can Damage Your Printer ........................................ 119
- Paper Storage Guidelines ............................................................ 119
- Supported Paper Types and Weights .......................................... 120
- Supported Standard Paper Sizes ................................................ 120
- Supported Paper Types and Weights for Automatic 2-Sided Printing 120
- Supported Standard Paper Sizes for Automatic 2-Sided Printing 121
- Supported Custom Paper Sizes .................................................... 121

Your printer is designed to use various paper and other media types. To ensure the best print quality and to avoid jams, follow the guidelines in this section.

For best results, use Xerox paper and media recommended for your printer.

Recommended Media

A list of paper and media recommended for your printer is available at:

- www.xerox.com/paper Recommended Media List (United States)
- www.xerox.com/europaper Recommended Media List (Europe)

Ordering Paper

To order paper or other media, contact your local reseller or visit www.xerox.com/office/WC6605supplies.

General Paper Loading Guidelines

- Do not overfill the paper trays. Do not load paper above the maximum fill line in the tray.
- Adjust the paper guides to fit the paper size.
- Fan paper before loading it in the paper tray.
- If excessive jams occur, use paper or other approved media from a new package.
- Do not print on label media once a label has been removed from a sheet.
- Use only paper envelopes. Print envelopes 1-sided only.
Paper That Can Damage Your Printer

Some paper and other media types can cause poor output quality, increased paper jams, or damage your printer. Do not use the following:

- Rough or porous paper
- Inkjet paper
- Non-laser glossy or coated paper
- Paper that has been photocopied
- Paper that has been folded or wrinkled
- Paper with cutouts or perforations
- Stapled paper
- Envelopes with windows, metal clasps, side seams, or adhesives with release strips
- Padded envelopes
- Plastic media

⚠️ CAUTION: The Xerox Warranty, Service Agreement, or Xerox Total Satisfaction Guarantee does not cover damage caused by using unsupported paper or specialty media. The Xerox Total Satisfaction Guarantee is available in the United States and Canada. Coverage could vary outside these areas. Please contact your local representative for details.

Paper Storage Guidelines

Storing your paper and other media properly contributes to optimum print quality.

- Store paper in dark, cool, relatively dry locations. Most paper is susceptible to damage from ultraviolet and visible light. Ultraviolet light, from the sun and fluorescent bulbs, is particularly damaging to paper.
- Reduce the exposure of paper to strong lights for long periods of time.
- Maintain constant temperatures and relative humidity.
- Avoid storing paper in attics, kitchens, garages, or basements. These spaces are more likely to collect moisture.
- Store paper flat, either on pallets, cartons, shelves, or in cabinets.
- Avoid food or drinks in the area where paper is stored or handled.
- Do not open sealed packages of paper until you are ready to load them into the printer. Leave stored paper in the original packaging. The paper wrapper protects the paper from moisture loss or gain.
- Some special media is packaged inside resealable plastic bags. Store the media inside the bag until you are ready to use it. Keep unused media in the bag and reseal it for protection.
### Supported Paper Types and Weights

<table>
<thead>
<tr>
<th>Trays</th>
<th>Paper Types</th>
<th>Weights</th>
</tr>
</thead>
<tbody>
<tr>
<td>All Trays</td>
<td>Hole Punched Colored</td>
<td>60–90 g/m²</td>
</tr>
<tr>
<td></td>
<td>Plain Letterhead</td>
<td>(75–105 g/m²)</td>
</tr>
<tr>
<td></td>
<td>Lightweight Cardstock</td>
<td>(106–163 g/m²)</td>
</tr>
<tr>
<td></td>
<td>Lightweight Glossy Cardstock</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Heavyweight Cardstock</td>
<td>(164–216 g/m²)</td>
</tr>
<tr>
<td></td>
<td>Heavyweight Glossy Cardstock</td>
<td></td>
</tr>
<tr>
<td>Bypass Tray</td>
<td>Labels</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Envelope</td>
<td></td>
</tr>
</tbody>
</table>

### Supported Standard Paper Sizes

<table>
<thead>
<tr>
<th>Tray</th>
<th>European Standard Sizes</th>
<th>North American Standard Sizes</th>
</tr>
</thead>
<tbody>
<tr>
<td>All Trays</td>
<td>A4 (210 x 297 mm, 8.3 x 11.7 in.)</td>
<td>Legal (216 x 356 mm, 8.5 x 14 in.)</td>
</tr>
<tr>
<td></td>
<td>B5 (176 x 250 mm, 6.9 x 9.8 in.)</td>
<td>Folio (216 x 330 mm, 8.5 x 13 in.)</td>
</tr>
<tr>
<td></td>
<td>A5 (148 x 210 mm, 5.8 x 8.3 in.)</td>
<td>Letter (216 x 279 mm, 8.5 x 11 in.)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Executive (184 x 267 mm, 7.25 x 10.5 in.)</td>
</tr>
<tr>
<td>Bypass Tray</td>
<td>C5 envelope (162 x 229 mm, 6.4 x 9 in.)</td>
<td>Monarch envelope (98 x 190 mm, 3.9 x 7.5 in.)</td>
</tr>
<tr>
<td></td>
<td>DL envelope (110 x 220 mm, 4.33 x 8.66 in.)</td>
<td>No. 10 envelope (241 x 105 mm, 4.1 x 9.5 in.)</td>
</tr>
</tbody>
</table>

### Supported Paper Types and Weights for Automatic 2-Sided Printing

<table>
<thead>
<tr>
<th>Paper Types</th>
<th>Weights</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hole Punched Colored</td>
<td>60–90 g/m²</td>
</tr>
<tr>
<td>Plain Letterhead</td>
<td>(75–105 g/m²)</td>
</tr>
<tr>
<td>Lightweight Cardstock</td>
<td></td>
</tr>
<tr>
<td>Lightweight Glossy Cardstock</td>
<td>(106–163 g/m²)</td>
</tr>
</tbody>
</table>
Supported Standard Paper Sizes for Automatic 2-Sided Printing

<table>
<thead>
<tr>
<th>European Standard Sizes</th>
<th>North American Standard Sizes</th>
</tr>
</thead>
<tbody>
<tr>
<td>A4 (210 x 297 mm, 8.3 x 11.7 in.)</td>
<td>Legal (216 x 356 mm, 8.5 x 14 in.)</td>
</tr>
<tr>
<td>B5 (176 x 250 mm, 6.9 x 9.8 in.)</td>
<td>Folio (216 x 330 mm, 8.5 x 13 in.)</td>
</tr>
<tr>
<td>A5 (148 x 210 mm, 5.8 x 8.3 in.)</td>
<td>Letter (216 x 279 mm, 8.5 x 11 in.)</td>
</tr>
<tr>
<td></td>
<td>Executive (184 x 267 mm, 7.25 x 10.5 in.)</td>
</tr>
</tbody>
</table>

Supported Custom Paper Sizes

Bypass Tray
- Width: 76.2–215.9 mm (3–8.5 in.)
- Length: 127–355.6 mm (5–14 in.)

Trays 1 and 2
- Width: 148–215.9 mm (5.8–8.5 in.)
- Length: 210–355.6 mm (8.3–14 in.)
Loading Paper

This section includes:
- Loading Paper in the Bypass Tray ................................................................. 122
- Configuring Trays 1 or 2 for the Paper Length .................................................. 124
- Loading Paper in Trays 1 and 2 ...................................................................... 125

Loading Paper in the Bypass Tray

1. Do one of the following:
   - If the bypass tray is loaded with paper already, remove any paper that is a different size or type.
   - If the Bypass Tray is closed, open it.

2. Pull out the extension tray for larger sizes.
3. Move the width guides to the edges of the tray.

4. Flex the sheets back and forth and fan them, then align the edges of the stack on a level surface. This procedure separates any sheets that are stuck together and reduces the possibility of jams.

Note: To avoid jams and misfeeds, do not remove paper from its packaging until you are ready to use it.

5. Load the paper in the tray. Load hole punched paper with the holes to the left.
− For 1-sided printing, load letterhead or pre-printed face up with the top edge going into the printer.

− For 2-sided printing, load letterhead and pre-printed face down with the top edge going into the printer.

   Note: Do not load paper above the maximum fill line. Overfilling the tray can cause the printer to jam.

6. Adjust the width guides until they touch the edges of the paper.
7. If the control panel prompts you, verify the size and type on the screen. To make changes:
   a. Touch Size, then touch an option for a standard paper size.
   b. Touch Type, then touch an option for the paper type.
   c. Touch OK.

Configuring Trays 1 or 2 for the Paper Length

You can adjust the lengths of trays 1 and 2 to accommodate A4/Letter and Legal paper sizes. In the Legal length settings, the trays protrude from the front of the printer.

To change the 550-Sheet Feeders in the trays to match the paper length:
1. Remove all paper from the tray.
2. To remove the tray from the printer, pull out the tray until it stops, lift the front of the tray slightly, then pull it out.
3. To extend the tray, with one hand, hold the back of the tray. With the other hand, at the front of the tray, press the release latch and pull the ends outward until they latch.

4. To compress the tray for shorter paper, with one hand, hold the back of the tray. With the other hand, at the front of the tray, press the release latch, then push the ends inward until they latch.

5. Load paper into the tray, then insert it back into the printer. For details, see Loading Paper into Trays 1 and 2 on page 125.

Loading Paper in Trays 1 and 2

1. Pull out the tray until it stops.
2. To remove the tray from the printer, pull out the tray until it stops, lift the front of the tray slightly, then pull it out.

3. At the back of the paper tray, press the paper lift tray down until it locks.
4. Adjust the paper length and width guides as illustrated.
5. Flex the sheets back and forth and fan them, then align the edges of the stack on a level surface. This procedure separates any sheets that are stuck together and reduces the possibility of jams.

6. Load paper into the tray with the print side face up.
   - Load hole punched paper with the holes to the left.
   - For 1-sided printing, load letterhead face up with the top of the paper toward the back of the tray.
   - For 2-sided printing, load letterhead face down with the top of the paper toward the back of the tray.

   **Note:** Do not load paper above the maximum fill line. Overfilling the tray can cause the printer to jam.

7. Adjust the length and width guides to fit the paper.
8. Slide the tray back into the printer.

9. Push the tray in all the way.

   Notes:
   - If the tray does not go in all the way, ensure that the paper lift plate at the back of the tray is locked down.
   - If the tray is extended for legal size paper, the tray protrudes when it is inserted into the printer.

10. If the control panel prompts you, verify the size and type on the screen. To make changes:
    a. Touch **Size**, then touch an option for a standard paper size.
    b. Touch **Type**, then touch an option for the paper type.
    c. Touch **OK**.
Printing on Special Paper

This section includes:

- Envelopes ................................................................. 128
- Labels ........................................................................... 132
- Glossy Cardstock ....................................................... 133

To order paper or other media, contact your local reseller or visit www.xerox.com/office/WC6605supplies.

See also:
www.xerox.com/paper Recommended Media List (United States)
www.xerox.com/europaper Recommended Media List (Europe)

Envelopes

You can print envelopes from the bypass tray only.

Guidelines for Printing Envelopes

- Print quality depends on the quality and construction of the envelopes. Try another envelope brand if you do not get desired results.
- Maintain constant temperatures and relative humidity.
- Store unused envelopes in their packaging to avoid excess moisture and dryness which can affect print quality and cause wrinkling. Excessive moisture can cause the envelopes to seal before or during printing.
- Remove air bubbles from the envelopes before loading them into the tray by setting a heavy book on top of them.
- In the print driver software, select Envelope as the paper type.
- Do not use padded envelopes. Use envelopes that lie flat on a surface.
- Do not use envelopes with heat activated glue.
- Do not use envelopes with press and seal flaps.
- Use only paper envelopes.
- Do not use envelopes with windows or metal clasps.
**Loading Envelopes in the Bypass Tray**

1. Open the bypass tray.

2. Move the width guides to the edges of the tray.

*Note:* If you do not load envelopes in the bypass tray right after they have been removed from the packaging, they can bulge. Flatten them to avoid jams.
3. Select an option to load the envelopes:
   - For Number 10 envelopes, load the envelopes with the short edge going into the printer, flaps down, and flaps to the right.

   - For Monarch or DL envelopes, do one of the following. If the envelopes wrinkle, try another option.
     • With the short edge going into the printer, flaps down, and flaps to the right.

     • With the print side up, flaps open and down, and the bottom of the envelope going into the printer.
• With the print side up, flaps closed and down, and flaps going into the printer.

For C5 envelopes, do one of the following. If the envelopes wrinkle, try the other option.
• With the print side up, flaps open and down, and the bottom of the envelope going into the printer.

Note: When you load envelopes with the flaps open, in the print driver, select Portrait, Landscape, or Rotated Landscape, as needed, to have them print correctly. In the print driver, use Rotate Image 180 Degrees to flip the image as needed.

4. At the control panel, touch Type, then touch Envelope.
5. At the control panel, touch Size, then select the envelope size.
6. Touch OK.
Labels
You can print labels from any tray.

Guidelines for Printing Labels
- Use labels designed for laser printing.
- Do not use vinyl labels.
- Do not feed a sheet of labels through the printer more than once.
- Do not use dry gum labels.
- Print only on one side of the sheet of labels. Use full sheet labels only.
- Store unused labels flat in their original packaging. Leave the sheets of labels inside the original packaging until ready to use. Return any unused sheets of labels to the original packaging and reseal it.
- Do not store labels in extremely dry or humid conditions or extremely hot or cold conditions. Storing them in extreme conditions can cause print-quality problems or cause them to jam in the printer.
- Rotate stock frequently. Long periods of storage in extreme conditions can cause labels to curl and jam in the printer.
- In the print driver software, select Label as the paper type.
- Before loading labels, remove all other paper from the tray.

⚠️ CAUTION: Do not use any sheet where labels are missing, curled, or pulled away from the backing sheet. It could damage the printer.

Loading Labels in the Bypass Tray
1. Remove all paper from the tray.
2. Load labels face up with the top of the page going into the printer.
3. Adjust the width guides until they touch the edges of the paper.
4. On the control panel, change the type to Label.
5. On the control panel, select the size.
6. Touch OK.
7. In the Printing Preferences of the print driver, on the Paper/Output tab, change the Paper Type setting.
Glossy Cardstock

You can print Lightweight Glossy Cardstock and Heavyweight Glossy Cardstock up to 216 g/m² from any tray.

Guidelines for Printing on Glossy Cardstock

- Do not open sealed packages of glossy cardstock until you are ready to load them into the printer.
- Leave glossy cardstock in the original wrapper, and leave the packages in the shipping carton until ready to use.
- Remove all other paper from the tray before loading glossy cardstock.
- Load only the amount of glossy cardstock you are planning to use. Do not leave glossy cardstock in the tray when you are finished printing. Replace unused cardstock in the original wrapper and seal.
- Rotate stock frequently. Long periods of storage in extreme conditions can cause glossy cardstock to curl and jam in the printer.
- In the print driver software, select the desired glossy cardstock type or select the tray loaded with the desired paper.
This chapter includes:

- Printing Overview ................................................................................................................................. 136
- Selecting Printing Options .................................................................................................................. 137
- Printing Features ................................................................................................................................. 140
- Using Custom Paper Sizes .................................................................................................................. 148
Printing Overview

Before printing, your computer and the printer must be plugged in, turned on, and connected. Ensure that you have the correct print driver software installed on your computer. For details, see Installing the Software on page109.

1. Select the appropriate paper.
2. Load paper in the appropriate tray. On the printer control panel, specify the size, color, and type.
3. Access the print settings in your software application. For most software applications, press CTRL+P for Windows, or CMD+P for Macintosh.
4. Select your printer.
5. Access the print driver settings by selecting Properties or Preferences for Windows, or Xerox® Features for Macintosh. The title of the button can vary depending on your application.
6. Modify the print driver settings as necessary, then click OK.
7. Click Print to send the job to the printer.
Selecting Printing Options

This section includes:

- Print Driver Help
- Windows Printing Options
- Macintosh Printing Options

Printing options, also called print driver software options, are specified as Printing Preferences in Windows, and Xerox® Features in Macintosh. Printing options include settings for 2-sided printing, page layout, and print quality. Printing options that are set from Printing Preferences become the default setting. Printing options that are set from within the software application are temporary. The application and the computer do not save the settings after the application is closed.

Print Driver Help

Xerox® print driver software Help information is available from the Printing Preferences window. Click the Help (?) button in the bottom left corner of the Printing Preferences window to see the Help.

Information about Printing Preferences appears in the Help window. From there, you can select by topic or use the search field to enter the topic or function for which you need information.
Setting Default Printing Options for Windows

When you print from any software application, the printer uses the print job settings specified in the Printing Preferences window. You can specify your most common printing options and save them so that you do not have to change them every time you print.

For example, if you want to print on both sides of the paper for most jobs, specify 2-sided printing in Printing Preferences.

To select default printing options:
1. Navigate to the list of printers on your computer:
   - For Windows XP SP1 and later, click **Start** > **Settings** > **Printers and Faxes**.
   - For Windows Vista, click **Start** > **Control Panel** > **Hardware and Sound** > **Printers**.
   - For Windows Server 2003 and later, click **Start** > **Settings** > **Printers**.
   - For Windows 7, click **Start** > **Devices and Printers**.
2. In the list, right-click the icon for your printer and click **Printing Preferences**.
3. In the Printing Preferences window, click a tab, select the options, then click **OK** to save.

   **Note:** For more information about Windows print driver options, click the Help button (?) in the Printing Preferences window.

Selecting Printing Options for an Individual Job for Windows

To use special printing options for a particular job, change the Printing Preferences from the application before sending the job to the printer. For example, if you want to use the Enhanced print-quality mode when printing a particular document, select Enhanced in Printing Preferences before printing the job.

1. With the document open in your software application, access the print settings. For most software applications, click **File** > **Print** or press **CTRL+P** for Windows.
2. Select your printer and click the **Properties** or **Preferences** button to open the Printing Preferences window. The title of the button can vary depending on your application.
3. Click a tab in the Printing Preferences window, then make selections.
4. Click **OK** to save and close the Printing Preferences window.
5. Click **Print** to send the job to the printer.
Saving a Set of Commonly Used Printing Options for Windows

You can define and save a set of options, so that you can apply them to future print jobs.

To save a set of printing options:
1. With the document open in your application, click File>Print.
2. Select the printer, then click Properties. Click the tabs in the Printing Properties window and select the desired settings.
3. Click Saved Settings at the bottom of the Printing Properties window, then click Save As.
4. Type a name for the set of printing options, then click OK to save the set of options in the Saved Settings list.
5. Select the name from the list to print using these options.

Macintosh Printing Options

Selecting Printing Options for Macintosh

To use specific printing options, change the settings before sending the job to the printer.
1. With the document open in your application, click File>Print.
2. Select your printer.
3. Select Xerox® Features from the Copies & Pages menu.
4. Select the desired printing options from the drop-down lists.
5. Click Print to send the job to the printer.

Saving a Set of Commonly Used Printing Options for Macintosh

You can define and save a set of options, so that you can apply them to future print jobs.

To save a set of printing options:
1. With the document open in your application, click File>Print.
2. Select your printer from the Printers list.
3. Select the desired printing options from the drop-down lists in the Print dialog box.
4. Click Presets>Save As.
5. Type a name for the printing options, then click OK to save the set of options in the Presets list.
6. To print using these options, select the name from the Presets list.
Printing Features

This section includes:

- Printing on Both Sides of the Paper ............................................................... 140
- Orientation ........................................................................................................ 142
- Selecting Paper Options for Printing ............................................................... 142
- Printing Multiple Pages to a Single Sheet .................................................... 142
- Printing Booklets ............................................................................................. 142
- Print Quality ..................................................................................................... 143
- Image Options ................................................................................................ 144
- Printing Watermarks ....................................................................................... 144
- Scaling ............................................................................................................. 145
- Printing Mirror Images ................................................................................... 145
- Selecting Job Completion Notification for Windows ....................................... 145
- Printing Special Job Types ............................................................................. 146
- Printing from a USB Flash Drive .................................................................... 147

Printing on Both Sides of the Paper

Printing a 2-Sided Document

If your printer supports Automatic 2-Sided Printing, the options are specified in the print driver. The print driver uses the settings for portrait or landscape orientation from the application for printing the document.

Note: Ensure that the paper size and weight are supported. For details, see Supported Paper Sizes and Weights for Automatic 2-Sided Printing on page 120.

Setting Up 1-Sided Printing

To set 1-sided printing as the default setting:

1. Navigate to the list of printers on your computer.
2. From the Printers and Faxes window, select a printer, right-click the printer, then select Printing preferences.
3. On the Printing Options tab, click the arrow to the right of the 2-Sided Printing, then select 1-Sided Print.
4. To close the Printing Preferences dialog box, click OK.
2-Sided Page Layout Options

You can specify the page layout for 2-sided printing, which determines how the printed pages turn. These settings override the application page orientation settings.

To make a 2-sided printing selection, on the Page Layout tab, in the bottom left corner of the preview pane, use the arrow button. Page Layout is located on the Document Options tab.

- **1-Sided Print**: Prints on one side of the media. Use this option when printing on transparencies, envelopes, labels, or other media that cannot be printed on both sides.
- **2-Sided Print**: Prints the job on both sides of the paper to allow binding on the long edge of the paper. The following illustrations show the result for documents with portrait and landscape orientations, respectively:

- **2-Sided Print, Flip on Short Edge**: Prints on both sides of the paper. The images print to allow binding on the short edge of the paper. The following illustrations show the result for documents with portrait and landscape orientations, respectively:

Note: 2-Sided Printing is part of the Earth Smart settings.

To change your default print driver settings, see Setting Default Printing Options for Windows on page 138.
Orientation

To select the default orientation:

1. On the Advanced tab, click Advanced Settings.
2. Click Orientation. Select an option:
   - Portrait: Orients the paper so that the text and images print across the short dimension of the paper.
   - Landscape: Orients the paper so that the text and images print across the long dimension of the paper.
   - Rotated Landscape: Orients the paper so that the content is rotated 180 degrees and with the long bottom side up.
3. Click OK.

Selecting Paper Options for Printing

There are two ways to select the paper for your print job. You can let the printer select which paper to use based on the document size, paper type, and paper color you specify. You can also select a specific tray loaded with the desired paper.

Printing Multiple Pages to a Single Sheet

When printing a multiple-page document, you can print more than one page on a single sheet of paper. Print 1, 2, 4, 6, 9, or 16 pages per side by selecting Pages Per Sheet on the Page Layout tab. Page Layout is on the Document Options tab.
Printing Booklets

With 2-sided printing, you can print a document in the form of a small booklet. Create booklets from any paper size that is supported for 2-sided printing. The driver automatically reduces each page image and prints four page images per sheet of paper, two page images on each side. The pages are printed in the correct order so that you can fold and staple the pages to create the booklet.

When you print booklets using the Windows PostScript or Macintosh driver, you can specify the gutter and creep.

- **Gutter**: Specifies the horizontal distance in points between the page images. A point is 0.35 mm (1/72 in.).
- **Creep**: Specifies how much the page images shift outward in tenths of a point. Shifting compensates for the thickness of the folded paper, which can cause the page images to shift outward slightly when folded. You can select a value from zero to 1 point.

### Gutter and Creep

![Gutter and Creep Diagram](image)

Print Quality

Print quality modes:

- **Standard print-quality mode**: 600 x 600 dpi
- **Enhanced print-quality mode**: 600 x 600 x 5 dpi (1200 x 1200 enhanced image quality)
- **Photo print-quality mode**: 600 x 600 x 5 dpi (1200 x 1200 enhanced image quality)

*Note*: The print resolutions are indicated for PostScript print drivers only. The only print quality mode for PCL is Enhanced.
Image Options

Image options controls the way the printer uses color to produce your document. The Windows PostScript and the Macintosh drivers provide the widest range of color controls and corrections on the Image Options tab.

To convert all color in the document to black and white or shades of gray, select **Xerox Black and White Conversion**.

The printer provides the following color correction options:
- **Automatic Color** applies the best color correction to text, graphics, and images. Xerox recommends this setting.
- **Vivid Color** produces brighter and more saturated colors.

Printing Watermarks

A watermark is special purpose text that can be printed across one or more pages. For example, you can add a word like Copy, Draft, or Confidential as a watermark instead of stamping it on a document before distribution.

To print a watermark:
1. Click the **Document Options** tab of the print driver.
2. From the Watermark menu, select the watermark. You can choose from preset watermarks, or create a customized watermark. You can also manage watermarks from this menu.
3. Under Text, select an option:
   - For **Text**, enter the text in the field, then specify the font and color.
   - For **Time Stamp**, specify the date and time options, then specify the font and color.
   - For **Picture**, click the Browse icon to locate the picture. Specify the scaling option that specifies the size of the picture in relation to the original image.
4. Specify the angle and position of the watermark.
5. Under **Layering**, select how to print the watermark:
   - **Print in Background** prints the watermark behind the text and graphics in the document.
   - **Blend** combines the watermark with the text and graphics in the document. A blended watermark is translucent, so you can see both the watermark and the document content.
   - **Print in Foreground** prints the watermark over the text and graphics in the document.
6. Click **Pages**, then select the pages on which to print the watermark:
   - **Print on All Pages** prints the watermark on all pages of your document.
   - **Print on Page 1 Only** prints the watermark only on the first page of the document.
7. If you selected a picture as a watermark, specify the lightness of the image.
8. Click **OK**.
Scaling

Scaling reduces or enlarges the original document to match the selected output paper size. In Windows, the Scale Options are located in the print driver on the Printing Options tab in the Paper field.

To access Scale Options, click the arrow at the right side of the Paper field, then select Other Size.

- **No Scaling** does not change the size of the page image printed on the output paper, and 100% appears in the percentage box. If the original size is larger than the output size, the page image is cropped. If the original size is smaller than the output size, extra space appears around the page image.
- **Automatically Scale** scales the document to fit the selected Output Paper Size. The scaling amount appears in the percentage box below the sample image.
- **Manually Scale** scales the document by the amount entered in the percentage box below the preview image.

Printing Mirror Images

If the PostScript driver is installed, you can print pages as a mirror image. Images mirror left to right when printed.

Selecting Job Completion Notification for Windows

You can select to be notified when your job finishes printing. A message appears on your computer screen with the name of the job and the name of the printer where it was printed.

**Note:** This feature is only available on a Windows computer printing to a network printer.

To select job completion notification from the Advanced tab:

1. Click **Notification**.
2. Click **Notify for Completed Jobs.** Select an option:
   - **Enabled**: This option turns on notifications.
   - **Disabled** turns off the Notification feature.
3. Click **OK**.
Printing

Printing Special Job Types

Special job types allow you to send a print job from your computer, then print it from the printer control panel. Select special job types in the print driver, Printing Options tab, under Job Type.

Note: The special job types are stored in memory on the printer and are removed when the printer is powered off. To store the special job types permanently, your printer needs the optional Productivity Kit installed.

Saved Job

Saved jobs are documents sent to the printer and stored there for future use. Saved Jobs appear in the Print From menu in Services Home.

To print a saved job:
1. If the control panel is dark, press the Power Saver button.
2. Touch the Print From service, then touch Saved Jobs.
3. Touch the user name or name of the folder that contains the saved job.
4. Touch the name of the saved job, touch Quantity, select the number of copies to print, then touch OK.
5. Touch Print.
6. To delete the document after printing, select Delete after printing.
7. Touch OK.

Secure Print

Secure Print allows you to associate a 1–12 digit passcode number with a print job when sending it to the printer. The job is held at the printer until the same passcode is entered at the control panel.

To release a Secure Print job for printing:
1. If the control panel is dark, press the Power Saver button.
2. At the printer control panel, press the Job Status button.
3. Touch Secure Jobs, then touch the user name or folder name for the secure job.
4. Enter the passcode number that you assigned to the print job using the keypad.
5. Touch OK.
6. Touch Quantity, enter the number of copies to print, then touch OK.
7. Touch Print.
8. To delete the document after printing, select Delete after printing.
9. Touch OK.
Printing from a USB Flash Drive

You can print a file stored on a USB Flash drive. The USB port is on the front of the printer.

To print from a USB Flash drive:
1. Insert the USB Flash Drive into the USB memory port on the printer.
2. At the USB Drive Detected screen, select Print a File.
3. Browse to a file, then touch the file name or icon.
4. Touch OK.
5. For the Output Color, 2-Sided Printing, Paper Supply, and Sides Per Page, select an option.
6. To enter the number of copies to print, use the keypad.
7. Press the green Start button.
8. To print another file from the USB Flash drive, select a file and repeat steps 4 through 7.
9. When finished, remove the USB Flash drive.

To print from a USB Flash drive that is already inserted in the printer:
1. If the USB Flash drive is already in the USB memory port, touch Print From>USB Memory.
2. Browse to a file, then touch the file name or icon.
3. Touch OK.
4. For the Output Color, 2-Sided Printing, Paper Supply, and Sides Per Page, select an option.
5. To enter the number of copies to print, use the keypad.
6. Press the green Start button.
Using Custom Paper Sizes

This section includes:

- Defining Custom Paper Sizes ........................................................................................................................................ 148
- Printing on Custom Paper Sizes ................................................................................................................................... 149

The WorkCentre 6605 Color Multifunction Printer prints on custom paper sizes that are within the minimum and maximum size range supported by the printer.

Defining Custom Paper Sizes

To print custom paper sizes, define the custom width and length of the paper in the print driver software and on the printer control panel. When setting the paper size, ensure that you specify the same size as the paper in the tray. Setting the wrong size can cause a printer error. Print driver settings override control panel settings when you print using the print driver software on your computer.

Defining a Custom Paper Size for Windows

You can save up to 20 custom paper sizes in the Windows print driver. Save each custom size with a unique name and the dimensions are retained until you change them.

1. Click the Printing Options tab of the print driver.
2. Click the arrow next to the Paper field, then select Other Size>Output Paper Size>New.
3. In the New Custom Size window, enter the height and width of the new size, then select the units.
4. Enter a title for the new size in the Name field, then click OK to save.

Defining a Custom Paper Size for Macintosh

1. In the application you are printing from, select File>Page Setup.
2. From the Format For drop-down list, select the printer.
3. From the Paper Size drop-down list, select Manage Custom Sizes.
4. In the Custom Paper Sizes window, click plus (+) to add the new custom size.
5. For the custom paper size, enter the width and height.
6. In the Non-Printable Area drop-down list, select the printer.
7. Double-click untitled, then type a name for the new custom size.
8. Click OK to close the Custom Paper Sizes window.
9. Click OK to close the Page Setup window.

The new custom size is available in the Paper Size drop-down list of the print driver and in Page Setup.

Note: To use the custom paper size, select Page Setup, and select the custom size that you created from the Paper Size drop-down list.
Printing on Custom Paper Sizes

Note: Before printing on a custom paper size, use the Custom Paper Sizes feature in printer properties to define the custom size. For details, see Defining Custom Paper Sizes on page 148.

Printing on Custom Paper Size Using Windows
1. Load the custom-size paper in the tray. For details, see Loading Paper on page 122.
2. In the application, click File>Print and select your printer.
3. In the Print dialog box, click Properties.
4. On the Printing Options tab, to select the desired custom size, use the Paper drop-down list.
   Note: If you are printing on custom size paper, define the custom size in the printer properties before printing.
5. From the Other Type drop-down list, select the paper type.
6. Select any other desired options, then click OK.
7. In the Print dialog box, click OK to start printing.

Printing on Custom Paper Size Using Macintosh
1. Load the custom-size paper. For details, see Loading Paper on page 122.
2. In the application, click Page Setup.
3. From the Paper Size drop-down list, select the custom paper size.
4. Click OK.
5. In the application, click Print.
6. Click OK.
This chapter includes:

- Making Copies ................................................................. 152
- Adjusting Copying Options ............................................. 155
- Changing the Default Copy Settings ................................ 162
- Limiting Access to Copying ............................................. 166
Making Copies

1. To clear previous control panel copy settings, press the **Clear All** button.
2. Load your original documents:
   − Use the document glass for single pages or paper that cannot be fed using the duplex automatic document feeder. Lift the duplex automatic document feeder, then place the original face down in the upper left corner of the document glass.
   − Use the duplex automatic document feeder for multiple or single pages. Remove any staples and paper clips from the pages, then place them face up in the duplex automatic document feeder. Insert originals face up with the top of the page entering the feeder first. Adjust the paper guides so they fit against the originals.
3. At the control panel, touch **Copy**.
4. Using the control panel keypad, enter the desired number of copies. The number of copies appears on the upper right corner of the display. To reset the number of copies to 1, press the **Clear All** button.
5. To select the copying option you want to change, press the arrow buttons. For details, see Adjusting Copying Options.
6. Press the **Start** button. One set of copies prints.
   If you place originals in the duplex automatic document feeder, copying continues until the duplex automatic document feeder is empty.
Duplex Automatic Document Feeder Guidelines

The duplex automatic document feeder accommodates the following originals:

- Width: 139.7–215.9 mm (5.5–8.5 in.)
- Length: 139.7–355.6 mm (5.5–14 in.)
- Weight:
  - 1-sided documents: 50–125 g/m²
  - 2-sided documents: 60–125 g/m²

Follow these guidelines when loading originals into the duplex automatic document feeder:

- Load originals face up so that the top of the document enters the feeder first.
- Place only loose sheets of paper in the duplex automatic document feeder.
- Adjust the paper guides so that they fit against the originals.
- Insert paper in the duplex automatic document feeder only when ink on the paper is dry.
- Do not load originals above the MAX fill line.

Document Glass Guidelines

The document glass accommodates original sizes up to 216 x 297 mm (8.5 x 11.7 in.). Use the document glass rather than the duplex automatic document feeder to copy or scan the following types of originals:

- Paper with paper clips or staples attached
- Paper with wrinkles, curls, folds, tears, or notches
- Coated or carbonless paper or items other than paper such as cloth or metal
- Envelopes
- Books
Copying an ID Card

You can copy both sides of an ID card or small document onto one side of paper. Each side is copied using the same location on the document glass. The printer stores both sides and prints them side by side on the paper.

To copy an ID card:
1. At the printer control panel, press the Services Home button.
2. Touch ID Card Copy.
3. For side 1, under the ID Card Copy tab, verify the output color, paper supply, lighter/darker, and auto suppression background settings. Change the settings as needed.
4. Touch the Image Quality tab.
5. Verify the sharpness and saturation settings. Change the settings as needed.
6. Lift the document cover.
7. Place the ID card, or a document smaller than half the selected paper supply size, about 6 mm (.25 in.) from the upper left corner of the document glass.
8. Press the green Start button.
9. Lift the document cover.
10. For side 2, turn the document over and position it about 6 mm (.25 in.) from the upper left corner of the document glass.
11. Press the green Start button.
12. When prompted, press Done.
13. Remove the ID card from the scanner.
Adjusting Copying Options

This section includes:
- Basic Settings ......................................................... 156
- Image-Quality Settings .......................................... 158
- Output Adjustments .............................................. 159

You can adjust numerous options for your copy jobs, specify characteristics of the original documents, and customize the output. For details, see Basic Settings on page 156.

You can also modify the default settings for many options. For details, see Selecting the Default Copy Settings on page 162.
Basic Settings

This section includes:

- Selecting a Paper Tray ..................................................................................................................................................... 156
- Selecting Color or Black and White Copies ............................................................................................................. 156
- Making the Image Lighter or Darker ......................................................................................................................... 156
- Setting 2-Sided Copying ................................................................................................................................................. 157

Selecting a Paper Tray

1. At the printer control panel, press the Services Home button.
2. Touch Copy.
4. Touch a paper tray.
5. Touch OK.

Selecting Color or Black and White Copies

If the original document contains color, you can create copies in full color or in black and white. The color mode indicators light to show the current setting.

Note: This setting returns to its default after the copy job is complete. To modify the default setting, see Changing the Default Copy Settings on page 156, on page 162.

To select color or black and white printing:
1. At the printer control panel, press the Services Home button.
2. Touch Copy.
3. Under the Copy tab, touch Output Color.
4. Select an option:
   - Full Color
   - Black & White
5. Touch OK.

Making the Image Lighter or Darker

1. At the printer control panel, press the Services Home button.
2. Touch Copy.
4. To lighten or darken the image, touch the buttons to move the slider.
5. Touch OK.
Setting 2-Sided Copying

1. At the printer control panel, press the Services Home button.
2. Touch Copy.
3. Under the Copy tab, touch 2-Sided Copying.
4. Touch one of the following:
   – 1 - 1 Sided
   – 1 - 2 Sided
   – 2 - 1 Sided
   – 2 - 2 Sided
5. To rotate the image on side 2 by 180 degrees, touch Rotate Side 2.
6. Touch OK.
Image-Quality Settings

This section includes:

- Specifying the Original Document Type
- Adjusting the Sharpness
- Changing the Saturation
- Auto Background Suppression

Specifying the Original Document Type

To specify the type of the original document:

1. At the printer control panel, press the Services Home button.
2. Touch Copy.
3. Touch the Quality tab.
4. Touch Original Type.
5. Touch one of the following:
   - Photo & Text for both photographs and text, such as magazines or newspapers. This is the default setting.
   - Text for black and white or colored text.
   - Photo for photographs.
6. Touch OK.

Adjusting the Sharpness

1. At the printer control panel, press the Services Home button.
2. Touch Copy.
3. Touch the Quality tab.
4. Touch Sharpness, then select an option.
5. Touch OK.

Changing the Saturation

1. Touch Saturation, then select an option.
2. Touch OK.
Auto Background Suppression

When copying originals printed on thin paper, text or images printed on one side of the paper can be seen on the other side. Use the Auto Background Suppression setting to reduce the sensitivity of the printer to variations in light background colors.

To adjust Auto Background Suppression:
1. At the printer control panel, press the Services Home button.
2. Touch Copy.
3. Touch the Quality tab.
4. Touch Auto Background Suppression, then select an option.
5. Touch OK.

Output Adjustments

Collating Copies

You can automatically collate multi-page copy jobs. For example, when making three 1-sided copies of a six-page document, the copies are printed in this order:

1, 2, 3, 4, 5, 6; 1, 2, 3, 4, 5, 6; 1, 2, 3, 4, 5, 6

Uncollated copies print in the following order:

1, 1, 1, 2, 2, 2, 3, 3, 3, 4, 4, 4, 5, 5, 5, 6, 6, 6

To select a collating option:
1. At the printer control panel, press the Services Home button.
2. Touch Copy.
3. Touch the Output tab.
4. Touch Collation.
5. Touch one of the following:
   - Auto turns on collation only for originals placed in the duplex automatic document feeder. Originals placed on the document glass are not collated. This is the default setting.
   - Collated turns on collation only for originals placed on the document glass.
   - Uncollated turns off collation.
6. Touch OK.
Reducing or Enlarging the Image

You can reduce the image to as little as 25% of its original size or enlarge it as much as 400%.

To reduce or enlarge the copied image:
1. At the printer control panel, press the Services Home button.
2. Touch Copy.
3. Touch the Output tab.
4. Touch Reduce/Enlarge.
5. Touch one of the following:
   – To select a preset image size, touch a button.
   – To set the copy size in increments of 1%, touch the + or - buttons or use the keypad to set the percentage. The default setting is 100%.
6. Touch OK.

Specifying the Original Size

1. At the printer control panel, press the Services Home button.
2. Touch Copy.
3. Touch the Output tab.
4. Touch Original Size.
5. Touch the document size.
6. Touch OK.

Printing Multiple Pages per Side

You can copy a single page and have it print multiple times onto one or both sides of the paper. The printer reduces the pages proportionally to fit.

To print multiple pages per side:
1. At the printer control panel, press the Services Home button.
2. Touch Copy.
3. Touch the Output tab.
4. Touch Pages Per Side.
5. Touch one of the following:
   – Off: This option copies one original image onto one side of a page. This is the default setting.
   – Auto copies two original pages, reduces the images, and prints them onto one side of a page.
   – Manual reduces the two original images as specified in Reduce/Enlarge, and prints them onto one side of a page.
6. Touch OK.
Adjusting the Edge Erase

1. At the printer control panel, press the Services Home button.
2. Touch Copy.
3. Touch the Output tab.
4. Touch Edge Erase.
5. To select the edge to erase, touch the + or - buttons.
6. Touch OK.
Changing the Default Copy Settings

This section includes:

- Changing Output Color ................................................................................................................................. 162
- Changing the Paper Tray ............................................................................................................................... 162
- Changing Collation ............................................................................................................................................... 163
- Changing Reduce/Enlarge ............................................................................................................................... 163
- Changing the Original Size .............................................................................................................................. 163
- Changing the Original Document Type ............................................................................................................. 163
- Changing Lighten/Darken ................................................................................................................................. 163
- Changing the Default for Sharpness .................................................................................................................. 163
- Changing the Saturation .................................................................................................................................... 163
- Changing Auto Background Suppression ......................................................................................................... 164
- Changing Auto Background Suppression Level .............................................................................................. 164
- Changing the Default Color Balance ............................................................................................................. 164
- Changing 2-Sided Copying ............................................................................................................................... 164
- Changing Print Multiple Pages per Side .......................................................................................................... 165
- Changing Edge Erase ....................................................................................................................................... 165

The printer uses the default copy settings on all copy jobs unless you change them for an individual job. You can modify the default copy settings.

To change the default copy settings:
1. At the printer control panel, press the Machine Status button.
2. Touch the Tools tab.
3. Touch Service Defaults.
4. Touch Copy Defaults, then touch the option you want to change.

Changing Output Color

1. Touch Output Color.
2. Select a color mode.
3. Touch OK.

Changing the Paper Tray

2. Select a paper tray.
3. Touch OK.
Changing Collation
1. Touch Collation.
2. Touch one of the following:
   - Auto turns on collation only for originals placed in the duplex automatic document feeder. Originals placed on the document glass are not collated. This is the default setting.
   - Collated turns on collation only for originals placed on the document glass.
   - Uncollated turns off collation.
3. Touch OK.

Changing Reduce/Enlarge
1. Touch Reduce/Enlarge.
2. Touch one of the following:
   - To select a default preset image size, touch a button.
   - To set the default copy size in increments of 1%, touch the + or - buttons or use the keypad to set the percentage.
3. Touch OK.

Changing the Original Size
1. Touch Original Size.
2. Touch the document size.
3. Touch OK.

Changing the Original Document Type
1. Touch Original Type.
2. Touch one of the following:
   - Photo & Text for both photographs and text, such as magazines or newspapers.
   - Text for black and white or colored text.
   - Photo for photographs.
3. Touch OK.

Changing Lighten/Darken
1. Touch Lighten/Darken.
2. To change the lighten or darken default, touch the buttons to move the slider.
3. Touch OK.

Changing the Default for Sharpness
1. Touch Sharpness, then select an option.
2. Touch OK.
Changing the Saturation
1. Touch **Saturation**, then select an option.
2. Touch **OK**.

Changing Auto Background Suppression
1. Touch **Auto Background Suppression**, then select an option.
2. Touch **OK**.

Changing Auto Background Suppression Level
1. Touch **Auto Background Suppression Level**, then select an option.
2. Touch **OK**.

Changing the Default Color Balance

The Color Balance control allows you to adjust the print color of your printer. Each of the four primary colors of red, green, blue, and gray balance, have five density settings. The density settings adjust the output based on the level of color saturation. Adjusting the setting negatively lowers the density and lightens the output. Adjusting the setting positively increases the density and darkens the output. Examples of low density areas include faces and sky.

To change the default color balance:
1. Touch **Color Balance**.
2. Touch the color you want to adjust.
3. To adjust the default density setting from -3 through +3, touch - or +.
4. Touch **OK**.

Changing 2-Sided Copying
1. Touch **2-Sided Copying**.
2. Touch one of the following:
   - **1 · 1 Sided**
   - **1 · 2 Sided**
   - **2 · 1 Sided**
   - **2 · 2 Sided**
3. To rotate the image on side 2 by 180 degrees, touch **Rotate Side 2**.
4. Touch **OK**.
Changing Print Multiple Pages per Side

1. Touch Pages Per Side.
2. Touch one of the following:
   - Off copies one original image onto one side of a page.
   - Auto copies two original pages, reduces the images, and prints them onto one side of a page.
   - Manual reduces the two original images as specified in Reduce/Enlarge, and prints them onto one side of a page.
3. Touch OK.

Changing Edge Erase

1. Touch Edge Erase.
2. To set the edge erase default, touch the + or - buttons.
3. Touch OK.
Limiting Access to Copying

The Copy Lock options limit access to copying by requiring a password to use the Copy function or to make color copies. You can also turn off copying.

To set the copy lock:
1. At the printer control panel, press the **Machine Status** button.
2. Touch the **Tools** tab.
3. Touch **Admin Settings**.
4. If prompted, enter the four-digit password, then touch **OK**.
5. Touch **Secure Settings**.
6. Touch **Service Lock**.
   
   **Note:** Enable Panel Lock before setting the service locks. For more information, see Configuring Secure Settings.
7. Touch a copy, email, fax, or scan option.
8. Touch an option:
   – **Enabled** turns off the service lock.
   – **Password Locked** requires a password to use the copy function. Enter a new password, then touch **OK**.
   – **Disabled** turns on the service lock, and turns off the copy function.
9. If prompted, enter the four-digit PIN, then touch **OK**.
10. Touch **OK**.
Scanning

This chapter includes:

- Loading Documents for Scanning ................................................................. 168
- Scanning to a USB Flash Drive ................................................................. 170
- Scanning to a Folder on a USB Connected Computer ...................................... 171
- Scanning to a PC from the Printer ............................................................. 172
- Scanning to a User Home Folder ............................................................... 173
- Scanning to a Shared Folder on a Network Computer ............................... 174
- Scanning to an Email Address ................................................................. 177
- Scanning to Web Services on Devices ....................................................... 178
- Scanning Images into an Application on a USB Connected Computer ........... 179
- Adjusting Scanning Settings ...................................................................... 181
- Changing the Default Scan Settings ......................................................... 184
- Limiting Access to Scanning ..................................................................... 187

See also:
Installation and Setup Overview on page 36
Loading Documents for Scanning

Position the original document as shown.

Document Glass
Lift the duplex automatic document feeder, then place the original face down in the upper left corner of the document glass.

Duplex Automatic Document Feeder
Insert originals face up with the top of the page entering the feeder first. Adjust the paper guides so they fit against the originals.

Duplex Automatic Document Feeder Guidelines
The duplex automatic document feeder accommodates the following originals:

- Width: 139.7–215.9 mm (5.5–8.5 in.)
- Length: 139.7–355.6 mm (5.5–14 in.)
- Weight:
  - 1-sided documents: 50–125 g/m²
  - 2-sided documents: 60–125 g/m²

Follow these guidelines when loading originals into the duplex automatic document feeder:

- Load originals face up so that the top of the document enters the feeder first.
- Place only loose sheets of paper in the duplex automatic document feeder.
- Adjust the paper guides so that they fit against the originals.
- Insert paper in the duplex automatic document feeder only when ink on the paper is dry.
- Do not load originals above the MAX fill line.
Document Glass Guidelines

The document glass accommodates original sizes up to 216 x 297 mm (8.5 x 11.7 in.). Use the document glass rather than the duplex automatic document feeder to copy or scan the following types of originals:

- Paper with paper clips or staples attached
- Paper with wrinkles, curls, folds, tears, or notches
- Coated or carbonless paper or items other than paper such as cloth or metal
- Envelopes
- Books
**Scanning to a USB Flash Drive**

You can scan a document and store the scanned file on a USB Flash drive. The Scan to USB function produces scans in .jpg, .pdf, and .tiff file formats.

*Note:* Before pressing the Scan button or inserting the USB Flash drive, press the Power Saver button, then wait until the Power Saver indicator turns off.

To scan to a USB Flash drive:

1. Load the original on the document glass or in the duplex automatic document feeder.
2. Insert your USB Flash drive in the USB Port on the front of the printer. The touch screen displays the Scan to USB Memory tab.
3. To save the scanned file to a specific folder on the USB Flash drive, touch Change Folder.
4. To change scan settings, touch the appropriate buttons. For details, see Adjusting Scanning Settings on page 181.
5. To change folder and file options, touch Options.
6. To create a folder for the scanned file, touch Create Folder>On>OK.
7. To add a prefix or suffix to the file title, touch File Name.
   - To have the printer name the file automatically, touch Auto.
   - To add a prefix to the file name, touch Prefix, touch Enter Text, type the prefix name, then touch OK.
   - To add a suffix to the file name, touch Suffix, touch Enter Text, type the suffix name, then touch OK.
8. To begin the scan, press Start. The printer scans your images to the folder you specified.
9. If you are scanning from the document glass, when prompted, touch Done to finish or Start to scan another page.

⚠️ **WARNING:** Do not remove the USB Flash drive until prompted. If you remove the Flash drive before the transfer is complete, the file will be unusable and other files on the drive may be damaged.
Scanning to a Folder on a USB Connected Computer

1. Start Express Scan Manager:
   – Windows: Click Start>Programs>Xerox Office Printing. Select your printer from the list. Double-click Express Scan Manager.
   – Macintosh: Navigate to Applications>Xerox. Select your printer from the list. Double-click Express Scan Manager.
2. To accept the default Destination Path folder, click OK to accept the default Destination Path folder, or to navigate to another folder, click Browse.
3. Click OK.
4. Load the original on the document glass or in the duplex automatic document feeder.
5. On the printer control panel, touch Scan to.
6. Touch PC.
7. Change scan settings as needed.
8. To begin the scan, press the Start button.
   An Express Scan Manager dialog box opens on your computer to indicate the progress. The printer scans your documents to the output destination specified in Express Scan Manager.
Scanning to a PC from the Printer

1. Load the original on the document glass or in the duplex automatic document feeder.
2. On the printer control panel, touch Scan to.
3. Touch Network.
4. Touch OK.
5. To change scan settings, touch the appropriate buttons. For details, see Adjusting Scanning Settings on page 181.
6. To change folder and file options, touch Options.
7. To add a prefix or suffix to the file title, touch File Name.
   - To have the printer name the file automatically, touch Auto.
   - To add a prefix to the file name, touch Prefix, touch Enter Text, type the prefix name, then touch OK.
   - To add a suffix to the file name, touch Suffix, touch Enter Text, type the suffix name, then touch OK.
8. To begin the scan, press Start. The printer scans your image to the folder you specified.
9. If you are scanning from the document glass, when prompted, touch Done to finish or Start to scan another page.
Scanning to a User Home Folder

Scan to Home allows you to scan documents that are saved to a home directory on an external server. The home directory is distinct for each authenticated user. The directory path is established through LDAP.

Before You Begin

To scan to the home folder defined in an LDAP directory, first ensure that the home folder locations are defined for each user.

If you want to scan to a shared folder on the network, create a shared folder on your network with read and write access privileges.

Scanning to a Home Directory

Note: If LDAP Network Authentication is configured, Home appears as an option on the Scan To screen.

1. Load the original on the document glass or in the duplex automatic document feeder.
2. On the printer control panel, touch Scan to.
3. Touch Home.
4. Enter User Name and Password, then click OK.
5. To begin the scan, press Start.
Scanning to a Shared Folder on a Network Computer

This section includes:

- Sharing a Folder on a Windows Computer ............................................................................................................. 174
- Sharing a Folder Using Macintosh OS X Version 10.5 and Later ....................................................................... 175
- Adding a Folder as an Address Book Entry Using CentreWare Internet Services .............................................. 175
- Adding a Folder as an Address Book Entry Using the Address Book Editor .............................................. 176
- Scanning to a Folder on a Network Computer ...................................................................................................... 176

Before using the printer as a scanner on a network, you must:

1. Create a shared folder on your computer hard drive.
2. Create an address using CentreWare Internet Services or the Address Book Editor pointing the scanner to the computer.

   Note: For more information, see Connecting the Printer on page 38.

Sharing a Folder on a Windows Computer

1. Open Windows Explorer.
2. Right-click the folder you want to share, then select Properties.
3. Click the Sharing tab, then click Advanced Sharing.
4. Select Share this folder.
5. Click Permissions.
6. Select the Everyone group, and verify that all permissions are enabled.
7. Click OK.

   Note: Remember the Share name for later use.
8. Click OK again.
9. Click Close.
Sharing a Folder Using Macintosh OS X Version 10.5 and Later

1. From the Apple menu, select **System Preferences**.
2. From the View menu, select **Sharing**.
3. From the Services list, select **File Sharing**.
4. Click the plus icon (+) below the Shared Folders field. A folder list appears.
5. Select the folder you want to share on the network, then click **Add**.
6. From the Users list, click **Everyone**.
7. From the list to the right of the Users window, use the arrow buttons to set user privileges to **Read & Write**.
8. Click the **Options** button.
9. To share this folder with Windows computers, select **Share files and folders using SMB**.
10. Select the **On** check box to the left of File Sharing in the Service pane.

   The folder and its contents are shared with network users.
11. Close the System Preferences window.

   **Note:** When you open a shared folder, a Shared Folder banner appears in the Finder for the folder and its subfolders.

Adding a Folder as an Address Book Entry Using CentreWare Internet Services

1. At your computer, open a Web browser, in the address field, type the IP address of the printer, then press **Enter** or **Return**.

   **Note:** If you do not know the IP address of your printer, see Finding the IP Address of Your Printer on page 30.
2. Click **Address Book**.
3. Under Network Scan (Comp./Serv.), click **Computer/Server Address Book**.
4. Next to any empty field, click **Add**, then enter the following information:
   - **Name:** Enter the name that you want to appear in the Address Book.
   - **Server Type:** Select **Computer (SMB)**.
   - **Host Address:** Enter the IP address of your computer.
   - **Port Number:** Enter the default port number for SMB, 139, or select a number from the range provided.
   - **Login Name:** Enter your computer user name.
   - **Login Password:** Enter your computer login password.
   - **Re-enter Password:** Enter your login password again.
   - **Name of Shared Directory:** Enter a name for the directory or folder. For example, if you want the scanned files to go in a folder named scans, type **scans**.
   - **Subdirectory Path:** Enter the path of the folder on the SMB server. For example, if you want the scanned files to go in a folder named **colorscans** inside the **scans** folder, type **\colorscans**.
5. Click **Save Changes**.
Adding a Folder as an Address Book Entry Using the Address Book Editor

1. On your computer, select Start > All Programs > Xerox Office Printing > WorkCentre 6605.
2. In the left navigation pane, under Printer Address Book, click Server.
3. For Name, enter the name of the shared file on your computer.
4. For Server Type, select Computer (SMB).
5. Click Computer Settings Wizard, then click Browse.
6. Navigate to a shared folder on your computer.
7. Click OK, then click Next.
8. To give the printer access to the shared folder, enter a login name and password.
9. Click Next, then click Finish.
10. Click OK.
   The new entry appears in the Server pane.
11. Click Save All.

Scanning to a Folder on a Network Computer

1. Load the original on the document glass or in the duplex automatic document feeder.
2. On the printer control panel, touch Scan to.
3. Touch Network.
4. Touch the address book entry.
5. Touch OK.
6. To change scan settings, touch the appropriate buttons. For details, see Adjusting Scanning Settings on page 181.
7. To change folder and file options, touch Options.
8. To create a folder for the scanned file, touch Create Folder > On > OK.
9. To add a prefix or suffix to the file title, touch File Name.
   – To have the printer name the file automatically, touch Auto.
   – To add a prefix to the file name, touch Prefix, touch Enter Text, type the prefix name, then touch OK.
   – To add a suffix to the file name, touch Suffix, touch Enter Text, type the suffix name, then touch OK.
10. To begin the scan, press Start. The printer scans your image to the folder you specified.
11. If you are scanning from the document glass, when prompted, touch Done to finish or Start to scan another page.
Scanning to an Email Address

Before scanning to an email address, you must set up the printer up with the email server information. For details, see Setting Up Scanning to an Email Address on page 81.

To scan an image and send it to an email address:
1. Load the original on the document glass or in the duplex automatic document feeder.
2. At the control panel, touch Printer.
3. Specify the method for selecting recipients:
   - New Recipient allows you to enter the email address manually. Use the keypad to enter the address.
   - Address Book allows you to select an email address or a distribution list from the Address Book.
4. Touch OK.
5. To change scan settings, touch the appropriate buttons. For details, see Adjusting Scanning Settings on page 181.
6. To change folder and file options, touch Options.
7. To add a prefix or suffix to the file title, touch File Name.
   - To have the printer name the file automatically, touch Auto.
   - To add a prefix to the file name, touch Prefix, touch Enter Text, type the prefix name, then touch OK.
   - To add a suffix to the file name, touch Suffix, touch Enter Text, type the suffix name, then touch OK.
8. To begin the scan, press Start.
   If you are scanning from the document glass, when prompted, touch Done to finish or Start to scan another page.
Scanning to Web Services on Devices

Web Services on Devices (WSD) connect your computer to the printer. Use WSD to access scanned images at your computer.

Note: See Installing the Printer as a Web Service on Devices.

To scan to WSD:
1. Load the original on the document glass or in the duplex automatic document feeder.
2. On the printer control panel, touch **Scan to**.
3. Touch **WSD**.
4. To select a destination, touch the computer address.
5. To select the scan type, touch the **Event** field, then touch the scan type.
6. To begin the scan, press **Start**.
7. At the computer WSD Scan Device message, select a program to complete the scan.
Scanning Images into an Application on a USB Connected Computer

This section includes:

- Scanning an Image into an Application ................................................................. 179
- Scanning an Image Using Windows XP ................................................................. 179
- Scanning an Image Using Windows Vista or Windows 7 ......................................... 180

You can import images directly from the scanner into a folder on your computer. With a Macintosh computer, and some Windows applications, you can import the images directly into an application.

Scanning an Image into an Application

Note: Some Windows applications, including Office 2007, do not support this feature.

1. Open the file in which you want to place the image.
2. In the application, select the menu item to acquire the image.
3. From the Paper Source menu in Windows, or from the Scan From menu on a Macintosh computer, select one of the following:
   - Document Glass
   - Duplex Automatic Document Feeder
4. Specify the other scan driver settings as desired.
   Note: For more information, click the Help (?) button to view the online help.
5. To begin the scan, press the Start button.
   The printer scans the document and places the image in your application.

Scanning an Image Using Windows XP

1. On your computer, select Start>Control Panel.
2. Double-click Scanners and Cameras.
3. Double-click Xerox WC6605.
4. Select an option:
   - Color picture
   - Grayscale picture
   - Black and white picture or text
   - Custom
5. Select the paper source:
   - Document Glass
   - Duplex Automatic Document Feeder
Scanning

6. To preview the document or select a portion of the document to scan, select **Preview**. The printer scans a preview copy of the image.
7. To select a portion of the document to scan, use the corner points to resize the frame.
8. Click **Next**.
9. Type a name for this group of pictures.
10. Select a file format:
    - BMP
    - TIF
    - JPG
    - PNG
11. Type in a path name or browse to a location for the scanned images.
12. To save the image to the folder, select **Nothing**.
13. Click **Next**.
14. To view the scanned image, click the folder link in the window.
15. Click **Finish**.
    The image is stored in the folder and ready for use in your applications.

**Scanning an Image Using Windows Vista or Windows 7**

1. On your computer, select **Start**>**All Programs**>**Windows Fax and Scan**.
2. Click **New Scan**.
3. If prompted, select **Xerox WC6605**, then click **OK**.
4. Select the scan settings.
5. To preview the document or select a portion of the document to scan, select **Preview**. The printer scans a preview copy of the image.
6. To select part of the document, clear **Preview or scan images as separate files**, then use the corner points to resize the frame.
7. Click **Scan**.
    The scanned image is stored in the default Scanned Documents folder or in a folder that you selected.
Adjusting Scanning Settings

This section includes:

- Setting the Output Color ................................................................. 181
- Setting the Scan Resolution ............................................................ 182
- Selecting 2-Sided Scanning .............................................................. 182
- Setting the File Format ................................................................. 182
- Making the Image Lighter or Darker ............................................. 182
- Adjusting the Sharpness ................................................................. 183
- Adjusting the Contrast ................................................................. 183
- Specifying the Original Size .......................................................... 183
- Erasing Edges .............................................................................. 183

You can modify the scan settings for individual jobs, once you select the scan mode.

You can also change the default values of some settings. For details, see Changing the Default Scan Settings.

Setting the Output Color

If the original image contains color, you can scan the image in color or in black and white. Selecting black and white significantly reduces the file size of the scanned images.

To set the output color:

1. At the printer control panel, press the Services Home button.
2. Touch Scan To, then select an option.
3. Under the Scan to PC tab, touch Output Color.
4. Select a color mode.
5. Touch OK.
Setting the Scan Resolution

The scan resolution depends on how you plan to use the scanned image. Scan resolution affects both the size and image quality of the scanned image file. Higher scan resolution produces better image quality and a larger file size.

To set the scan resolution:
1. At the printer control panel, press the Services Home button.
2. Touch Scan To, then select an option.
3. Under the Scan to PC tab, touch Resolution.
4. Select an option.
5. Touch OK.

Selecting 2-Sided Scanning

2-Sided Scanning scans both sides of the original image.

To set 2-sided scanning:
1. At the printer control panel, press the Services Home button.
2. Touch Scan To, then select an option.
3. Under the Scan to PC tab, touch 2-Sided Scanning.
4. Touch 2-Sided.
5. To rotate the image on side 2 by 180 degrees, touch Rotate Side 2.
6. Touch OK.

Setting the File Format

1. At the printer control panel, press the Services Home button.
2. Touch Scan To, then select an option.
3. Under the Scan to PC tab, touch File Format.
4. Touch a setting.
5. Touch OK.

Making the Image Lighter or Darker

1. At the printer control panel, press the Services Home button.
2. Touch Scan To, then select an option.
3. Touch the Quality tab.
4. Touch Lighten/Darken.
5. To lighten or darken the image, touch the buttons to move the slider.
6. Touch OK.
Adjusting the Sharpness
1. At the printer control panel, press the Services Home button.
2. Touch Scan To, then select an option.
3. Touch the Quality tab.
4. Touch Sharpness, then select an option.
5. Touch OK.

Adjusting the Contrast
1. At the printer control panel, press the Services Home button.
2. Touch Scan To, then select an option.
3. Touch the Quality tab.
4. Touch Contrast, then select an option.
5. Touch OK.

Specifying the Original Size
1. At the printer control panel, press the Services Home button.
2. Touch Scan To, then select an option.
3. Touch the Options tab.
4. Touch Original Size, then select a document size.
5. Touch OK.

Erasing Edges
You can specify an amount of space to erase from the edges of your scans.

To use Erasing Edges:
1. At the printer control panel, press the Services Home button.
2. Touch Scan To, then select an option.
3. Touch the Options tab.
4. Touch Edge Erase, then touch the + or - buttons.
5. Touch OK.
Changing the Default Scan Settings

This section includes:

- Changing the Default for File Format ....................................................................................................................... 184
- Changing Output Color ................................................................................................................................................. 184
- Changing the Default Scan Resolution ....................................................................................................................... 185
- Changing the Original Size ......................................................................................................................................... 185
- Changing the Default for 2-Sided Scanning .............................................................................................................. 185
- Changing Lighten/Darken ............................................................................................................................................. 185
- Changing the Default for Sharpness ........................................................................................................................... 185
- Changing the Default for Contrast ............................................................................................................................. 185
- Changing Auto Background Suppression .................................................................................................................. 185
- Changing Auto Background Suppression Level ....................................................................................................... 186
- Changing Edge Erase ...................................................................................................................................................... 186
- Changing the Default for TIFF File Format .............................................................................................................. 186
- Changing the Default for Quality/File Size .............................................................................................................. 186
- Changing the Default for Maximum Email Size ....................................................................................................... 186

The printer uses the default scan settings on all scan jobs unless you change them for an individual job. You can modify the default scan settings.

To change the default scan settings:
1. At the printer control panel, press the **Machine Status** button.
2. Touch **Tools**.
3. Touch **Service Defaults**.
4. Touch **Scan Defaults**.
5. Navigate to the option that you want to modify.

### Changing the Default for File Format

1. Touch **File Format**.
2. Touch a default setting.
3. Touch **OK**.

### Changing Output Color

1. Touch **Output Color**, then select an option.
2. Touch **OK**.
Changing the Default Scan Resolution

The scan resolution depends on how you plan to use the scanned image. Scan resolution affects both the size and image quality of the scanned image file. Higher scan resolution produces better image quality and a larger file size.

To set the default scan resolution:
1. Touch Resolution.
2. Touch a default scan resolution.
3. Touch OK.

Changing the Original Size

1. Touch Original Size.
2. Touch the document size.
3. Touch OK.

Changing the Default for 2-Sided Scanning

1. Touch 2-Sided Scanning.
2. Touch to print 1-sided or 2-sided copies by default.
3. If you touch 2-Sided, to rotate the image on side 2 by 180 degrees, touch Rotate Side 2.
4. Touch OK.

Changing Lighten/Darken

1. Touch Lighten/Darken.
2. To change the lighten or darken default, touch the buttons to move the slider.
3. Touch OK.

Changing the Default for Sharpness

1. Touch Sharpness, then select an option.
2. Touch OK.

Changing the Default for Contrast

1. Touch Contrast, then select an option.
2. Touch OK.

Changing Auto Background Suppression

1. Touch Auto Background Suppression, then select an option.
2. Touch OK.
Changing Auto Background Suppression Level

1. Touch Auto Background Suppression Level, then select an option.
2. Touch OK.

Changing Edge Erase

1. Touch Edge Erase.
2. To set the edge erase default, touch the + or - buttons.
3. Touch OK.

Changing the Default for TIFF File Format

Note: TIFF files created by this printer can fail to open properly in some computer applications.

1. Touch TIFF File Format, then select an option.
2. Touch OK.

Changing the Default for Quality/File Size

1. Touch Quality/File Size, then select an option.
2. Touch OK.

Changing the Default for Maximum Email Size

1. Touch Max Email Size.
2. To set a size from 50–16384 KB, touch the arrow buttons or the alphanumeric keypad.
3. Touch OK.
Limiting Access to Scanning

The Scan Lock options limit access to scanning by requiring a password to use the Scan function. You can also turn off scanning.

To set the Scan Lock:
1. At the printer control panel, press the **Machine Status** button.
2. Touch **Tools > Admin Settings**.
3. If prompted, enter the four-digit password, then touch **OK**.
4. Touch **Secure Settings**.
   
   **Note:** Panel Lock must be enabled before setting the service locks. For details, see Managing Panel Lock on page 95.

5. Touch **Service Lock**.
6. To limit access to a type of scanning, touch a scanning option.
7. To specify the kind of limit you want to place on the scanning type, touch an option:
   - **Enabled**: Turns on scanning and turns off the service lock.
   - **Password Locked**: Requires a password to use scanning. Enter a new password, then touch **OK**.
   - **Disabled**: Turns off scanning and removes the Scan To button from the printer control panel.
8. Touch **OK**.
This chapter includes:

- Configuring the Printer for Faxing ................................................................. 190
- Loading Documents for Faxing ...................................................................... 191
- Sending a Fax from the Printer ....................................................................... 192
- Sending a Delayed Fax .................................................................................... 193
- Sending a Cover Page with a Fax..................................................................... 194
- Sending a Fax From Your Computer ................................................................. 195
- Printing a Secure Fax ...................................................................................... 197
- Polling a Remote Fax Machine ................................................................. 198
- Manually Sending, Receiving, or Polling Using OnHook .......................... 199
- Editing the Fax Address Book ......................................................................... 200
Configuring the Printer for Faxing

Before you use the fax, you must configure the Fax Settings to make it compatible with your local connection and regulations. The Fax Settings include optional features you can use to configure the printer for faxing.

For details on Fax Settings and Fax Default Settings, see Configuring Fax Defaults and Settings on page 70.
Loading Documents for Faxing

Position the original document as shown.

**Document Glass**
Lift the duplex automatic document feeder, then place the original face down in the upper left corner of the document glass.

**Duplex Automatic Document Feeder**
Insert originals face up with the top of the page entering the feeder first. Adjust the paper guides so they fit against the originals.

*Note: For details, see Duplex Automatic Document Feeder Guidelines on page 153.*
Sending a Fax from the Printer

1. At the printer control panel, press the Services Home button.
2. Touch Fax.
3. Adjust fax settings as needed.
   - To adjust brightness, touch Lighten/Darken, then adjust as needed. Darken light originals such as pencil images, and lighten dark images such as halftone images from newspapers or magazines.
   - To set the scan resolution, touch Resolution, then select an option.
   - To scan both sides of your original document, touch 2-Sided Scanning, then touch 2-Sided.
4. Enter a recipient fax number manually, or select an individual or group from the fax address book.
   - Enter a fax number manually using the keypad. Press the Redial/Pause button, represented by a hyphen, to insert a pause as needed. Press the Redial/Pause button multiple times to add additional pauses.
   - To add a number from the fax address book, touch the address book icon and touch Device Address Book Individuals, or Device Address Book Groups. Select the individual or group from the list, then touch OK.
   - To add numbers using Speed Dial, touch the orange telephone icon. Enter the speed dial number that is associated with the contact in the address book, then touch OK.
   Note: You can add only one fax number manually. To send to multiple fax numbers, add speed dial numbers or individuals or groups from the fax address book.
5. Press the green Start button.
   Note: You can configure the printer to print a confirmation report after it transmits a fax. For details, see Configuring Fax Defaults and Settings on page 70.
Sending a Delayed Fax

1. At the printer control panel, press the Services Home button.
2. Touch Fax. Add fax recipients and select fax settings as needed.
3. Touch Options.
4. Touch Delayed Send.
5. Touch On.
6. Touch Hours or Minutes, then use the keypad to enter the number of hours or minutes that the printer waits until sending the fax.
7. Touch OK.
8. Press the green Start button.
   The fax is scanned and saved, and sent at the time you specified.
Sending a Cover Page with a Fax

You can send a cover sheet with your fax. The cover sheet lists recipient information from the fax address book, and sender information from the Company Name Fax Line setting. For details, see Configuring Fax Defaults and Settings on page 70.

1. At the printer control panel, press the Services Home button.
2. Touch Fax. Add fax recipients and select fax settings as needed.
3. Touch Options.
5. Touch On.
6. Touch OK.
7. Press the green Start button.
Sending a Fax From Your Computer

This section includes:

- Sending a Fax Using Windows Applications ................................................................. 195
- Sending a Fax Using Macintosh Applications .................................................................. 196

You can send a fax to the printer from an application on your computer.

Sending a Fax Using Windows Applications

You can send a fax from many Windows applications by using the PCL 6 driver. The Fax window allows you to enter recipients, create a cover page with notes, and set options. You can set confirmation sheet, send speed, resolution, send time, and dialing options.

1. With the desired document or graphic open in your application, open the Print dialog box. For most software applications, click File > Print or press CTRL+P.
2. Select your printer, then click Properties to open the print driver dialog box.
3. On the Printing Options tab, from the Job Type list, select Fax.
4. Click Recipients.
5. Do one or more of the following:
   - Click the Phonebook button, select a phone book from the list, select a name from the upper list, then add it to the Fax Recipients. Repeat the procedure to add more names. Click OK.
   - Click the Add Recipients button, type the recipient name and fax number, add other information, then click OK. Add new recipients as needed.
6. To include a cover sheet, click Cover Sheet, then from the Cover Sheet Options list, select Print a Cover Sheet.
7. On the Cover Sheet information tab, type notes that you want to appear on the cover sheet.
8. On the Options tab, select the options for the fax.
9. Click OK.
10. In the Printer Properties window, click OK.
11. In the Print window, click OK.
Sending a Fax Using Macintosh Applications

You can send a fax from many Macintosh applications by using the fax driver. To install the fax driver, see Installing the Software on page 109.

1. Access the print settings in your software application. For most software applications, press CMD+P.
2. Select your LAN fax printer from the list.
3. To access the fax driver settings, select Fax Setting. The title of the button can vary depending on your application.
4. Modify fax settings as needed. For more information, click the Help (?) button.
5. Click Print.
6. Do one or more of the following:
   - Enter the recipient name and fax number, then click Add.
   - Click Look Up Address Book, select recipients from the local Address Book, or click Look Up Device Address Book and select recipients, then click Add.
7. Click OK.
8. To delay sending the fax, select Delayed Send, then enter the time that you want the fax to send.
9. Click Start Sending.
Printing a Secure Fax

When the Secure Receive setting is enabled, you must enter a password before faxes can be printed.

**Note:** Before you can receive a Secure Fax, enable Panel Lock and Secure Fax features. For details, see Configuring Fax Defaults and Settings on page 70.

1. At the printer control panel, press the **Job Status** button.
2. Touch **Secure Fax Receive**.
3. Enter the passcode.
4. Touch **OK**.
Polling a Remote Fax Machine

Fax Polling allows the printer to retrieve a fax stored on another fax machine that supports fax polling.

To retrieve a fax from another fax machine:
1. At the printer control panel, press the Services Home button.
2. Touch Fax. Enter the fax number of the fax machine that you want to poll.
3. Touch Options.
4. Touch Polling Receive.
5. Touch On.
6. Touch OK.
7. Press the green Start button.
Manually Sending, Receiving, or Polling Using OnHook

OnHook temporarily allows you to send, receive, or poll faxes manually. OnHook also turns on the fax modem speaker temporarily so you can hear the fax transmission sounds. This feature is helpful when dialing internationally, or when using phone systems that require you to wait for a specific audio tone.

Manually Sending, Receiving, or Polling Using OnHook

1. At the printer control panel, press the Services Home button.
2. Touch Fax.
3. Touch OnHook.
4. Touch Mode.
6. Enter a recipient fax number manually, enter a speed dial number, or select an individual or group from the fax address book.
   - Enter a fax number manually using the keypad. Press the Redial/Pause button, represented by a hyphen, to insert a pause as needed. Press the Redial/Pause button multiple times to add additional pauses.
   - To add a number from the fax address book, touch the address book icon and touch Device Address Book Individuals, or Device Address Book Groups. Select the individual or group from the list, then touch OK.
   - To add numbers using Speed Dial, touch the orange telephone icon. Enter the speed dial number that is associated with the contact in the address book, then touch OK.

Note: You can add only one fax number manually. To send to multiple fax numbers, add speed dial numbers or individuals or groups from the fax address book.
7. Press the green Start button.
Editing the Fax Address Book

This section includes:
- Adding or Editing Contacts in the Fax Address Book in CentreWare Internet Services ...................... 200
- Adding or Editing Groups in the Fax Address Book in CentreWare Internet Services .......................... 200
- Adding or Editing Contacts in the Fax Address Book at the Control Panel ............................................... 201
- Adding or Editing Groups in the Fax Address Book at the Control Panel .................................................. 201
- Using the Address Book Editor Utility ........................................................................................................ 201

You can create and save fax information for individual contacts or groups. Each contact is associated with a speed dial number. You can manage address book contacts in CentreWare Internet Services, at the control panel, or using the Address Book Editor utility.

Adding or Editing Contacts in the Fax Address Book in CentreWare Internet Services

1. At your computer, open a Web browser, in the address field, type the IP address of the printer, then press Enter or Return.
2. In CentreWare Internet Services, click Address Book.
3. Under Fax, click Fax Address Book.
4. To add or edit a contact, next to the contact, click Add or Edit.
5. Type a name and fax number for the contact. Use a - character to indicate a dialing pause.
6. Click Save Changes.

Adding or Editing Groups in the Fax Address Book in CentreWare Internet Services

1. At your computer, open a Web browser, in the address field, type the IP address of the printer, then press Enter or Return.
2. In CentreWare Internet Services, click Address Book.
3. Under Fax, click Fax Groups.
4. To add or edit a group, next to the group, click Add or Edit.
5. Type a name for the group, then select the contacts that you want to add to the group.
6. Click Save Changes.
Adding or Editing Contacts in the Fax Address Book at the Control Panel

1. At the printer control panel, press the Machine Status button.
2. Touch Tools>Admin Settings>Fax Address Book>Individuals.
3. To add a contact, touch an unused contact, then touch Edit. To edit a contact, touch an existing contact, then touch Edit.
4. Touch Name, type a name, then touch OK.
5. Touch Fax Number, use the keypad to type a fax number, then touch OK. To insert a pause, press the Redial/Pause button (-).
6. Touch OK.

Adding or Editing Groups in the Fax Address Book at the Control Panel

1. At the printer control panel, press the Machine Status button.
2. Touch Tools>Admin Settings>Fax Address Book>Groups.
3. Touch an unused group in the list, or touch a group, then touch Edit.
4. Touch Enter Group Name, type a name for the group, then touch OK.
5. To add contacts to the group, touch Add from Address Book.
6. Touch the contacts you want to add to the group, then touch OK.
7. Touch OK.

Using the Address Book Editor Utility

The Address Book Editor utility allows you to manage address book contacts at your computer.

To access the Address Book Editor utility:

- For Windows computers, select Start>Programs>Xerox>WorkCentre 6605>Address Book Editor.
- For Macintosh computers, navigate to Applications>Xerox>WorkCentre 6605, then open Address Book Editor.
This chapter includes:

- Cleaning the Printer ................................................................. 204
- Adjustments and Maintenance Procedures ....................... 219
- Ordering Supplies ..................................................................... 228
- Managing the Printer .............................................................. 231
- Moving the Printer ................................................................. 232
Cleaning the Printer

This section includes:
- General Precautions .......................................................................................................................................................... 204
- Cleaning the Exterior ........................................................................................................................................................ 205
- Cleaning the Scanner ....................................................................................................................................................... 205
- Cleaning the Interior ........................................................................................................................................................ 208

General Precautions

⚠️ CAUTION: When cleaning your printer do not use organic or strong chemical solvents or aerosol cleaners. Do not pour fluids directly into any area. Use supplies and cleaning materials only as directed in this documentation.

⚠️ WARNING: Keep all cleaning materials out of the reach of children.

⚠️ WARNING: Do not use pressurized spray cleaning aids on or in the printer. Some pressurized sprays contain explosive mixtures and are not suitable for use in electrical applications. Use of pressurized spray cleaners increases the risk of fire and explosion.

⚠️ WARNING: Do not remove the covers or guards that are fastened with screws. You cannot maintain or service any parts that are behind these covers and guards. Do not attempt any maintenance procedure that is not described in the documentation supplied with your printer.

⚠️ WARNING: Internal parts of the printer can be hot. Use caution when doors and covers are open.

- Do not place anything on top of the printer.
- Do not leave the covers and doors open for any length of time, especially in well-lit places. Light exposure can damage the imaging units.
- Do not open covers and doors during printing.
- Do not tilt the printer while it is in use.
- Do not touch the electrical contacts or gears. Doing so could damage the printer and cause the print quality to deteriorate.
- Ensure any parts removed during cleaning are replaced before you plug in the printer.
Cleaning the Exterior

Clean the exterior of the printer once a month.

• Wipe the paper tray, output tray, control panel, and other parts with a damp, soft cloth.
• After cleaning, wipe with a dry, soft cloth.
• For stubborn stains, apply a small amount of mild detergent to the cloth and gently wipe the stain off.

⚠️ CAUTION: Do not spray detergent directly on the printer. Liquid detergent could enter the printer through a gap and cause problems. Never use cleaning agents other than water or mild detergent.

Cleaning the Scanner

Clean the scanner about once a month, when anything is spilled on it, or when debris or dust collect on any of the surfaces. Keep the feed rollers clean to ensure the best possible copies and scans.

Cleaning the Scanner

1. Slightly dampen a soft, lint-free cloth with water.
2. To gain better access to the output tray, push the Control Panel Latch Release, then lift the control panel up.
3. Remove any paper or other media from the output tray.
4. Wipe the area under the scanner until it is clean.
5. Open the document cover.

6. Wipe the surface of the document glass until it is clean and dry.
   
   **Note:** For best results, use Xerox® Glass Cleaner to remove marks and streaks.

7. Wipe the white underside of the document cover until it is clean and dry.
8. Close the document cover.
9. Open the duplex automatic document feeder cover.

10. With a dry, soft lint-free cloth or paper towel, wipe the duplex automatic document feeder feed roller until it is clean.

Cleaning the Feed Rollers on the Duplex Automatic Document Feeder

1. Open the duplex automatic document feeder top cover.

2. Wipe the feed rollers with a dry soft lint-free cloth or paper towel until they are clean.

Note: If the duplex automatic document feeder rollers get stained with toner or debris, they can cause stains on the documents. To remove the stains, use a soft lint-free cloth dampened with a neutral detergent or water.

Cleaning the Interior

Clean the interior of the printer regularly to prevent stains inside the printer that can deteriorate printing quality. Clean the printer interior whenever you replace an imaging unit.

After clearing paper jams or replacing a toner cartridge, inspect the inside of the printer before closing the printer covers and doors.

- Remove any remaining pieces of paper or debris. For details, see Clearing Paper Jams on page 242.
- Remove any dust or stains with a dry, clean cloth.

WARNING: Never touch a labeled area on or near the heat roller in the fuser. You can get burned. If a sheet of paper is wrapped around the heat roller, do not try to remove it immediately. Switch off the printer immediately and wait 40 minutes for the fuser to cool. Try to remove the jam after the printer has cooled.
**Cleaning the Laser Lenses**

If prints have voids or light streaks through one or more color, use the following instructions to clean the laser lenses.

⚠️ **WARNING:** If you accidentally get toner on your clothes, lightly dust them off as best as you can. If some toner remains on your clothes, use cool water, not hot, to rinse off the toner. If toner gets on your skin, wash it off with cool water and a mild soap. If you get toner in your eyes, wash it out immediately with cool water and consult a doctor.

1. Turn off the printer.

⚠️ **CAUTION:** If the optional Productivity Kit (HD) is not installed, ensure that the Ready LED is off before you turn off the printer. The data in the memory is cleared when the printer is turned off.

2. Open the right side door.

3. To unlock the waste cartridge, turn the waste cartridge lever 90-degrees counterclockwise.
4. Grasp the handle of the waste cartridge, then pull it out. To prevent toner spills, keep the openings facing up.

**Notes:**
- Be careful not to spill toner when handling the waste cartridge.
- After removing the waste cartridge, do not touch the area shown in the illustration.

5. Place the removed waste cartridge on a level surface.

⚠️ **CAUTION:** To avoid toner spills or malfunction, do not lay the waste cartridge on its side.
6. Remove the cleaning rod from inside the printer.

7. Insert the cleaning rod into one of the four cleaning holes until it clicks, then pull it out. Repeat this two more times. Repeat this step for the other three colors.

8. Repeat the procedure for the holes in the other three slots.
9. Return the cleaning rod to its original location.
10. Reinsert the waste cartridge.

   ![Image of waste cartridge being reinserted]

   **Note:** If the waste cartridge does not fit into place properly, ensure that the belt is inserted fully.

11. To lock the waste cartridge, turn the waste cartridge lock lever 90-degrees clockwise.

   ![Image of waste cartridge lock lever being turned]

12. Close the side door.

   ![Image of side door being closed]
Cleaning the Color Toner Density Sensors

1. Turn off the printer.

⚠️ **CAUTION:** If the optional Productivity Kit (HD) is not installed, ensure that the Ready LED is off before you turn off the printer. The data in the memory is cleared when the printer is turned off.

2. Push down on the rear door release and pull open the door.

3. Open the side door.

4. To unlock the waste cartridge, turn the waste cartridge lever 90-degrees counterclockwise.
5. Grasp the handle of the waste cartridge, then pull it out. To prevent toner spills, keep the openings facing up.

Notes:
- Be careful not to spill toner when handling the waste cartridge.
- After removing the waste cartridge, do not touch the area shown in the illustration.

6. Place the removed waste cartridge on a level surface.

⚠️ CAUTION: To avoid toner spills or malfunction, do not lay the waste cartridge on its side.
7. Push the release, then raise the front of the control panel.

8. Open the top cover.

9. Put your fingers through the loops on both sides of the transfer belt, then pull it out.
10. Use a dry cotton swab to clean the color toner density sensors.

11. Reinsert the belt unit into the printer.

12. Close the top cover.
13. Reinsert the waste cartridge.

**Note:** If the waste cartridge does not fit into place properly, ensure that the belt is inserted fully.

14. To lock the waste cartridge, turn the waste cartridge lock lever 90-degrees clockwise.
15. Close the side door.

16. Close the rear door.
Adjustments and Maintenance Procedures

This section includes:

- Color Registration ................................................................. 219
- Adjusting for the Paper Type ...................................................... 222
- Adjusting the Transfer Belt Unit .................................................. 222
- Adjusting the Fuser ................................................................. 223
- Adjusting the Transfer Roller ..................................................... 223
- Initializing NVM .................................................................. 224
- Initializing the Print Meter ......................................................... 224
- Resetting the Transfer Unit ....................................................... 225
- Clearing Storage .................................................................. 225
- Formatting the Hard Disk Drive ................................................. 226
- Adjusting the Altitude ............................................................. 226
- Clearing Job History ............................................................... 227
- Adjusting the Touchscreen ....................................................... 227

Color Registration

The printer automatically adjusts the color registration when automatic adjustment is turned on. You can also adjust color registration manually any time the printer is idle. You must adjust the color registration any time the printer is moved. If you are having printing problems, adjust the color registration.

Setting Automatic Color Registration

1. At the printer control panel, press the Machine Status button.
2. Touch Tools, then touch Admin Settings.
3. Touch Service Tools.
4. Touch Auto Registration, then touch On.
5. Touch OK.
6. To return to the Service Tools menu, press the Back arrow. To return to the Services Home menu, press the Services Home button.
Performing an Automatic Color Registration Adjustment

Automatic color registration adjustment occurs every time a new toner cartridge is installed. You can run this adjustment at other times as needed.

To perform an automatic color registration adjustment:
1. At the printer control panel, press the Machine Status button.
2. Touch Tools, then touch Admin Settings.
3. Touch Service Tools.
4. Touch Color Registration>Auto Registration>Start.
   The printer runs while it performs the Auto Registration routine.

Performing a Manual Color Registration Adjustment

Color Registration adjusts the printer to make corrections to blurry or hazy prints, or prints with color halos.

To perform a color registration adjustment:
1. At the printer control panel, press the Machine Status button.
2. Touch Tools, then touch Admin Settings.
3. Touch Service Tools.
4. Touch Color Registration>Print Registration Chart>Print.
5. Starting with the left side calibration lines, circle the line in each group where the color bar aligns with the adjacent black bars.
6. Repeat the process for the right side calibration lines, RY, RM, and RC.
7. Align a straight edge through the middle of the white zone in each of the PY, PM, and PC charts. Circle the number at the end of each chart that represents the middle of the white zone.

8. Touch **Enter Registration Value**.
9. To enter values for each LY, LM, and LC fields, use - and + to adjust the value to what you circled in step 5.
10. Touch **Next**.
11. To enter values for each RY, RM, and RC fields, use - and + to adjust the value to what you circled in step 6.
12. Touch **Next**.
13. To enter values for each PY, PM, and PC fields, use - and + to adjust the value to what you circled in step 7.
14. Touch **OK**.
15. Print another Registration Chart, then repeat the process until you complete the color registration corrections.
16. Touch the **Back** arrow to return to the previous menu, or press the **Services Home** button to return to Service Home.
Adjusting for the Paper Type

Use Adjust Paper Type to compensate for paper thickness within a paper type. If the printed image is too light, use a heavier setting for the paper you are using. If the printed image is mottled or blotchy-looking, decrease the setting for the paper you are using.

To adjust the paper type:
1. At the printer control panel, press the **Machine Status** button.
2. Touch **Tools>Admin Settings**.
3. Using the keypad, type the passcode as needed.
4. Touch **Service Tools**.
5. Touch **Paper Type**.
6. To select the paper type, touch **Plain** or **Labels**.
7. To select the weight range of the paper, touch **Lightweight** or **Heavyweight**.
8. Touch **OK**.
9. To return to the Service Tools menu, press the **Back** arrow. To return to the Services Home menu, press the **Services Home** button.

Adjusting the Transfer Belt Unit

Adjust Transfer Belt Unit allows you to improve print quality for selected paper types. If the printed image is too light, increase the offset for the paper you are using. If the printed image is mottled or blotchy-looking, decrease the offset for the paper you are using.

To adjust the transfer belt unit:
1. At the printer control panel, press the **Machine Status** button.
2. Touch **Tools>Admin Settings**.
3. Using the keypad, type the passcode as needed.
4. Touch **Service Tools**.
5. Touch **Adjust Transfer Belt Unit**.
6. To adjust the black level, touch **K Offset**.
7. To increase or decrease the amount of offset, press the arrow buttons, then press **OK**.
8. To adjust the color level, touch **YMC Offset**.
9. To increase or decrease the amount of offset, press the arrow buttons, then press **OK**.
10. To return to the Service Tools menu, press the **Back** arrow. To return to the Services Home menu, press the **Services Home** button.
Adjusting the Fuser

Use Adjust Fuser for optimum print quality across a wide range of paper types. If the toner on a print is smearing or can be rubbed off the paper, increase the offset for the paper you are using. If the toner is blistered or mottled, decrease the offset for the paper you are using.

To adjust the fuser:
1. At the printer control panel, press the **Machine Status** button.
2. Touch **Tools > Admin Settings**.
3. Using the keypad, type the passcode as needed.
4. Touch **Service Tools**.
5. Touch **Adjust Fuser**.
6. To select the paper type, touch the name of the paper type in the list.
7. To increase or decrease the amount of offset, press the arrow buttons, then press **OK**.
8. To adjust the fuser for another paper type, select it from the list, then repeat steps 6 and 7.
9. To return to the Service Tools menu, press the **Back** arrow.

Adjusting the Transfer Roller

Use Adjust Transfer Roller to specify the bias transfer roller voltage for printing on the selected paper type. If the printed image is too light, increase the offset for the paper you are using. If the printed image is mottled or blotchy-looking, decrease the offset for the paper you are using.

To adjust the transfer roller:
1. At the printer control panel, press the **Machine Status** button.
2. Touch **Tools > Admin Settings**.
3. Using the keypad, type the passcode as needed.
4. Touch **Service Tools**.
5. Touch **Adjust Transfer Roller**.
6. To select the paper type, touch the name of the paper type in the list.
7. To increase or decrease the amount of offset, press the arrow buttons, then press **OK**.
8. To return to the Service Tools menu, press the **Back** arrow. To return to the Services Home menu, press the **Services Home** button.
## Initializing NVM

This feature initializes the settings stored in the non-volatile memory (NVM) except for the network settings. The NVM stores printer settings even after the power is turned off. After executing this function and restarting the printer, all menu settings are reset to their default values.

To initialize non-volatile memory:

1. At the printer control panel, press the **Machine Status** button.
2. Touch **Tools > Admin Settings**.
3. Using the keypad, type the passcode as needed.
4. Touch **Service Tools**.
5. Touch **Initialize NVM**.
6. To select to reset the non-volatile memory, touch **Fax Settings**, **Scan Settings** or **System Settings**.
7. Touch **Initialize > Yes, Initialize**.
   
   To cancel, touch the X button or select **No, Cancel**.
8. To return to the Service Tools menu, press the **Back** arrow. To return to the Services Home menu, press the **Services Home** button.

## Initializing the Print Meter

The print meter records the total number of printed pages by user and paper size, and by total prints. For each user, it also records the sheets printed by color, black only, and the total. To see the page count since the last reset of the print meter, you can print the Print Volume Report from the information pages. At the end of each accounting cycle, you can initialize the print meter to keep an accurate accounting of the print volume by user.

To initialize the print meter:

1. At the printer control panel, press the **Machine Status** button.
2. Touch **Tools > Admin Settings**.
3. Using the keypad, type the passcode as needed.
4. Touch **Service Tools**.
5. Touch **Initialize Print Meter**.
6. Touch **Initialize > Yes, Initialize**.
   
   To cancel, touch the X button or select **No, Cancel**.
7. To return to the Service Tools menu, press the **Back** arrow. To return to the Services Home menu, press the **Services Home** button.
Resetting the Transfer Unit

The print meter keeps a count of the pages processed by the Transfer Unit. As the page count nears the end of life for the transfer unit, a message appears to warn you to replace it soon. After the transfer unit is replaced, reset the transfer unit so that the printer has an accurate page count for the new unit.

To reset the transfer unit:
1. At the printer control panel, press the Machine Status button.
2. Touch Tools > Admin Settings.
3. Using the keypad, type the passcode as needed.
4. Touch Service Tools.
5. Touch Reset Transfer Unit.
6. Touch Reset > Yes, Reset.
   To cancel, touch the X button or select No, Cancel.
7. To return to the Service Tools menu, press the Back arrow. To return to the Services Home menu, press the Services Home button.

Clearing Storage

As users send more secure and saved jobs to the printer, the storage media fills and the lists become long and cumbersome. To clear the unneeded files from the lists, use the Clear Storage procedure.

To clear storage:
1. At the printer control panel, press the Machine Status button.
2. Touch Tools, then touch Admin Settings.
3. Touch Clear Storage.
   − To clear secure and saved jobs, touch All, then touch Clear.
   − To clear secure jobs only, touch Secure, then touch Clear.
   − To clear saved jobs only, touch Saved, then touch Clear.
4. To clear the storage, touch Yes, Clear.
   To cancel, touch the X button or select No, Cancel.
5. To return to the Service Tools menu, press the Back arrow. To return to the Services Home menu, press the Services Home button.
Formatting the Hard Disk Drive

When installing a new hard drive (HDD) or when trying to restore an inoperative printer, you can format the hard drive. Formatting the HDD writes over the disk allocation tables which point to where information is stored on the drive. After you format the HDD, the printer can no longer access files and settings that were on it. Use Format HDD to remove access to sensitive information when moving the printer from your group.

**Note:** Formatting the HDD does not remove secure or sensitive files from the printer hard disk drive, it only overwrites the allocation table. A formatted HDD still contains file and setting information that can be retrieved. To remove all sensitive information from the HDD, erase and overwrite the entire drive.

To format the HDD:
1. At the printer control panel, press the **Machine Status** button.
2. Touch **Tools**, then touch **Admin Settings**.
3. Touch **Format HDD**.
4. To format the drive, touch **Yes, Start**.
   To cancel, touch the **X** button or select **No, Cancel**.
5. To return to the Service Tools menu, press the **Back** arrow. To return to the Services Home menu, press the **Services Home** button.

**WARNING:** Formatting the HDD renders all previous files, pending files, and settings inaccessible by the printer.

Adjusting the Altitude

Use Adjust Altitude to adjust the altitude to match that of the location where the printer is installed. If the altitude setting is incorrect, it can cause print-quality problems.

To adjust the altitude:
1. At the printer control panel, press the **Machine Status** button.
2. Touch **Tools**, then touch **Admin Settings**.
3. Touch **Adjust Altitude**.
4. To select an altitude from the list, touch it.
5. Touch **OK**.
6. To return to the Service Tools menu, press the **Back** arrow. To return to the Services Home menu, press the **Services Home** button.
Clearing Job History

The printer retains information on previous printing jobs, including the date, time, job type, document name, output color, paper size, number of pages, and results. The status of a maximum of 20 jobs prints on the Job History Report. Use Clear Job History to clear all jobs from the list.

To clear job history:
1. At the printer control panel, press the Machine Status button.
2. Touch Tools, then touch Admin Settings.
3. Touch Clear Job History.
4. To clear the job history, touch Yes, Start.
   To cancel, touch the X button or select No, Cancel.
5. To return to the Service Tools menu, press the Back arrow. To return to the Services Home menu, press the Services Home button.

Adjusting the Touchscreen

1. At the printer control panel, press the Machine Status button.
2. Touch Tools, then touch Admin Settings.
3. Touch Adjust Touchscreen.
4. Read the instructions, then touch OK.
5. Touch each cross as it is indicated.
   Note: To improve the accuracy of the adjustment, use a stylus to touch the center of each cross.
6. Touch OK.
7. To return to the Service Tools menu, press the Back arrow. To return to the Services Home menu, press the Services Home button.
Ordering Supplies

This section includes:

- Consumables ................................................................. 228
- Routine Maintenance Items ........................................... 228
- When to Order Supplies .................................................. 229
- Toner Cartridges .......................................................... 230
- Recycling Supplies ......................................................... 230

Consumables

Consumables are printer supplies that get depleted during the operation of the printer. Consumable supplies for this printer are the Genuine Xerox® Toner Cartridges in Cyan, Magenta, Yellow, and Black.

Notes:

- Each consumable includes installation instructions.
- Install only new cartridges in your printer. If a used toner cartridge is installed, then the toner remaining amount displayed could be inaccurate.
- To ensure print quality, the toner cartridge has been designed to cease functioning at a predetermined point.

⚠️ CAUTION: Use of toner other than genuine Xerox® Toner can affect print quality and printer reliability. Xerox® Toner is the only toner designed and manufactured under strict quality controls by Xerox for specific use with this printer.

Routine Maintenance Items

Routine maintenance items are printer parts that have a limited life and require periodic replacement. Replacements can be parts or kits. Routine maintenance items are typically customer replaceable.

Note: Each routine maintenance item includes installation instructions.

Routine maintenance items for this printer include the following:

- Imaging Unit Kit
- Waste Cartridge
- Fuser
- Transfer Unit Kit
When to Order Supplies

A warning appears on the control panel when supplies near their replacement time. Verify that you have replacements on hand. It is important to order these items when the messages first appear to avoid interruptions to your printing. An error message appears on the control panel when supplies must be replaced.

Order supplies from your local reseller or go to www.xerox.com/office/WC6605supplies.

⚠️ **CAUTION:** Use of non-Xerox supplies is not recommended. The Xerox Warranty, Service Agreement, and Total Satisfaction Guarantee do not cover damage, malfunction, or degradation of performance caused by use of non-Xerox supplies, or the use of Xerox supplies not specified for this printer. The Total Satisfaction Guarantee is available in the United States and Canada. Coverage could vary outside these areas. Please contact your Xerox representative for details.
Toner Cartridges

This section includes:

- General Precautions .......................................................................................................................................................... 230
- Replacing a Toner Cartridge .......................................................................................................................................... 230

General Precautions

⚠️ WARNINGS:

- When replacing a toner cartridge, be careful not to spill the toner. If any toner spills, avoid contact with clothes, skin, eyes, and mouth. Do not inhale the toner dust.
- Keep toner cartridges out of the reach of children. If a child accidentally swallows toner, have the child spit out the toner, and rinse out their mouth with water. Consult a physician immediately.

⚠️ WARNING: Use a damp cloth to wipe off spilled toner. Never use a vacuum cleaner to remove spills. Electric sparks inside the vacuum cleaner can cause a fire or explosion. If you spill a large volume of toner, contact your local Xerox representative.

⚠️ WARNING: Never throw a toner cartridge into an open flame. Remaining toner in the cartridge can catch fire and cause burn injuries or an explosion.

Replacing a Toner Cartridge

When a toner cartridge reaches its usable life span, the control panel displays a message. Job Tracker displays the toner status in the Printer Status window. When a toner cartridge is empty, the printer stops and displays messages on the control panel and in the Job Tracker Printer Status window.

Install only new cartridges in your printer. If a used toner cartridge is installed, then the toner remaining amount displayed could be inaccurate.

Note: Each toner cartridge includes installation instructions.

<table>
<thead>
<tr>
<th>Printer Status Message</th>
<th>Cause and Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Printer Toner Cartridge is Close to Life.</td>
<td>The toner cartridge is low. Order a new toner cartridge.</td>
</tr>
<tr>
<td>Replace the toner cartridge or check that the toner cartridge is properly seated.</td>
<td>The toner cartridge is empty. Replace the toner cartridge with a new one.</td>
</tr>
</tbody>
</table>

Recycling Supplies

For more information on the Xerox® supplies recycling program, go to: www.xerox.com/gwa.
Managing the Printer

This section includes:
- Checking Page Counts ..................................................................................................................................................... 231
- Changing the Passcode Using the Control Panel........................................................................................................... 231

Checking Page Counts

The Meter Readings menu shows the number of processed print jobs. The meter is divided according to the color mode. You cannot reset the meter readings; they track the total number of pages printed for the life of the printer.

You can check the total number of printed pages on the Configuration Report. It lists the print volume by the total number of pages printed on each paper size.

Printing the Configuration Report

1. At the printer control panel, press the Machine Status button.
2. Touch Information Pages, then touch Configuration Report.
3. Touch Print.

Viewing Meter Readings

1. At the printer control panel, press the Machine Status button.
2. Touch Meter Readings.
3. After viewing the readings, touch X to close the window or press the Services Home button to return to the Services Home menu.

Changing the Passcode Using the Control Panel

1. At the printer control panel, press the Machine Status button.
2. Touch Tools>Admin Settings.
3. At the prompt, enter a four-digit passcode, then touch OK.
4. Use the Up or Down arrows to navigate, then touch Secure Settings.
5. Touch Panel Lock, then touch Change Passcode.
6. At the prompt, enter a four-digit passcode, then touch OK.
7. At the prompt, enter the new passcode, then touch OK.
8. At the prompt, re-enter the passcode, then touch OK.
9. Touch the Back arrow to return to the previous menu, or press the Services Home button to return to Service Home.
Moving the Printer

**WARNINGS:**

- To lift the printer, always use at least two people to grasp the hand holds on each side of the printer.
- To prevent you from dropping the printer or injury, lift the printer firmly by gripping the recessed areas on both sides of the printer. Never lift the printer by gripping any other areas.
- If the optional 550-Sheet Feeder is installed, uninstall it before you move the printer. If the optional 550-Sheet Feeder is not fixed to the printer securely, it could fall to the ground and cause injury.

Follow these instructions when moving the printer:

1. Turn off the printer and disconnect the power cord and other cables from the back of the printer.

   **CAUTION:** If the optional Productivity Kit (HD) is not installed, ensure that the Ready LED is off before you turn off the printer. The data in the memory is cleared when the printer is turned off.

   **WARNING:** To prevent electric shock, never touch the power plug with wet hands. When removing the power cord, ensure that you pull the plug and not the cord. Pulling the cord can damage it, which can lead to fire or electric shock.

2. Remove any paper or other media from the output tray. If the output tray extension is extended, close it.
3. Remove the paper from the paper tray.  
   Keep the paper wrapped and away from humidity and dirt.

4. Lift and carry the printer as shown in the illustration.

Notes:

- When moving the printer, do not tilt it more than 10 degrees to the front, back, left, or right. Tilting the printer more than 10 degrees can cause toner spillage.
- When moving the printer over a long distance, remove the imaging units and toner cartridges to prevent toner from spilling.

⚠️ CAUTION: Failure to repackage the printer properly for shipment can result in damage not covered by the Xerox® Warranty, Service Agreement, or Total Satisfaction Guarantee. The Xerox® Warranty, Service Agreement, or Total Satisfaction Guarantee do not cover damage to the printer caused by improper moving.

After moving the printer:
1. Reinstall any parts you removed.
2. Reconnect the printer to the cables and power cord.
3. Plug in and turn on the printer.
Troubleshooting

This chapter includes:

- General Troubleshooting ................................................................. 236
- Paper Jams ...................................................................................... 241
- Getting Help .................................................................................. 265
General Troubleshooting

This section includes:

- Printer Does Not Turn On ................................................................. 236
- Printer Resets or Turns Off Frequently ............................................. 237
- Printer Does Not Print ....................................................................... 237
- Printing Takes Too Long ................................................................. 238
- Document Prints From Wrong Tray .................................................... 239
- Automatic 2-Sided Printing Problems ............................................... 239
- Printer is Making Unusual Noises ..................................................... 239
- Paper Tray Will Not Close ............................................................... 239
- Condensation has Formed Inside the Printer ..................................... 240

This section contains procedures to help you locate and resolve problems. Resolve some problems by simply restarting the printer.

Printer Does Not Turn On

<table>
<thead>
<tr>
<th>Probable Causes</th>
<th>Solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>The power switch is not turned on.</td>
<td>Turn on the switch.</td>
</tr>
<tr>
<td>The power cord is not correctly plugged into the outlet.</td>
<td>Turn off the printer power switch, and plug the power cord securely into the outlet.</td>
</tr>
</tbody>
</table>
| Something is wrong with the outlet connected to the printer. | • Plug another electrical appliance into the outlet and see if it operates properly.  
  • Try a different outlet.                           |
| The printer is connected to an outlet with a voltage or frequency that does not match the printer specifications. | Use a power source with the specifications listed in the Electrical Specifications on page 277. |

⚠️ CAUTION: Plug the three-wire cord with grounding prong directly into a grounded AC outlet.
## Printer Resets or Turns Off Frequently

<table>
<thead>
<tr>
<th>Probable Causes</th>
<th>Solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>The power cord is not plugged into the outlet correctly.</td>
<td>Turn off the printer, confirm that the power cord is plugged in correctly to the printer and the outlet, then turn on the printer.</td>
</tr>
<tr>
<td>A system error occurred.</td>
<td>Turn off the printer, then turn it on again. Print the Error History from the Information Pages of the Printer Setting Utility. If the error persists, contact your Xerox representative.</td>
</tr>
<tr>
<td>The printer is connected to an uninterruptible power supply.</td>
<td>Turn off the printer, then connect the power cord to a suitable outlet.</td>
</tr>
<tr>
<td>The printer is connected to a power strip shared with other high-power devices.</td>
<td>Plug the printer directly into the outlet or into a power strip that is not shared with other high-power devices.</td>
</tr>
</tbody>
</table>

## Printer Does Not Print

<table>
<thead>
<tr>
<th>Probable Causes</th>
<th>Solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>The printer is in Energy Saver mode.</td>
<td>Push the control panel button.</td>
</tr>
<tr>
<td>The printer has an error.</td>
<td>Follow the instructions on the control panel to clear the error. If the error persists, contact your Xerox representative.</td>
</tr>
<tr>
<td>The printer is out of paper.</td>
<td>Load paper into the tray.</td>
</tr>
<tr>
<td>A toner cartridge is empty.</td>
<td>Replace the empty toner cartridge.</td>
</tr>
<tr>
<td>The Error Indicator is blinking.</td>
<td>If the Ready Indicator is off, the printer has stopped working. Turn off the printer, then turn it on again. If the error persists, contact your Xerox representative.</td>
</tr>
<tr>
<td>Both control panel indicators are off.</td>
<td>Turn off the printer, confirm that the power cord is plugged in correctly to the printer and the outlet, then turn on the printer. If the error persists, contact your Xerox representative.</td>
</tr>
</tbody>
</table>
## Troubleshooting

### The printer is busy.

- If the Ready Indicator is flashing, it is normal. A previous print job could be the problem. Use the printer properties to delete all print jobs in the print queue.
- Load the paper in the tray.
- If the Ready Indicator is not flashing after you send a print job, check the USB connection between the printer and the computer. Turn off the printer, then turn it on again.

### The printer cable is disconnected.

- If the Ready Indicator is not flashing after you send a print job, check the USB connection between the printer and the computer.
- If the Ready Indicator is not flashing after you send a print job, check the Ethernet connection between the printer and the computer.

### Printing Takes Too Long

<table>
<thead>
<tr>
<th>Probable Causes</th>
<th>Solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>The printer is set to a slower printing mode, for example, for printing on glossy or heavyweight paper.</td>
<td>It takes more time to print on certain types of special paper. Ensure that the paper type is set properly in the driver and at the printer control panel. For details, see Print Speed on page 278.</td>
</tr>
<tr>
<td>The printer is in Energy Saver mode.</td>
<td>Wait. It takes time for printing to start when the printer is coming out of Energy Saver mode.</td>
</tr>
<tr>
<td>The way the printer was installed on the network could be an issue.</td>
<td>Determine if a print spooler or a computer sharing the printer is buffering all print jobs and then spooling them to the printer. Spooling can slow print speeds. To test the speed of the printer, print some information pages such as the Office Demo Page. If the page does not print at the rated speed of the printer, you could have a network or printer installation issue.</td>
</tr>
<tr>
<td>The job is complex.</td>
<td>Wait. No action needed.</td>
</tr>
<tr>
<td>The print-quality mode in the driver is set to Enhanced.</td>
<td>Change the print-quality mode in the print driver to Standard.</td>
</tr>
<tr>
<td>The printer quality is set to Photo and the printer is being used for complex, 2-sided print jobs.</td>
<td>Increase memory size to 1 GB RAM by installing the Productivity Kit (Memory).</td>
</tr>
</tbody>
</table>
### Document Prints From Wrong Tray

<table>
<thead>
<tr>
<th>Probable Causes</th>
<th>Solutions</th>
</tr>
</thead>
</table>
| Application and print driver have conflicting tray selections. | 1. Check the tray selected in the print driver.  
2. Go to the page setup or printer settings of the application from which you are printing.  
3. Set the paper source to match the tray selected in the print driver or set the paper source to Automatically Select.  
**Note:** To have the print driver select the tray, set the tray used as the paper source to Auto Selection Enabled. |

### Automatic 2-Sided Printing Problems

<table>
<thead>
<tr>
<th>Probable Causes</th>
<th>Solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unsupported or incorrect paper.</td>
<td>Ensure that you are using a supported paper size and weight for 2-sided printing. Envelopes and labels cannot be used for 2-sided printing. For details, see Supported Standard Types and Weights for Automatic 2-Sided Printing on page 120 and Supported Standard Paper Sizes for Automatic 2-Sided Printing on page 121.</td>
</tr>
<tr>
<td>Incorrect setting.</td>
<td>In the print driver Properties, select <strong>2-Sided Print</strong> on the Paper/Output tab.</td>
</tr>
</tbody>
</table>

### Printer is Making Unusual Noises

<table>
<thead>
<tr>
<th>Probable Causes</th>
<th>Solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>There is an obstruction or debris inside the printer.</td>
<td>Turn off the printer and remove the obstruction or debris. If you cannot remove it, contact your Xerox representative.</td>
</tr>
</tbody>
</table>

### Paper Tray Will Not Close

<table>
<thead>
<tr>
<th>Probable Causes</th>
<th>Solutions</th>
</tr>
</thead>
</table>
| The paper tray does not fully close.                 | • The paper tray lift plate is not locked down. Push down on the paper stack at the back of the tray until it locks down.  
• Some debris or an object is blocking the tray.  
• The tray is hanging up on the table or shelf on which it is located. |
Condensation has Formed Inside the Printer

Moisture can condense inside a printer where the humidity is above 85% or when a cold printer is located in a warm room. Condensation can form in a printer after it has been sitting in a cold room that is heated quickly.

<table>
<thead>
<tr>
<th>Probable Causes</th>
<th>Solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>The printer has been sitting in a cold room.</td>
<td>Allow the printer to operate for several hours at room temperature.</td>
</tr>
<tr>
<td>The relative humidity of the room is too high.</td>
<td>• Reduce the humidity in the room.</td>
</tr>
<tr>
<td></td>
<td>• Move the printer to a location where the temperature and relative humidity are within the operating specifications.</td>
</tr>
</tbody>
</table>
Paper Jams

This section includes:

- Locating Paper Jams ......................................................................................................................................................... 241
- Clearing Paper Jams .......................................................................................................................................................... 242
- Troubleshooting Paper Jams ............................................................................................................................................. 253
- Print-Quality Problems ...................................................................................................................................................... 255
- Copy and Scan Problems .................................................................................................................................................. 262
- Fax Problems ....................................................................................................................................................................... 263

Locating Paper Jams

⚠️ **WARNING:** Never touch a labeled area on or near the heat roller in the fuser. You can get burned. If a sheet of paper is wrapped around the heat roller, do not try to remove it immediately. Switch off the printer immediately and wait 40 minutes for the fuser to cool. Try to remove the jam after the printer has cooled. If the error persists, contact your Xerox representative.

⚠️ **CAUTION:** Do not attempt to clear any paper jams using tools or instruments. This can permanently damage the printer.

The following illustration shows where paper jams can occur along the paper path:

1. Tray 2
2. Duplex Automatic Document Feeder
3. Fuser
4. Bypass Tray
5. Tray 1
Clearing Paper Jams

This section includes:
- Clearing Paper Jams from the Duplex Automatic Document Feeder ......................................................... 242
- Clearing Paper Jams from the Bypass Tray ............................................................................................................ 244
- Clearing Paper Jams from the Tray 1 Area ............................................................................................................. 246
- Clearing Paper Jams from the Tray 2 Area ............................................................................................................. 249
- Clearing Paper Jams from the Fuser Area ............................................................................................................. 251

Clearing Paper Jams from the Duplex Automatic Document Feeder

1. Remove the remaining paper from the duplex automatic document feeder.
2. Open the duplex automatic document feeder cover.
3. Lift the release lever up to 90 degrees, then remove the jammed paper by gently pulling in the direction as illustrated.
4. If the document is difficult to remove, remove the feed roller assembly and remove the paper:
   a. Lift the lever up to the 90 degree position, then lift the front of the assembly clear of the bracket.
   b. Move the front of the assembly slightly to the left, then lift it up about 13 mm (0.5 in.).
   c. To release the assembly from the rear bracket, pull it toward the front of the printer and lift it free.
   d. Pull out the paper in the direction as illustrated.

5. To replace the feed roller assembly, reverse the procedures.
6. If the paper is jammed in the exit of the duplex automatic document feeder, pull it out as illustrated.

7. Reload the document in the duplex automatic document feeder, then adjust the guides against the edges of the paper.
Clearing Paper Jams from the Bypass Tray

To resolve the error displayed on the control panel you must clear all paper from the paper path.

1. Remove any paper from the bypass tray.

2. Grasp both sides of the Bypass Tray, then pull it straight out of the printer.

3. Pull out Tray 1 until it stops.
4. To remove the tray, lift the front of it slightly, then pull it out of the printer.

5. Remove the jammed paper.

6. At the back of the paper tray, press the paper lift tray down until it locks.
7. Insert Tray 1 into the printer, then push it all the way in.

Notes:
- If the tray does not go all the way in, ensure that the paper lift at the back of the tray is locked down.
- If the tray is extended for legal size paper, the tray protrudes when it is inserted into the printer.
8. Insert the Bypass Tray into the printer.

9. Push the tray in all the way.

10. If the control panel prompts you, verify the size and type on the screen. To make changes:
   a. Touch Size, then touch an option for a standard paper size.
   b. Touch Type, then touch an option for the paper type.
   c. Touch OK.

**Clearing Paper Jams from the Tray 1 Area**

To resolve the error displayed on the control panel you must clear all paper from the paper path.

1. Remove any paper from the bypass tray.

2. Grasp both sides of the bypass tray, then pull it straight out of the printer.
3. Pull out Tray 1 until it stops.

4. To remove the tray, lift the front of it slightly, then pull it out of the printer.

5. Remove the jammed paper.
6. At the back of the paper tray, press the paper lift tray down until it locks.
7. Insert Tray 1 into the printer, then push it all the way in.

Notes:
- If the tray does not go all the way in, ensure that the paper lift at the back of the tray is locked down.
- If the tray is extended for legal size paper, the tray protrudes when it is inserted into the printer.
8. Insert the bypass tray into the printer.

9. Push the tray in all the way.
10. If the control panel prompts you, verify the size and type on the screen. To make changes:
   a. Touch **Size**, then touch an option for a standard paper size.
   b. Touch **Type**, then touch an option for the paper type.
   c. Touch **OK**.
Clearing Paper Jams from the Tray 2 Area

To resolve the error displayed on the control panel you must clear all paper from the paper path.

1. Pull out tray 2 until it stops.

2. To remove the tray, lift the front of it slightly, then pull it out of the printer.

3. Remove any paper jammed at the front of the printer.
4. At the back of the printer, open the Tray 2 Door, then remove any paper jammed at the back of the printer.

5. Insert the tray back into the printer.

6. Push the tray in all the way.

Notes:
- If the tray does not go all the way in, ensure that the paper lift at the back of the tray is locked down.
- If the tray is extended for legal size paper, the tray protrudes when it is inserted into the printer.

7. If the control panel prompts you, verify the size and type on the screen. To make changes:
   a. Touch **Size**, then touch an option for a standard paper size.
   b. Touch **Type**, then touch an option for the paper type.
   c. Touch **OK**.
Clearing Paper Jams from the Fuser Area

To resolve the error displayed on the control panel you must clear all paper from the paper path.

1. Push down on the rear door release and pull open the door.

2. Lift the levers as shown.

3. To lift the top paper guide on the top of the fuser, use the tabs to pull it up and out.
4. Remove any jammed paper from the back of the printer.

5. Close the paper guide cover on the fuser.

6. Lower the levers to their original position.

7. Close the rear door.
Troubleshooting Paper Jams

This section includes:

- **Multiple Sheets Pulled Together** ................................................................. 253
- **Paper Misfeeds** .......................................................................................... 253
- **Label and Envelope Misfeeds** ................................................................. 253
- **Paper Jam Message Stays On** ................................................................. 254
- **Jams During Automatic 2-Sided Printing** .............................................. 254

## Multiple Sheets Pulled Together

<table>
<thead>
<tr>
<th>Probable Causes</th>
<th>Solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>The paper tray is too full.</td>
<td>Remove some of the paper. Do not load paper past fill line.</td>
</tr>
<tr>
<td>The edges of the paper are not even.</td>
<td>Remove the paper, align the edges, and then reload it.</td>
</tr>
<tr>
<td>The paper is moist from humidity.</td>
<td>Remove the paper from the tray, and replace it with new dry paper.</td>
</tr>
<tr>
<td>Too much static electricity is present.</td>
<td>Try a new ream of paper.</td>
</tr>
<tr>
<td>Using unsupported paper.</td>
<td>Use only Xerox®-approved paper. For details, see Supported Paper on page 118.</td>
</tr>
<tr>
<td>Humidity is too high for coated paper.</td>
<td>Feed paper one sheet at a time.</td>
</tr>
</tbody>
</table>

## Paper Misfeeds

<table>
<thead>
<tr>
<th>Probable Causes</th>
<th>Solutions</th>
</tr>
</thead>
</table>
| The paper is not correctly positioned in the tray. | • Remove the misfed paper and reposition it properly in the tray.  
  • Adjust the paper guides in the tray to match the size of the paper. |
| The paper tray is too full.         | Remove some of the paper. Do not load paper past the fill line. |
| The paper guides are not correctly adjusted to the paper size. | Adjust the paper guides in the tray to match the size of the paper. |
| The tray contains warped or wrinkled paper. | Remove the paper, smooth it out, and reload it. If it still misfeeds, do not use that paper. |
| The paper is moist from humidity.   | Remove the moist paper and replace it with new, dry paper. |
| Using paper of the wrong size, thickness, or type. | Use only Xerox approved paper. For details, see Supported Paper on page 118. |
Label and Envelope Misfeeds

<table>
<thead>
<tr>
<th>Probable Causes</th>
<th>Solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>The label sheet is facing the wrong way in the tray.</td>
<td>• Load label sheets according to the instructions from the manufacturer. Load labels only in the Bypass Tray, face up and with the top going into the printer.</td>
</tr>
</tbody>
</table>
| Envelopes are loaded incorrectly.                    | • Load No. 10, DL, and Monarch envelopes in the trays with the print side up, flaps closed, flap-side down and to the right. Load them with the short edge leading into the printer.  
  • Load C5 envelopes with the print side up, flaps open and facing away from the printer. |
| No. 10, DL, and Monarch envelopes are wrinkling.      | To prevent wrinkling on No. 10, DL, C5, or Monarch envelopes, load them print side up, flaps open and facing away from the printer.  
  Note: When you load envelopes long-edge feed, ensure that you specify landscape orientation in the print driver. |

Paper Jam Message Stays On

<table>
<thead>
<tr>
<th>Probable Causes</th>
<th>Solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Some paper remains jammed in the printer.</td>
<td>Recheck the media path and make sure that you have removed all of the jammed paper.</td>
</tr>
<tr>
<td>One of the printer doors is open.</td>
<td>Check the doors on the printer. Close any door that is open.</td>
</tr>
</tbody>
</table>

Note: Check for, and remove, torn pieces of paper in the paper path.

Jams During Automatic 2-Sided Printing

<table>
<thead>
<tr>
<th>Probable Causes</th>
<th>Solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Using paper of the wrong size, thickness, or type.</td>
<td>Use paper of the correct size, thickness, or type. For details, see Supported Paper Sizes for Automatic 2-Sided Printing on page 121.</td>
</tr>
<tr>
<td>Paper is loaded in the wrong tray.</td>
<td>The paper must be loaded in the correct tray. For details, see Supported Paper on page 118.</td>
</tr>
<tr>
<td>Tray is loaded with mixed paper.</td>
<td>Load the tray with only one type and size of paper.</td>
</tr>
</tbody>
</table>
Print-Quality Problems

This section includes:

- Controlling Print Quality ................................................................. 256
- Solving Print-Quality Problems ...................................................... 257

Your printer is designed to produce consistently high-quality prints. If you observe print-quality problems, use the information in this section to troubleshoot the problem. For more information, go to www.xerox.com/office/WC6605support.

⚠️ **CAUTION:** The Xerox Warranty, Service Agreement, or Xerox Total Satisfaction Guarantee does not cover damage caused by using unsupported paper or specialty media. The Xerox Total Satisfaction Guarantee is available in the United States and Canada. Coverage could vary outside these areas. Please contact your local representative for details.

Notes:

- To ensure consistent print quality, the toner cartridges and imaging units for many models of equipment are designed to cease functioning at a predetermined point.
- Grayscale images printed with the composite black setting increment the color pages counter, because color consumables are used. Composite black is the default setting on most printers.
Controlling Print Quality

Various factors can affect the quality of the output of your printer. For consistent and optimum print quality, use paper designed for your printer, and correctly set the Print-Quality Mode and Color Adjustments. Follow the guidelines in this section to maintain optimum print quality from your printer.

Temperature and humidity affect the quality of the printed output. The guaranteed range for optimal print quality is: 15–28°C (59–82°F) and 20–70% relative humidity.

Paper and Media

Your printer is designed to use various paper and other media types. Follow the guidelines in this section for the best print quality and to avoid jams:

- Use only Xerox approved paper. For details, see Supported Paper on page 118.
- Use only dry, undamaged paper.

⚠️ **CAUTION:** Some paper and other media types can cause poor output quality, increased paper jams, or damage your printer. Do not use the following:

- Rough or porous paper
- Inkjet paper
- Non-laser glossy or coated paper
- Paper that has been photocopied
- Paper that has been folded or wrinkled
- Paper with cutouts or perforations
- Stapled paper
- Envelopes with windows, metal clasps, side seams, or adhesives with release strips
- Padded envelopes
- Plastic media

- Ensure the paper type selected in your print driver matches the paper type on which you are printing.
- If you have the same size paper loaded in more than one tray, ensure that the proper tray is selected in the print driver.
- Store your paper and other media properly for optimum print quality. For details, see Paper Storage Guidelines on page 119.
**Solving Print-Quality Problems**

When the print quality is poor, select the closest symptom from the following table and see the corresponding solution to correct the problem. You can also print a Demo Page to more precisely determine the print-quality problem. For details, see Information Pages on page 29.

If the print quality does not improve after carrying out the appropriate action, contact your Xerox representative.

**Notes:**
- To enhance print quality, toner cartridges for many models of equipment have been designed to cease functioning at a predetermined point.
- Grayscale images printed with the composite black setting increment the color pages counter, because color consumables are used. Composite black is the default setting on most printers.

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Probable Causes</th>
<th>Solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Faded printouts with multiple colors faded.</td>
<td>The toner cartridges are not Xerox® toner cartridges.</td>
<td>Verify that the toner cartridges meet specifications, and replace them if necessary.</td>
</tr>
<tr>
<td></td>
<td>The paper being used is outside the recommended specification range.</td>
<td>Replace the paper with a recommended size and type, and confirm that your control panel and print driver settings are correct. For details, see Supported Paper on page 118.</td>
</tr>
</tbody>
</table>
|                                              | The paper type is heavier or thicker than the paper type selection. | • Ensure that the proper paper is loaded in the paper tray.  
• Choose a heavier paper type at the control panel and in the print driver.  
• Use a lighter paper or paper type. |
<p>|                                              | The bias transfer voltage is not properly adjusted for the paper type. | Verify that the paper types set in the control panel and the print driver match the paper loaded in the tray. |
|                                              | The settings in the application or print driver are incorrect. | Print the Demo Page from the Information Pages menu. If the Demo Page looks correct, the printer is printing properly. Your application or incorrect settings in the print driver are probably causing the print-quality problems. |
|                                              | The paper is damp. | Replace the paper. |
|                                              | The high-voltage supply is defective. | For assistance, go to the Xerox® Support website at <a href="http://www.xerox.com/office/WC6605support">www.xerox.com/office/WC6605support</a>. |</p>
<table>
<thead>
<tr>
<th>Symptom</th>
<th>Probable Causes</th>
<th>Solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Only one color is faded.</td>
<td>Toner cartridge is empty or damaged.</td>
<td>Check the condition of the toner cartridge and replace it if necessary.</td>
</tr>
</tbody>
</table>
| Copy colors are wrong color.                 | The color balance is not adjusted properly. | Adjust the color balance:  
   1. Press the **Machine Status** button.  
   2. Touch **Tools>Copy Defaults**.  
   3. Scroll to, then select **Color Balance**.  
   4. Select a color, then adjust the dark, midtones, and light shades for each color.  
   **Note:** - numbers reduce the color, + numbers increase the color.  
   5. Click **OK**.  
   6. To return to the **Services Home** menu, press the **Services Home** button. |
| Stray black dots or white areas (dropouts).  | The paper is outside the recommended specification range. | Replace the paper with a recommended size and type, and confirm that your control panel and print driver settings are correct. For details, see **Supported Paper** on page 118. |
| There is debris on the rollers.              | Wipe the feed rollers with a clean damp cloth to remove debris from the rollers.  
   **Note:** Do not touch the transfer roller or the exposed end of the transfer belt. |
| The toner cartridges are not Xerox® toner cartridges. | Ensure that the toner cartridges meet specifications and replace them if necessary. For details, see **Consumables** on page 228. |
| Vertical black or color streaks or multiple colored streaks or lines.  
  Streaks in only one color.                   | The toner cartridges are not Xerox® toner cartridges. | Ensure that the toner cartridges meet specifications and replace them if necessary. For details, see **Consumables** on page 228. |
<table>
<thead>
<tr>
<th>Symptom</th>
<th>Probable Causes</th>
<th>Solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Debris in the printer is dragging against the</td>
<td>There is a problem with the toner cartridge for that color.</td>
<td>Check the toner cartridge for damage and replace if necessary. For assistance, go to the</td>
</tr>
<tr>
<td>toner before it is fused.</td>
<td></td>
<td>Xerox® Support website at <a href="http://www.xerox.com/office/WC6605support">www.xerox.com/office/WC6605support</a>.</td>
</tr>
<tr>
<td>Color around the edge of printing is incorrect.</td>
<td>The color registration is incorrect.</td>
<td>Adjust the color registration. For details, see Color Registration on page 219.</td>
</tr>
<tr>
<td>Partial blanks, creased paper, or blotted</td>
<td>The paper is damp.</td>
<td>Replace the paper.</td>
</tr>
<tr>
<td>printing.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>The paper is outside the recommended</td>
<td>Replace the paper with a recommended size and type. For details, see Supported</td>
<td>For assistance, go to the Xerox® Support website at <a href="http://www.xerox.com/office/WC6605support">www.xerox.com/office/WC6605support</a>.</td>
</tr>
<tr>
<td>specification range.</td>
<td>Paper on page 118.</td>
<td></td>
</tr>
<tr>
<td>The printer is worn or damaged.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>The toner cartridges are not Xerox® toner</td>
<td>Verify that the toner cartridges meet specifications and replace if necessary.</td>
<td>For details, see Consumables on page 228.</td>
</tr>
<tr>
<td>cartridges.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>The paper is impeded in the paper path.</td>
<td>• Remove any paper or debris from the paper path.</td>
<td>Turn on the printer and leave it on for at least one hour to get rid of the condensation.</td>
</tr>
<tr>
<td>Condensation inside the printer causes</td>
<td>• Ensure that the trays are pushed in all the way.</td>
<td>For assistance, go to the Xerox® Support website at <a href="http://www.xerox.com/office/WC6605support">www.xerox.com/office/WC6605support</a>.</td>
</tr>
<tr>
<td>partial blanks or creased paper.</td>
<td>• Ensure that the rear cover is closed and locked.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
## Troubleshooting

### Symptom | Probable Causes | Solutions
---|---|---
Vertical blanks appear. | The lenses are blocked. | Clean the lenses in the inside of the printer. For details, see [Cleaning the Laser Lenses](#) on page 209.

![Image of vertical blanks](image)

The printer is worn or damaged. | For assistance, go to the Xerox® Support website at [www.xerox.com/office/WC6605support](http://www.xerox.com/office/WC6605support).

White lines or streaks running through only one color. | Something is blocking the lens for the affected color. | Clean the lens for the affected color.

![Image of white lines](image)

White line or lines running through all colors. | Paper or debris is dragging the bottom of the transfer belt. | - Remove the paper or debris from the printer.
- For assistance, go to the Xerox® Support website at [www.xerox.com/office/WC6605support](http://www.xerox.com/office/WC6605support).

![Image of white line](image)

Slanted printing. | The paper guides in the trays are not set correctly. | Reset the paper tray guides. For details, see [Loading Paper](#) on page 122.
<table>
<thead>
<tr>
<th>Symptom</th>
<th>Probable Causes</th>
<th>Solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Colors are blurry or there is white area around objects.</td>
<td>Color-to-color alignment is not correct.</td>
<td>Perform an automatic color registration adjustment. For details, see Color Registration on page 219.</td>
</tr>
<tr>
<td>Blotchy or mottled images.</td>
<td>The paper is too light or too thin.</td>
<td>Choose a different paper type at the control panel, in the application, and in the printer driver.</td>
</tr>
<tr>
<td></td>
<td>The paper is damp.</td>
<td>Replace the paper.</td>
</tr>
<tr>
<td></td>
<td>The humidity is too high.</td>
<td>Reduce the humidity in the room or move the printer to a new location.</td>
</tr>
<tr>
<td>Spots or lines appear at regular intervals on the prints.</td>
<td>One or more of the components in the paper path is marking the paper.</td>
<td>To determine the cause, measure the distance between the print defects.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• 75.3 mm (3 in.) - Imaging Unit</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• 28.3 mm (1.1 in.) - Imaging Unit</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• 31.1 mm (1.2 in.) - Imaging Unit</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• 32.3 mm (1.3 in.) - Imaging Unit</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• 25.1 mm (1 in.) - Transfer Belt</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• 56.5 mm (2.2 in.) - Transfer Roller</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• 82.3 mm (3.2 in.) - Fuser</td>
</tr>
<tr>
<td></td>
<td></td>
<td>If the repeating defects match one of these distances, replace that item.</td>
</tr>
</tbody>
</table>
## Copy and Scan Problems

If the copy or scan quality is poor, refer to the following table.

<table>
<thead>
<tr>
<th>Symptoms</th>
<th>Solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lines or streaks only present in copies made from the document feeder.</td>
<td>There is debris on the document glass. When scanning, the paper from the document feeder passes over the debris creating lines or streaks. Clean all glass surfaces with a lint-free cloth.</td>
</tr>
<tr>
<td>Spots present in copies taken from the document glass.</td>
<td>There is debris on the document glass. When scanning, the debris creates a spot on the image. Clean all glass surfaces with a lint-free cloth.</td>
</tr>
<tr>
<td>The reverse side of the original is showing on the copy or scan.</td>
<td>Turn on Background Suppression.</td>
</tr>
<tr>
<td>Image is too light or too dark.</td>
<td>• Copy: Use the Image Quality settings to lighten, darken, or adjust contrast.</td>
</tr>
<tr>
<td></td>
<td>• Scan: Use the Advanced Settings Tab to lighten, darken, or adjust contrast.</td>
</tr>
<tr>
<td>Colors are inaccurate.</td>
<td>• Copy: Use the Image Quality settings to adjust color balance.</td>
</tr>
<tr>
<td></td>
<td>• Scan: Confirm the correct Original Type is set.</td>
</tr>
</tbody>
</table>

If the problem persists, for online support information, go to [www.xerox.com/office/WC6605support](http://www.xerox.com/office/WC6605support).
Fax Problems

This section includes:

- Problems Sending Faxes ................................................................................................................................. 263
- Problems Receiving Faxes ............................................................................................................................... 264

Note: If you cannot send and receive faxes, make sure that you are connected to an approved analog telephone line. The fax cannot send or receive when connected to a digital phone line.

If you cannot send or receive faxes correctly, refer to the following tables.

### Problems Sending Faxes

<table>
<thead>
<tr>
<th>Symptoms</th>
<th>Causes</th>
<th>Solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>The document is not scanned using the document feeder.</td>
<td>The document is too thick, too thin, or too small.</td>
<td>Use the document glass to send the fax.</td>
</tr>
<tr>
<td>The document is scanned at an angle.</td>
<td>The document feeder guides are not adjusted to the width of the document.</td>
<td>Adjust the document feeder guides to fit the width of the document.</td>
</tr>
<tr>
<td>The fax received by the recipient is blurry.</td>
<td>The document is incorrectly positioned.</td>
<td>Position the document correctly.</td>
</tr>
<tr>
<td></td>
<td>The document glass is dirty.</td>
<td>Clean the document glass.</td>
</tr>
<tr>
<td></td>
<td>The text in the document is too light.</td>
<td>Adjust the resolution. Adjust the contrast.</td>
</tr>
<tr>
<td></td>
<td>There is a problem with the telephone connection.</td>
<td>Verify that the telephone line is working, then send the fax again.</td>
</tr>
<tr>
<td></td>
<td>There is a problem with the fax machine of the caller.</td>
<td>Make a copy to verify that your printer is operating correctly. If the copy was printed correctly, have the recipient verify the condition of their fax machine.</td>
</tr>
</tbody>
</table>
| The fax received by the recipient is blank.   | The document was loaded incorrectly.                | • Document feeder: Place the original document face up.  
                                               |                                                     | • Document glass: Place the original document face down. |
| Fax was not transmitted.                      | The fax number is wrong.                           | Verify the fax number.                         |
|                                               | The telephone line is incorrectly connected.        | Verify the telephone line connection. If it is disconnected, connect it. |
|                                               | There is a problem with the fax machine of the recipient. | Contact the recipient.                        |
|                                               | The fax is not installed or is not enabled.         | Verify that the fax is installed and enabled.  |
|                                               | Server Fax is enabled.                             | Make sure that Server Fax is disabled.         |

If the problem persists, for online support information, go to www.xerox.com/office/WC6605support.
## Problems Receiving Faxes

<table>
<thead>
<tr>
<th>Symptoms</th>
<th>Causes</th>
<th>Solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>The received fax is blank.</td>
<td>There is a problem with the telephone connection or with the fax machine of the caller.</td>
<td>Verify that the printer can make clean copies. If it can, have the caller send the fax again.</td>
</tr>
<tr>
<td></td>
<td>The sender loaded the pages incorrectly.</td>
<td>Contact the sender.</td>
</tr>
<tr>
<td>The printer answers the call, but does not accept incoming data.</td>
<td>Not enough memory.</td>
<td>If the job contains several graphics, the printer could not have enough memory. The printer does not answer when memory is low. Delete stored documents and jobs then wait for the existing job to complete. This increases available memory.</td>
</tr>
<tr>
<td>The received fax size is reduced.</td>
<td>The paper supply in the printer does not match the document size sent.</td>
<td>Confirm the original size of the documents. Documents could be reduced based on the available paper supply in the printer.</td>
</tr>
<tr>
<td>Faxes cannot be received automatically.</td>
<td>The printer is set to receive faxes manually.</td>
<td>Set the printer to automatic reception.</td>
</tr>
<tr>
<td></td>
<td>The memory is full.</td>
<td>Load paper if it is empty, and then print the faxes stored in the memory.</td>
</tr>
<tr>
<td></td>
<td>The telephone line is incorrectly connected.</td>
<td>Verify the telephone line connection. If it is disconnected, connect it.</td>
</tr>
<tr>
<td></td>
<td>There is a problem with the fax machine of the sender.</td>
<td>Make a copy to verify that your printer is operating correctly. If the copy prints correctly, have the recipient verify their fax machine is operating correctly.</td>
</tr>
</tbody>
</table>

If the problem persists, for online support information, go to [www.xerox.com/office/WC6605support](http://www.xerox.com/office/WC6605support).
Getting Help

This section includes:

- Control Panel Messages .................................................................................................................................................. 265
- Using the Integrated Troubleshooting Tools ......................................................................................................... 266
- Online Support Assistant ................................................................................................................................................ 267
- Information Pages ............................................................................................................................................................ 267
- More Information .............................................................................................................................................................. 267

Your printer comes with utilities and resources to help you troubleshoot printing problems.

Control Panel Messages

The printer control panel provides information and troubleshooting help. When a fault or warning condition occurs, the control panel displays a message informing you of the problem. For many status and warning messages, the control panel Information provides additional information.

Control Panel Help

When a fault occurs that stops the printing operation, such as a paper jam, a message appears on the screen. A graphical illustration appears to indicate the location of the fault with a brief explanation of the action to take to clear the fault. The illustration changes to indicate multiple locations and actions to take.

Viewing Warning Messages on the Control Panel

When a warning condition occurs, a message appears on the control panel to inform you of the problem. Warning messages inform you about printer conditions, such as low supplies or open doors, that require your attention. If more than one warning condition occurs, only one is displayed on the control panel.

Viewing Current Faults on the Control Panel

When a fault condition occurs, a message appears on the control panel to inform you of the problem. Fault messages warn you about printer conditions that prevent the printer from printing or degrade printing performance. If more than one fault occurs, only one is displayed on the control panel.
Troubleshooting

Viewing Job Status on the Control Panel

To view current or saved jobs on the control panel:
1. At the control panel, press the Job Status button.
   In the top portion of the screen, a list of current jobs appears.
2. To view a list of secure prints, touch Secure Jobs.
3. To view a list of secure faxes received, touch Secure Fax Receive.

To print a detailed list of last 20 print, copy, fax, or scan jobs that have processed:
1. At the printer control panel, press the Machine Status button.
2. Touch Information Pages.
3. Use the arrows to navigate the screens, then touch Job History.
4. Touch Print.

Using the Integrated Troubleshooting Tools

Your printer has a printable set of reports. Two of them, the Demo Page and the Error History report, can help with troubleshooting certain problems. The Demo Page prints an image using many colors to show the current ability of the printer to print. The Error History report prints information on the most recent printer errors.

Printing Reports

1. At the printer control panel, press the Machine Status button.
2. Touch Information Pages.
3. Use the arrows to navigate, then select a report.
4. Touch Print.

Specifying the Source Tray for Printing Reports

1. At the printer control panel, press the Machine Status button.
2. Touch Tools>Tray Management>Tray Priority.
3. To specify a default source tray, select First, then select the tray from which to print reports.
4. Click OK.

Viewing Meter Readings

1. At the printer control panel, press the Machine Status button.
2. Touch Meter Readings.
3. After viewing the readings, touch X to close the window or press the Services Home button to return to the Services Home menu.
Online Support Assistant

The Online Support Assistant is a knowledge base that provides instructions and troubleshooting help to solve your printer problems. You can find solutions for print-quality problems, paper jams, software installation issues, and more.

To access the Online Support Assistant, go to www.xerox.com/office/WC6605support.

Information Pages

Your printer has a printable set of information pages. These include configuration and font information, demonstration pages, and more.

More Information

You can obtain more information about your printer from these sources:

<table>
<thead>
<tr>
<th>Resource</th>
<th>Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>Installation Guide</td>
<td>Packaged with the printer.</td>
</tr>
<tr>
<td>Other documentation for your printer</td>
<td><a href="http://www.xerox.com/office/WC6605docs">www.xerox.com/office/WC6605docs</a></td>
</tr>
<tr>
<td>Recommended Media List</td>
<td>United States: <a href="http://www.xerox.com/paper">www.xerox.com/paper</a></td>
</tr>
<tr>
<td></td>
<td>European Union: <a href="http://www.xerox.com/europaper">www.xerox.com/europaper</a></td>
</tr>
<tr>
<td>Technical support information for your</td>
<td><a href="http://www.xerox.com/office/WC6605support">www.xerox.com/office/WC6605support</a></td>
</tr>
<tr>
<td>printer; including online technical</td>
<td></td>
</tr>
<tr>
<td>support, Online Support Assistant, and</td>
<td></td>
</tr>
<tr>
<td>driver downloads.</td>
<td></td>
</tr>
<tr>
<td>Information about menus or error</td>
<td>Press the control panel Help (?) button.</td>
</tr>
<tr>
<td>messages</td>
<td></td>
</tr>
<tr>
<td>Information Pages</td>
<td>Print from the control panel panel, or from CentreWare Internet Services,</td>
</tr>
<tr>
<td></td>
<td>click Status&gt;Information Pages.</td>
</tr>
<tr>
<td>CentreWare Internet Services documentation</td>
<td>In CentreWare Internet Services, click Help.</td>
</tr>
<tr>
<td>Order supplies for your printer</td>
<td><a href="http://www.xerox.com/office/WC6605supplies">www.xerox.com/office/WC6605supplies</a></td>
</tr>
<tr>
<td>A resource for tools and information,</td>
<td><a href="http://www.xerox.com/office/businessresourcecenter">www.xerox.com/office/businessresourcecenter</a></td>
</tr>
<tr>
<td>including interactive tutorials, printing</td>
<td></td>
</tr>
<tr>
<td>templates, helpful tips, and customized</td>
<td></td>
</tr>
<tr>
<td>features to meet your individual needs.</td>
<td></td>
</tr>
<tr>
<td>Local sales and support center</td>
<td><a href="http://www.xerox.com/office/worldcontacts">www.xerox.com/office/worldcontacts</a></td>
</tr>
<tr>
<td>Printer registration</td>
<td><a href="http://www.xerox.com/office/register">www.xerox.com/office/register</a></td>
</tr>
<tr>
<td>Xerox® Direct online store</td>
<td><a href="http://www.direct.xerox.com/">www.direct.xerox.com/</a></td>
</tr>
</tbody>
</table>
Specifications

This appendix includes:

- Printer Configurations and Options ................................................................. 270
- Physical Specifications ..................................................................................... 272
- Environmental Specifications ......................................................................... 276
- Electrical Specifications ............................................................................... 277
- Performance Specifications ......................................................................... 278
- Controller Specifications ............................................................................. 279
Printed on recycled paper.

**Printer Configurations and Options**

**Available Configurations**

The WorkCentre 6605 Color Multifunction Printer is available in two configurations:

- WorkCentre 6605N Color Multifunction Printer: Network printer with copy, print, scan, and fax functions and USB or network connectivity.
- WorkCentre 6605DN Color Multifunction Printer: Network printer with copy, automatic 2-sided printing, scan, and fax functions and USB or network connectivity.

**Standard Features**

The WorkCentre 6605 Color Multifunction Printer provides the following features:

<table>
<thead>
<tr>
<th>Feature</th>
<th>WorkCentre 6605 Color Multifunction Printer</th>
</tr>
</thead>
</table>
| Print speed | • Standard and Enhanced modes up to 36 ppm  
• Photo mode up to 17 ppm |
| 2-Sided Print Speed | • Standard mode up to 24 images per minute  
• Enhanced mode up to 24 images per minute |
| Print resolution | Up to 600 x 600 x 5 dpi (1200 x 1200 enhanced image quality) |
| Paper capacity | • 100 sheets  
• 550 sheets  
• 550 sheets |
| Maximum print size | Legal (216 x 356 mm, 8.5 x 14 in.) |
| 2-Sided Printing | Up to 163 g/m² from any tray (WorkCentre 6605DN model only) |
| Copy Speed | • 13 copies per minute for color, 22 for black and white  
• 4 copies per minute for color, 7 for black and white |
| Copy resolution | 600 x 600 dpi |
| Max Copy Size | Legal (216 x 356 mm, 8.5 x 14 in.) |
| Document feeder | Duplex Automatic Document Feeder |
| Document feeder capacity | 50 sheets |
| Scan resolution | • 1200 x 1200 dpi  
• Up to 9600 dpi interpolated  
• Up to 600 dpi |
### Specifications

<table>
<thead>
<tr>
<th>Feature</th>
<th>WorkCentre 6605 Color Multifunction Printer</th>
</tr>
</thead>
<tbody>
<tr>
<td>Max Scan Size</td>
<td></td>
</tr>
<tr>
<td>• Document Glass</td>
<td>• 215.9 x 297 mm (8.5 x 11.7 in.)</td>
</tr>
<tr>
<td>• Duplex Automatic Document Feeder</td>
<td>• 215.9 x 355.6 mm (8.5 x 14 in.)</td>
</tr>
<tr>
<td>File formats</td>
<td>• JPEG</td>
</tr>
<tr>
<td>• TIFF</td>
<td>• TIFF</td>
</tr>
<tr>
<td>• PDF</td>
<td>• PDF</td>
</tr>
<tr>
<td>Supported scanning</td>
<td>• Scan to Desktop (SMB)</td>
</tr>
<tr>
<td>• Scan to FTP</td>
<td>• Scan to FTP</td>
</tr>
<tr>
<td>• Scan to Email</td>
<td>• Scan to Email</td>
</tr>
<tr>
<td>• Scan to USB</td>
<td>• Scan to Computer (USB)</td>
</tr>
<tr>
<td>• WSD Scan</td>
<td></td>
</tr>
<tr>
<td>Email address book</td>
<td>• Up to 100 email addresses</td>
</tr>
<tr>
<td>• Up to 10 email groups</td>
<td>• Up to 10 email groups</td>
</tr>
<tr>
<td>• Up to 10 addresses per email group</td>
<td>• Up to 10 addresses per email group</td>
</tr>
<tr>
<td>Control panel</td>
<td>4.3 inch LCD touch screen and keypad navigation</td>
</tr>
<tr>
<td>Connectivity</td>
<td>• Universal Serial Bus (USB 2.0)</td>
</tr>
<tr>
<td>• USB Flash drive</td>
<td>• Ethernet 10/100 Base-T</td>
</tr>
<tr>
<td>• Wireless network connectivity: Optional</td>
<td>• Wireless network connectivity: Optional</td>
</tr>
<tr>
<td>• AirPrint</td>
<td>• AirPrint</td>
</tr>
<tr>
<td>Remote access</td>
<td>CentreWare Internet Services</td>
</tr>
</tbody>
</table>

**Options and Upgrades**

- Wireless network adapter
- 550-Sheet Feeder
- 160 GB+ Hard Disk - Productivity Kit (HD)
- 512 MB memory upgrade - Productivity Kit (Memory)
Physical Specifications

Weights and Dimensions

<table>
<thead>
<tr>
<th></th>
<th>WorkCentre 6605DN Color Multifunction Printer</th>
<th>WorkCentre 6605DN Color Multifunction Printer with Optional 550-Sheet Feeder</th>
</tr>
</thead>
<tbody>
<tr>
<td>Width</td>
<td>430 mm (16.9 in.)</td>
<td>430 mm (16.9 in.)</td>
</tr>
<tr>
<td>Depth</td>
<td>528 mm (20.8 in.)</td>
<td>530 mm (20.8 in.)</td>
</tr>
<tr>
<td>Height</td>
<td>560 mm (22.0 in.)</td>
<td>653 mm (25.7 in.)</td>
</tr>
<tr>
<td>Weight</td>
<td>32.5 kg (71.7 lb.)</td>
<td>35.1 kg (77.3 lb.)</td>
</tr>
</tbody>
</table>

Standard Configuration
Configurations with Optional 550-Sheet Feeder

Total Space Requirements

<table>
<thead>
<tr>
<th></th>
<th>WorkCentre 6605DN Color Multifunction Printer</th>
<th>WorkCentre 6605DN Color Multifunction Printer with Optional 550-Sheet Feeder</th>
</tr>
</thead>
<tbody>
<tr>
<td>Width</td>
<td>930 mm (36.6 in.)</td>
<td>930 mm (36.6 in.)</td>
</tr>
<tr>
<td>Depth</td>
<td>1528 mm (60.2 in.)</td>
<td>1528 mm (60.2 in.)</td>
</tr>
<tr>
<td>Height</td>
<td>855 mm (33.7 in.)</td>
<td>948 mm (37.3 in.)</td>
</tr>
</tbody>
</table>
Clearance Requirements

WorkCentre 6605 Color Multifunction Printer
Clearance Requirements with Optional 550-Sheet Feeder

WorkCentre 6605 Color Multifunction Printer
Environmental Specifications

Temperature

- Operating temperature: 10–32°C (50–90°F)
- Optimum temperature: 15–28°C (59–82°F)

Relative Humidity

- Minimum–Maximum Humidity Range: 10–85%
- Optimal Humidity Range: 20–70% relative humidity at 28°C (82°F)

Note: Under extreme environmental conditions, such as 10°C and 85% relative humidity, defects can occur due to condensation.

Elevation

For optimum performance, use the printer at elevations below 3100 m (10,170 ft.).
Electrical Specifications

Power Supply Voltage and Frequency

<table>
<thead>
<tr>
<th>Power Supply Voltage</th>
<th>Power Supply Frequency</th>
</tr>
</thead>
<tbody>
<tr>
<td>110–127 VAC +/-10%, (99–140 VAC)</td>
<td>50 Hz +/- 3 Hz</td>
</tr>
<tr>
<td></td>
<td>60 Hz +/- 3 Hz</td>
</tr>
<tr>
<td>220–240 VAC +/-10%, (198–264 VAC)</td>
<td>50 Hz +/- 3 Hz</td>
</tr>
<tr>
<td></td>
<td>60 Hz +/- 3 Hz</td>
</tr>
</tbody>
</table>

Power Consumption

- Energy Saver Mode (Sleep): 6 W
- Ready: 72 W
- Continuous printing: 560 W

This printer does not consume electric power when the power switch is turned off even if the printer is connected to an AC outlet.

ENERGY STAR Qualified Product

The WorkCentre 6605 Color Multifunction Printer is ENERGY STAR® qualified under the ENERGY STAR Program Requirements for Imaging Equipment.

The ENERGY STAR and ENERGY STAR mark are registered United States trademarks.

The ENERGY STAR Imaging Equipment Program is a team effort between United States, European Union, and Japanese governments and the office equipment industry to promote energy-efficient copiers, printers, fax, multifunction printers, personal computers, and monitors. Reducing product energy consumption helps combat smog, acid rain, and long-term changes to the climate by decreasing the emissions that result from generating electricity.

Xerox® ENERGY STAR equipment is preset at the factory to switch to Energy Saver Modes after 5 minutes from the last copy or print.
Performance Specifications

<table>
<thead>
<tr>
<th>Feature</th>
<th>Specifications</th>
</tr>
</thead>
<tbody>
<tr>
<td>Printer warm up time</td>
<td>Power on: As fast as 27 seconds.</td>
</tr>
<tr>
<td></td>
<td>Recovery from sleep mode: As fast as 9 seconds.</td>
</tr>
<tr>
<td></td>
<td>Note: Warm up time assumes an ambient temperature of 20°C (68°F) at 60% relative humidity.</td>
</tr>
</tbody>
</table>

Print Speed

Print speeds for continuous printing are up to 36 ppm. Print speeds are the same for color or black and white printing.

Several factors affect print speed:

- Print mode. The fastest print modes are Standard and Enhanced. Photo mode prints at half speed. Photo mode prints 1-sided pages on Plain, Letter/A4 at 17 ppm.
- Paper size. Letter (8.5 x 11 in.) prints slightly faster than A4 (210 x 297 mm). Larger sizes reduce print speeds.
- Paper type and weights. For faster printing, use paper weights of 105 g/m² or less.

The maximum print speed for 1-sided printing is 36 ppm on Letter paper, and 35 ppm on A4 paper.

The maximum print speed for 2-sided printing is 24 ppm on Letter and A4 paper.

Photo mode prints 1-sided pages on Plain, Letter/A4 at 17 ppm.
Controller Specifications

Processor

533 MHz ARM11 processor

Memory

<table>
<thead>
<tr>
<th>Memory</th>
<th>WorkCentre 6605 Color Multifunction Printer</th>
</tr>
</thead>
<tbody>
<tr>
<td>Standard memory</td>
<td>512 MB RAM</td>
</tr>
<tr>
<td>Optional Memory Productivity Kit (Memory)</td>
<td>512 MB RAM (1 GB total)</td>
</tr>
<tr>
<td>Flash memory</td>
<td>64 MB ROM</td>
</tr>
<tr>
<td>EEPROM</td>
<td>64 KB EPROM</td>
</tr>
<tr>
<td>Fax memory</td>
<td>4 MB RAM</td>
</tr>
<tr>
<td>SRAM</td>
<td>128 KB</td>
</tr>
</tbody>
</table>

Interfaces

Universal Serial Bus (USB 2.0)

Ethernet 10/100/1000Base-TX

IEEE802.11 Compliant Wireless Network Adapter
This appendix includes:

- Basic Regulations ................................................................. 282
- Copy Regulations ................................................................. 286
- Fax Regulations ................................................................. 289
- Material Safety Data Sheets .............................................. 293
Basic Regulations

Xerox has tested this printer to electromagnetic emission and immunity standards. These standards are designed to mitigate interference caused or received by this printer in a typical office environment.

United States FCC Regulations

This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference when the equipment is operated in a residential environment. This equipment generates, uses, and can radiate radio frequency energy. If it is not installed and used in accordance with these instructions, it may cause harmful interference to radio communications. However, there is no guarantee that interference will not occur in a particular installation.

If this equipment does cause harmful interference to radio or television reception, which can be determined by turning the equipment off and on, the user is encouraged to try to correct the interference by one or more of the following measures:

- Reorient or relocate the receiving antenna.
- Increase the separation between the equipment and receiver.
- Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
- Consult the dealer or an experienced radio/TV technician for help.

Changes or modifications to this equipment not approved by Xerox can void the authority of the user to operate this equipment.

**Note:** To ensure compliance with Part 15 of the FCC rules, use shielded interface cables.

Canada

This Class B digital apparatus complies with Canadian ICES-003.

Cet appareil numérique de la classe B est conforme à la norme NMB-003 du Canada.
European Union

The CE mark applied to this product symbolizes a declaration of conformity by Xerox with the following applicable Directives of the European Union as of the dates indicated:

- December 12, 2006: Low Voltage Directive 2006/95/EC

This printer, if used properly in accordance with the instructions, is not dangerous for the consumer or for the environment.

To ensure compliance with European Union regulations, use shielded interface cables.

A signed copy of the Declaration of Conformity for this printer can be obtained from Xerox.

European Union Lot 4 Imaging Equipment Agreement Environmental Information

Environmental Information Providing Environmental Solutions and Reducing Cost

The following information has been developed to assist users and has been issued in relation to the European Union (EU) Energy Related Products Directive, specifically the Lot 4 study on Imaging Equipment. This requires manufacturers to improve environmental performance of in scope products and supports the EU action plan on energy efficiency.

In scope products are Household and Office equipment that meet the following criteria.

- Standard monochrome format products with a maximum speed less than 66 A4 images per minute
- Standard color format products with a maximum speed less than 51 A4 images per minute

Introduction

The following information has been developed to assist users and has been issued in relation to the European Union (EU) Energy Related Products Directive, specifically the Lot 4 study on Imaging Equipment. This requires manufacturers to improve environmental performance of in scope products and supports the EU action plan on energy efficiency.

In scope products are Household and Office equipment that meet the following criteria.

- Standard monochrome format products with a maximum speed less than 66 A4 images per minute
- Standard color format products with a maximum speed less than 51 A4 images per minute
Environmental Benefits of Duplex Printing

Most Xerox products have duplex printing, also known as 2-sided printing, capability. This enables you to print on both sides of the paper automatically, and therefore helps to reduce the use of valuable resources by reducing your paper consumption. The Lot 4 Imaging Equipment agreement requires that on models greater than or equal to 40 ppm color or greater than or equal to 45 ppm monochrome the duplex function has been auto enabled, during the setup and driver installation. Some Xerox models below these speed bands may also be enabled with 2-sided printing settings defaulted on at the time of install. Continuing to use the duplex function will reduce the environmental impact of your work. However, should you require simplex/1-sided printing, you may change the print settings in the print driver.

Paper Types

This product can be used to print on both recycled and virgin paper, approved to an environmental stewardship scheme, which complies with EN12281 or a similar quality standard. Lighter weight paper (60 g/m²), which contains less raw material and thus save resources per print, may be used in certain applications. We encourage you to check if this is suitable for your printing needs.

ENERGY STAR

The ENERGY STAR program is a voluntary scheme to promote the development and purchase of energy efficient models, which help to reduce environmental impact. Details on the ENERGY STAR program and models qualified to ENERGY STAR can be found at the following website: www.energystar.gov/index.cfm?fuseaction=find_a_product.showProductGroup&pgw_code=IEQ

For additional information on energy or other related topics, please see www.xerox.com/about-xerox/environment/enus.html or www.xerox.co.uk/about-xerox/environment/engb.html.

Power Consumption and Activation Time

The amount of electricity a product consumes depends on the way the device is used. This product is designed and configured to enable you to reduce your electricity costs. After the last print it switches to Ready Mode. In this mode it can print again immediately if required. If the product is not used for a period of time, the device switches to a Power Saver Mode. In these modes, only essential functions remain active in order to enable reduced product power consumption.

Upon exiting from Power Saver Mode, the first print will take slightly longer than in Ready Mode. This delay is the result of the system “waking up” from Power Saver mode and is typical of most imaging products on the market.

If you wish to set a longer Activation Time or would like to completely deactivate the Power Save Mode, please consider that this device may then only switch to a lower energy level after a longer period of time or not at all.

To learn more about Xerox participation in sustainability initiatives, please visit our website at: www.xerox.com/about-xerox/environment/enus.html
Germany

Blendschutz

Das Gerät ist nicht für die Benutzung im unmittelbaren Gesichtsfeld am Bildschirmarbeitsplatz vorgesehen. Um störende Reflexionen am Bildschirmarbeitsplatz zu vermeiden, darf dieses Produkt nicht im unmittelbaren Gesichtsfeld platziert werden.

Lärmemission

Maschinenlärminformations-Verordnung 3. GPSGV: Der höchste Schalldruckpegel beträgt 70 dB(A) oder weniger gemäß EN ISO 7779.

Importeur

Xerox GmbH
Hellersbergstraße 2-4
41460 Neuss
Deutschland

Turkey RoHS Regulation

In compliance with Article 7 (d), we hereby certify “it is in compliance with the EEE regulation.”

“EEE yönetmeliğine uygundur.”

Regulatory Information for 2.4 GHz Wireless Network Adapter


Operation of this device is subject to the following two conditions: (1) this device may not cause harmful interference, and (2) this device must accept any interference received, including interference that may cause undesired operation.

Changes or modifications to this device not specifically approved by the Xerox Corporation may void the user’s authority to operate this equipment.
Copy Regulations

United States

Congress, by statute, has forbidden the reproduction of the following subjects under certain circumstances. Penalties of fine or imprisonment may be imposed on those guilty of making such reproductions.

1. Obligations or Securities of the United States Government, such as:
   - Certificates of Indebtedness.
   - National Bank Currency.
   - Coupons from Bonds.
   - Federal Reserve Bank Notes.
   - Silver Certificates.
   - Gold Certificates.
   - United States Bonds.
   - Treasury Notes.
   - Federal Reserve Notes.
   - Fractional Notes.
   - Certificates of Deposit.
   - Paper Money.
   - Bonds and Obligations of certain agencies of the government, such as FHA and so on.
   - Bonds. United States Savings Bonds may be photographed only for publicity purposes in connection with the campaign for the sale of such bonds.
   - Internal Revenue Stamps. If it is necessary to reproduce a legal document on which there is a canceled revenue stamp, this may be done provided the reproduction of the document is performed for lawful purposes.
   - Postage Stamps, canceled or uncanceled. For philatelic purposes, Postage Stamps may be photographed, provided the reproduction is in black and white and is less than 75% or more than 150% of the linear dimensions of the original.
   - Postal Money Orders.
   - Bills, Checks, or Drafts of money drawn by or upon authorized officers of the United States.
   - Stamps and other representatives of value, of whatever denomination, which have been or may be issued under any Act of Congress.
   - Adjusted Compensation Certificates for Veterans of the World Wars.

2. Obligations or Securities of any Foreign Government, Bank, or Corporation.

3. Copyrighted materials, unless permission of the copyright owner has been obtained or the reproduction falls within the “fair use” or library reproduction rights provisions of the copyright law. Further information of these provisions may be obtained from the Copyright Office, Library of Congress, Washington, D.C. 20559. Ask for Circular R21.
4. Certificate of Citizenship or Naturalization. Foreign Naturalization Certificates may be photographed.

5. Passports. Foreign Passports may be photographed.

6. Immigration papers.

7. Draft Registration Cards.

8. Selective Service Induction papers that bear any of the following Registrant’s information:
   - Earnings or Income.
   - Court Record.
   - Physical or mental condition.
   - Dependency Status.
   - Previous military service.
   - Exception: United States military discharge certificates may be photographed.

9. Badges, Identification Cards, Passes, or Insignia carried by military personnel, or by members of the various Federal Departments, such as FBI, Treasure, and so on (unless photograph is ordered by the head of such department or bureau).

Reproducing the following is also prohibited in certain states:

- Automobile Licenses.
- Drivers’ Licenses.
- Automobile Certificates of Title.

The preceding list is not all inclusive, and no liability is assumed for its completeness or accuracy. In case of doubt, consult your attorney.

Canada

Parliament, by stature, has forbidden the reproduction of the following subjects under certain circumstances. Penalties of fine or imprisonment may be imposed on those guilty of making such reproductions.

- Current bank notes or current paper money
- Obligations or securities of a government or bank
- Exchequer bill paper or revenue paper
- The public seal of Canada or of a province, or the seal of a public body or authority in Canada, or of a court of law
- Proclamations, orders, regulations, or appointments, or notices thereof (with intent to falsely cause same to purport to have been printed by the Queens Printer for Canada, or the equivalent printer for a province)
- Marks, brands, seals, wrappers, or designs used by or on behalf of the Government of Canada or of a province, the government of a state other than Canada or a department, board, Commission, or agency established by the Government of Canada or of a province or of a government of a state other than Canada
- Impressed or adhesive stamps used for the purpose of revenue by the Government of Canada or of a province or by the government of a state other than Canada
- Documents, registers, or records kept by public officials charged with the duty of making or issuing certified copies thereof, where the copy falsely purports to be a certified copy thereof
- Copyrighted material or trademarks of any manner or kind without the consent of the copyright or trademark owner

This list is provided for your convenience and assistance, but it is not all-inclusive, and no liability is assumed for its completeness or accuracy. In case of doubt, consult your solicitor.

Other Countries

Copying certain documents may be illegal in your country. Penalties of fine or imprisonment may be imposed on those found guilty of making such reproductions.

- Currency notes
- Bank notes and checks
- Bank and government bonds and securities
- Passports and identification cards
- Copyright material or trademarks without the consent of the owner
- Postage stamps and other negotiable instruments

This list is not inclusive and no liability is assumed for either its completeness or accuracy. In case of doubt, contact your legal counsel.
Fax Regulations

United States

Fax Send Header Requirements

The Telephone Consumer Protection Act of 1991 makes it unlawful for any person to use a computer or other electronic device, including a fax machine, to send any message unless such message clearly contains in a margin at the top or bottom of each transmitted page or on the first page of the transmission, the date and time it is sent and an identification of the business or other entity, or other individual sending the message and the telephone number of the sending machine or such business, other entity, or individual. The telephone number provided may not be a 900 number or any other number for which charges exceed local or long-distance transmission charges.

Data Coupler Information

This equipment complies with Part 68 of the FCC rules and the requirements adopted by the Administrative Council for Terminal Attachments (ACTA). On the cover of this equipment is a label that contains, among other information, a product identifier in the format US:AAAEQ##TXXXX. If requested, this number must be provided to the Telephone Company.

A plug and jack used to connect this equipment to the premises wiring and telephone network must comply with the applicable FCC Part 68 rules and requirements adopted by the ACTA. A compliant telephone cord and modular plug is provided with this product. It connects to a compatible modular jack that is also compliant. See installation instructions for details.

You can safely connect the printer to the following standard modular jack: USOC RJ-11C using the compliant telephone line cord (with modular plugs) provided with the installation kit. See installation instructions for details.

The Ringer Equivalence Number (REN) is used to determine the number of devices that can be connected to a telephone line. Excessive RENs on a telephone line could result in the devices not ringing in response to an incoming call. In most but not all areas, the sum of RENs should not exceed five (5.0). To be certain of the number of devices that can be connected to a line, as determined by the RENs, contact the local Telephone Company. For products approved after July 23, 2001, the REN is part of the product identifier that has the format US:AAAEQ##TXXXX. The digits represented by ## are the REN without a decimal point (for example, 03 is a REN of 0.3). For earlier products, the REN is separately shown on the label.
To order the correct service from the local Telephone Company, you could also have to quote the codes in the following list:

- Facility Interface Code (FIC) = 02LS2
- Service Order Code (SOC) = 9.0Y

⚠️ **CAUTION:** Ask your local Telephone Company for the modular jack type installed on your line. Connecting this machine to an unauthorized jack can damage telephone company equipment. You, not Xerox, assume all responsibility and/or liability for any damage caused by the connection of this machine to an unauthorized jack.

If this Xerox® equipment causes harm to the telephone network, the Telephone Company could temporarily discontinue service to the telephone line to which it is connected. If advance notice is not practical, the Telephone Company notifies you of the disconnection as soon as possible. If the Telephone Company interrupts your service, they can advise you of your right to file a complaint with the FCC if you believe that it is necessary.

The Telephone Company could change its facilities, equipment, operations, or procedures which could affect the operation of the equipment. If the Telephone Company changes something that affects the operation of the equipment, they should notify you in order for you to make necessary modifications to maintain uninterrupted service.

If you experience trouble with this Xerox® equipment, please contact the appropriate service center for repair or warranty information. Contact information is contained in the Machine Status menu on the printer and in the back of the Troubleshooting section of the User Guide. If the equipment is causing harm to the telephone network, the Telephone Company may request you to disconnect the equipment until the problem is resolved.

Only a Xerox Service Representative or an authorized Xerox Service provider are authorized to make repairs to the printer. This applies at any time during or after the service warranty period. If unauthorized repair is performed, the remainder of the warranty period is null and void.

This equipment must not be used on party lines. Connection to party line service is subject to state tariffs. Contact the state public utility commission, public service commission, or corporation commission for information.

Your office could have specially wired alarm equipment connected to the telephone line. Make sure that the installation of this Xerox® equipment does not disable your alarm equipment.

If you have questions about what could disable alarm equipment, consult your Telephone Company or a qualified installer.
Canada

This product meets the applicable Industry Canada technical specifications.

A representative designated by the supplier should coordinate repairs to certified equipment. Repairs or alterations made by the user to this device, or device malfunctions, could cause the telecommunications company to request you to disconnect the equipment.

For user protection, make sure that the printer is properly grounded. The electrical ground connections of the power utility, telephone lines, and internal metallic water pipe systems, if present, must be connected together. This precaution could be vital in rural areas.

**WARNING:** Do not attempt to make such connections yourself. Contact the appropriate electric inspection authority, or electrician, to make the ground connection.

The REN assigned to each terminal device provides an indication of the maximum number of terminals allowed to be connected to a telephone interface. The termination on an interface could consist of any combination of devices. The only limitation to the number of devices is the requirement that the sum of the RENs of the devices does not exceed 5. For the Canadian REN value, please see the label on the equipment.

European Union

Radio Equipment and Telecommunications Terminal Equipment Directive

The Facsimile has been approved in accordance with the Council Decision 1999/5/EC for pan-European single terminal connection to the public switched telephone network (PSTN). However, due to differences between the individual PSTNs provided in different countries, the approval does not give an unconditional assurance of successful operation on every PSTN network terminal point.

In the event of a problem you should contact your authorized local dealer.

This product has been tested to and is compliant with ES 203 021-1, -2, -3, a specification for terminal equipment for use on analog-switched telephone networks in the European Economic Area. This product provides a user-adjustable setting of the country code. The country code should be set prior to connecting this product to the network. Refer to the customer documentation for the procedure for setting the country code.

**Note:** Although this product can use either loop disconnect (pulse) or DTMF (tone) signaling, we recommend that you set it to use DTMF signaling for more reliable and faster call setup. Modification of this product, connection to external control software, or connection to an external control apparatus not authorized by Xerox will invalidate its certification.

South Africa

This modem must be used in conjunction with an approved surge protection device.
New Zealand

1. The grant of a Telepermit for any item of terminal equipment indicates only that Telecom has accepted that the item complies with minimum conditions for connection to its network. It indicates no endorsement of the product by Telecom, it does not provide any sort of warranty, and it does not imply that any Telepermitted product is compatible with all Telecom network services. Above all, it provides no assurance that any item will work correctly in all respects with another item of Telepermitted equipment of a different make or model.

   The equipment may not be capable of correct operation at the higher data speeds designated. 33.6 kbps and 56 kbps connections are likely to be restricted to lower bit rates when connected to some PSTN implementations. Telecom will accept no responsibility for difficulties that arise in such circumstances.

2. Immediately disconnect this equipment should it become physically damaged, then arrange for its disposal or repair.

3. This modem shall not be used in any manner which could constitute a nuisance to other Telecom customers.

4. This device is equipped with pulse dialing, while the Telecom standard is DTMF tone dialing. There is no guarantee that Telecom lines will always continue to support pulse dialing.

5. Use of pulse dialing, when this equipment is connected to the same line as other equipment, may give rise to 'bell tinkle' or noise and cause a false answer condition. If you encounter such problems, do not contact the Telecom Faults Service.

6. DTMF tones dialing is the preferred method because it is faster than pulse (decadic) dialing and is readily available on almost all New Zealand telephone exchanges.

**WARNING:** No ‘111’ or other calls can be made from this device during a mains power failure.

7. This equipment may not provide for the effective hand-over of a call to another device connected to the same line.

8. Some parameters required for compliance with Telecom Telepermit requirements are dependent on the equipment (computer) associated with this device. The associated equipment shall be set to operate within the following limits for compliance with Telecom Specifications:
   - For repeat calls to the same number:
     - There shall be no more than 10 call attempts to the same number within any 30 minute period for any single manual call initiation, and
     - The equipment shall go on-hook for a period of not less than 30 seconds between the end of one attempt and the beginning of the next attempt.
   - For automatic calls to different numbers:
     The equipment shall be set to ensure that automatic calls to different numbers are spaced such that there is no less than five seconds between the end of one call attempt and the beginning of another.

9. For correct operation, total of the RNs of all devices connected to a single line at any time should not exceed five.
Material Safety Data Sheets

For Material Safety Data information regarding your printer, go to:

- North America: www.xerox.com/msds
- European Union: www.xerox.com/environment_europe

For the Customer Support Center phone numbers, go to www.xerox.com/office/worldcontacts.
Recycling and Disposal

This appendix includes:

- All Countries ......................................................................................................................................................................... 296
- North America ..................................................................................................................................................................... 297
- European Union .................................................................................................................................................................. 298
- Other Countries ................................................................................................................................................................... 300
All Countries

If you are managing the disposal of your Xerox product, please note that the printer may contain lead, mercury, perchlorate, and other materials whose disposal may be regulated due to environmental considerations. The presence of these materials is fully consistent with global regulations applicable at the time that the product was placed on the market. For recycling and disposal information, contact your local authorities. Perchlorate Material: This product may contain one or more Perchlorate-containing devices, such as batteries. Special handling may apply, please see www.dtsc.ca.gov/hazardouswaste/perchlorate.
North America

Xerox operates an equipment take-back and reuse/recycle program. Contact your Xerox representative (1-800-ASK-XEROX) to determine if this Xerox product is part of the program. For more information about Xerox environmental programs, visit www.xerox.com/environment, or for recycling and disposal information, contact your local authorities.
European Union

Some equipment may be used in both a domestic/household and a professional/business application.

Domestic/Household Environment

Application of this symbol on your equipment is confirmation that you should not dispose of the equipment in the normal household waste stream.

In accordance with European legislation, end of life electrical and electronic equipment subject to disposal must be segregated from household waste.

Private households within EU member states may return used electrical and electronic equipment to designated collection facilities free of charge. Please contact your local disposal authority for information.

In some member states, when you purchase new equipment, your local retailer may be required to take back your old equipment free of charge. Please ask your retailer for information.

Professional/Business Environment

Application of this symbol on your equipment is confirmation that you must dispose of this equipment in compliance with agreed national procedures.

In accordance with European legislation, end of life electrical and electronic equipment subject to disposal must be managed within agreed procedures.

Prior to disposal, please contact your local reseller or Xerox representative for end of life take-back information.
Collection and Disposal of Equipment and Batteries

These symbols on the products and/or accompanying documents mean that used electrical and electronic products and batteries should not be mixed with general household waste.

For proper treatment, recovery, and recycling of old products and used batteries, please take them to applicable collection points, in accordance with your national legislation and the Directive 2002/96/EC and 2006/66/EC.

By disposing of these products and batteries correctly, you will help to save valuable resources and prevent any potential negative effects on human health and the environment which could otherwise arise from inappropriate waste handling.

For more information about collection and recycling of old products and batteries, please contact your local municipality, your waste disposal service or the point of sale where you purchased the items.

Penalties may be applicable for incorrect disposal of this waste, in accordance with national legislation.

Business Users in the European Union

If you wish to discard electrical and electronic equipment, please contact your dealer or supplier for further information.

Disposal Outside of the European Union

These symbols are only valid in the European Union. If you wish to discard these items, please contact your local authorities or dealer and ask for the correct method of disposal.

Battery Symbol Note

This wheeled bin symbol may be used in combination with a chemical symbol. This establishes compliance with the requirements set out by the Directive.

Battery Removal

Batteries should only be replaced by a MANUFACTURER-approved service facility.
Other Countries

Please contact your local waste management authority to request disposal guidance.